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Nuance Communications, Inc.
END USER LICENSE AGREEMENT

Your acceptance of the terms of this End User License Agreement (“Agreement”) is required before your use of the accompanying software. This
Agreement is between you (“Licensee” or “you”) and Nuance Communications, Inc. and/or one or more of its affiliates (collectively, “Nuance”).
By opening the sealed Software Package and/or by installing or otherwise using the software accompanying this Agreement (“Software”), you
agree to be bound by the terms and conditions of this Agreement. The term “Software” shall also include any modified versions, updates, or
upgrades of the Software licensed to you by Nuance. You may install and use a modified version, update, or upgrade of the Software only if you
have a validly licensed existing version of the Software being modified, updated, or upgraded. If you download, install, copy, or otherwise use

a modified version, update, or upgrade of the Software, then your license terminates as to the previous version of the Software, and you have a
license only to such modified version, update, or upgrade of the Software under the terms of this Agreement. If you do not agree to the terms
and conditions of this Agreement, you may not install or use the Software and must promptly return the Software and all accompanying materi-
als to the entity from which you obtained this Software Package. THIS IS A LICENSE TO USE SOFTWARE AND NOT A SALE OF SOFTWARE
CODE.

This document is Licensee’s proof of a non-exclusive license to exercise the rights granted herein and must be retained by Licensee. If you or
your company have signed a separate software license agreement with Nuance or with any of Nuance’s authorized resellers, and that separate
software license agreement is intended to govern the use of Software, the terms of that separate license agreement shall control over any
conflicting terms in this End User License Agreement.

As used in this Agreement, “Software Package” means the Software and the accompanying documentation. As used in this Agreement, “Voice
Profile” shall mean a data file created and used by the Software Package to recognize the speech of a sole natural person. A Voice Profile be
may not be shared or otherwise used by the Run-Time Software in a manner to recognize the speech of more than one natural person under
any circumstances. As used in this Agreement, “Run-time Engine” shall mean the accessing of the Software Package by application software
via an Application Programming Interface(“API”) that may be incorporated into the Software Package by Nuance, or similar direct access to the
code of the Software Package that by-passes the API. Such use is subject to separate licensing to the application software developer and to the
end user.

1(a). Grant of License — For home use of Basic, Home, Premium and Dragon Dictate Editions of the Software.

Nuance grants a non-exclusive license, without the right to sublicense or otherwise transfer, to Licensee, to install and use the Software
contained on the provided installation media on a single home computer running validly-licensed operating systems and to use, in connection
with such Software, the rest of the Software Package. This license is for one (1) computer located a physical residential address that allows

the creation of multiple Voice Profiles by multiple speakers (“Primary”). The Licensee may also install one (1) copy Software Package on one (1)
additional home computer for the sole purpose of backing up the Software Package and may not be used concurrently with the Primary copy of
the Software Package. Any additional computers at the same physical residential address will require the purchase of additional license(s) for the
Software Package. Speakers are permitted to create and use multiple Voice Profiles under this License. Voice Profile can be stored on one (1)
computer. This license does not authorize Licensee or Licensee’s third parties to use this Software on a computer for the transcription of audio
files by many users. This license for the Software Package does not allow Licensee to use the Software as a Run-time Engine.

1(b). Grant of License — For Educational Institutions using Premium Professional, Legal, and Dragon Dictate Academic Editions of the Software.

Nuance grants a non-exclusive license, without the right to sublicense or otherwise transfer (reference is made to section 19.3 below), to
Licensee to install and use one (1) copy of the Software contained on the provided installation media on a single computer running a validly-
licensed operating system and to use, in connection with such Software, the rest of the Software Package by one (1) Licensee located at one (1)
physical address. This license expressly prohibits the use of Software Package on any portable machine or machine that is not licensed to the
same Licensee. Licensee is permitted to create and use multiple Voice Profiles under this license . A single license for the Software Package
does not allow Licensee to use the Software Package on a server. This license for the Software Package does not allow Licensee to use the
Software as a Run-time Engine.

1(c). Grant of License — For Professional and Legal Editions of the Software.

Nuance grants a non-exclusive license, without the right to sublicense or otherwise transfer (reference is made to section 19.3 below), to
Licensee (and Licensee’s employees who agree to be bound by the terms and conditions of this License, provided Licensee has entered into a
Nuance volume license agreement), to install and use the Software contained on the provided installation media on multiple computers running
validly-licensed operating systems and to use, in connection with such Software, the rest of the Software Package. A licensed speaker is
permitted to create and use multiple Voice Profiles under this license. Voice Profiles can be stored on one or more computers or on a server
to allow the speaker to move from computer to computer and still maintain a consistent dictation experience across computers. A separate
license, however, must be purchased for each additional speaker whose Voice Profile or Voice Profiles is or are being used by the Software.



Licensee may authorize a third party to use the Software in connection with any of Licensee’s Voice Profiles solely for the purpose of performing
editing or correcting functions for Licensee; however, such third party must purchase a separate License to create his or her own Voice Profile.
This license permits the Licensee to install the Software Package on an additional machine to use the Software for the transcription of audio files
from many licensed users provided that the Licensee has purchased a license of the Software Package for this purpose. This license for the
Software Package does not allow Licensee to use the Software as a Run-time Engine.

2. Nuance’s Rights

Licensee acknowledges that the Software Package consists of proprietary information and products of Nuance (or other third parties) protected

under United States or other patent, copyright, or trade secret laws. Licensee further acknowledges and agrees that all right, title and interest in
and to the Software Package, and each component thereof, are and shall remain with Nuance. This Agreement does not convey to Licensee an
interest in or to the Software Package but only a limited right to use, revocable in accordance with the terms of this Agreement.

3. Term

This License is effective upon Licensee’s first installation and/or use of the Software and shall continue until terminated. Licensee may terminate
this Agreement at any time by returning the Software Package to Nuance. Nuance may terminate this Agreement upon breach by Licensee of
any terms hereof. Upon such termination by Nuance, Licensee agrees to uninstall the Software and promptly return the Software Package to
Nuance.

4. Other Restrictions
(a) Licensee may not sub-license, rent, lease, or otherwise commercialize the Software Package in any manner.

(b) Licensee may not reverse engineer, decompile, modify, create derivative works (except for Voice Profiles or custom vocabularies as
set forth in the accompanying documentation) of, or disassemble the Software. You may not use any feature of the Software to create
works such as custom vocabularies or language models for sale to third parties or re-sale by third parties, and/or to commercialize

in any other manner. The foregoing restriction is applicable to you except to the extent that such restriction is expressly prohibited by
applicable law.

(c) Licensee may not modify, make additions to or otherwise adapt the Software Package, or use the Software in conjunction with
other software or data packages, for the purpose of enabling or adding features or functionality from another version or edition of the
Software or development tool associated with the Software.

(d) Licensee may only use the Software in accordance with and in the manner intended by its accompanying documentation.

(e) Licensee may not publish the results of benchmarking the Software against competitive software, except to the extent that the
foregoing restriction is expressly prohibited by applicable law.

(f) Licensee may not transfer or assign this license or the Software Package to any third party without the prior express written
consent of Nuance Any changes to, modifications to, or derivative works (except as set forth above) of the Software shall become the
exclusive property of Nuance except to the extent that the foregoing restriction is expressly prohibited by applicable law.

5. Activation

Nuance has designed the Software to prevent unlicensed use of the Software. Licensee agrees that Nuance may do so. In particular, use of
the Software requires that Licensee activate the Software as described during the installation of the Software. During such activation, Nuance
may collect certain non-personal technical information from Licensee’s computer concerning Licensee’s computer or network. Licensee agrees
that Nuance may do so. Licensee may be required to reactivate the Software if Licensee modifies its computer hardware, the Software, or the
operating system.

6. Notifications

The Software contains a component that will automatically activate Licensee’s Internet browser and attempt to initiate a connection through the
Internet to a website maintained by Nuance. This connection will be made using the Internet connections and telephone lines under Licensee’s
control. From time to time, Licensee may receive notices about the Software or other information through this Internet connection. By installing
the Software on Licensee’s computer, Licensee hereby consents to have the Software initiate a connection through the Internet to Nuance’s
website, to use Licensee’s resources to connect to such website, and to receive notices about the Software and other information through this
Internet connection.



7. Proprietary Rights

Title, ownership rights, and intellectual property rights in the Software Package shall remain in Nuance and/or its suppliers or licensors. Licensee
acknowledges such ownership and intellectual property rights and will not take any action to jeopardize, limit, or interfere in any manner with
Nuance’s or its suppliers’ or licensors’ ownership of or rights with respect to the Software Package. The Software Package is protected by
copyright and other intellectual property laws and by international treaties.

8. Disclaimer of Warranty

THE SOFTWARE PACKAGE IS PROVIDED ON AN “AS IS” BASIS, WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION
THE WARRANTIES THAT IT IS FREE OF DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING. THE
ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS BORNE BY LICENSEE. SHOULD THE SOFTWARE PROVE
DEFECTIVE IN ANY RESPECT, LICENSEE AND NOT NUANCE OR ITS SUPPLIERS OR RESELLERS ASSUMES THE ENTIRE COST OF ANY
SERVICE OR REPAIR. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS AGREEMENT. NO USE OF THE
SOFTWARE IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER. SOME STATES OR JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY MAY LAST, SO THE ABOVE LIMITATIONS
MAY NOT APPLY TO YOU.

9. Limitation of Liability

IN'NO EVENT WILL NUANCE BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, ECONOMIC OR CONSEQUENTIAL DAMAGES,
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE PACKAGE, INCLUDING THE SOFTWARE, DOCUMENTATION, OR
MICROPHONE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO CASE SHALL NUANCE'’S LIABILITY EXCEED THE
AMOUNT PAID BY LICENSEE FOR THE SOFTWARE PACKAGE. SOME STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO IN THOSE STATES OR JURISIDICTIONS, THE ABOVE
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. AS A CONDITION OF YOUR USE OF THE SOFTWARE PACKAGE, YOU AGREE

TO INDEMNIFY NUANCE FOR ALL CLAIMS RELATING TO YOUR USE, REPRODUCTION AND/OR RECEIPT OF CONTENT THROUGH

USE OF THE SOFTWARE PACKAGE. LICENSEE UNDERSTANDS THAT SPEECH RECOGNITION IS A STATISTICAL PROCESS AND THAT
RECOGNITION ERRORS ARE INHERENT IN THE PROCESS. LICENSEE ACKNOWLEDGES THAT IT IS LICENSEE’S RESPONSIBILITY TO
CORRECT RECOGNITION ERRORS BEFORE USING THE RESULTS OF THE RECOGNITION.

10. Assignment
Licensee shall not sublicense, rent, lease or lend the Software to another party.

11. Remedies

If Licensee breaches this Agreement, Licensee shall promptly return the Software Package to Nuance. A breach by Licensee will irrevocably
harm Nuance, and Nuance shall be entitled to injunctive and/or other equitable relief, in addition to any other remedies afforded by law.

12. Governing Law
This Agreement shall be governed by the laws of the Commonwealth of Massachusetts.

13. Severability

Should any term of this Agreement be declared void or unenforceable by any court of competent jurisdiction, such declaration shall have no
effect on the remaining terms hereof.

14. No Waiver

The failure of either party to enforce any rights granted hereunder or to take action against the other party in the event of any breach hereunder
shall not be deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions in the event of future breaches.

15. United States Government End Users

This Section applies to all acquisitions of the Software by or for the Federal government or by any prime contractor or subcontractor (at any tier)
under any contract, grant, cooperative agreement, or other activity with the Federal government. By accepting delivery of the Software, the
government hereby agrees that this software qualifies as “commercial” computer software within the meaning of the acquisition regulation(s)
applicable to the procurement. The terms and conditions of this Agreement shall pertain to the government’s use and disclosure of the Software
and shall supersede any conflicting contractual terms or conditions. If this Agreement fails to meet the government’s needs or is inconsistent in
any respect with Federal law, the government agrees to return the Software, unused, to Nuance. The following additional statement applies only
to acquisitions governed by DFARS Subpart 227.4 (October 1988): “Restricted Rights—Use, duplication, and disclosure by the Government is



subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-
7013 (Oct. 1988).” In the event any of the above referenced agency regulations is amended or replaced, the equivalent successor regulation
shall apply instead.

16. Licensee expressly agrees that Nuance is not a licensed health care provider and if that the Software is not a substitute for independent
medical decision making by a qualified health care practitioner. Licensee is solely responsible for its own conduct with respect to patient care
and any reliance upon the Software shall not diminish Licensee’s responsibility for patient care that Licensee may be involved or associated with.

17. Consent to Use Of Speech Data

The Software has a feature by which you may enable Nuance to collect Speech Data (as defined below). By turning on the feature to provide
Nuance with Speech Data, you acknowledge, consent and agree that Nuance may collect and use the Speech Data as provided hereunder. The
parties agree that Speech Data shall only be used by Nuance or third parties acting under the direction of Nuance, pursuant to confidentiality
agreements, to tune, enhance and improve the speech recognition and other components of the Software, and other Nuance services and
products. Nuance will not use the information elements in any Speech Data for any purpose except as set forth above. “Speech Data” means
the audio files, associated transcriptions and log files provided by you hereunder or generated in connection with the Software.

18. Export Restrictions

The Software is subject to United States export laws and regulations. You must comply with all domestic and international export laws and
regulations that apply to the Software.

19. Country Unique Terms

For licenses granted outside of the United States or Canada, the following terms are in addition to, or replace or modify the referenced terms
above. All terms above that are not changed by these amendments remain unchanged and in effect.

19.1. Governing Law. The phrase “This Agreement shall be governed by the laws of the Commonwealth of Massachusetts.” is
replaced as follows “This Agreement shall be governed by the laws of Ireland.”

19.2. Where Licensee acquired the Software in the European Economic Area and uses the Software to process personal data (as
defined by European Union Directive 95/46/EC); the terms of Nuance’s privacy policies shall apply http://www.nuance.com/company/
privacy/.

19.3. Where Licensee acquired the Software in the European Economic Area Licensee may not transfer or assign this license or the
Software Package to any third party without the prior express written consent of Nuance which shall not be unreasonably withheld.
The foregoing shall not apply in cases of any statutory entitlement to transfer or assign this license or the Software Package to a
third party, which may apply in certain cases. Please consult www.nuance.com for further information or contact Nuance’s customer
support service so that Nuance can verify the individual request.

Copyright © 2014 Nuance Communications, Inc. All rights reserved. Nuance, the Nuance logo, Dragon and NaturallySpeaking are trademarks
or registered trademarks of Nuance Communications, Inc. or its affiliates in the United States and/or other countries. The Software contains
Adobe Flash® Player software by Adobe Systems, Incorporated, Copyright © 2008 Adobe Systems, Incorporated All rights reserved. Flash is a
trademark of Adobe Systems, Incorporated
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AquaticPrime Framework
Copyright © 2006-2010, Lucas Newman

All rights reserved.

BDAlias
Copyright © 2001-2010, bDistributed.com, Inc.

All rights reserved.

GTMStackTrace.m
Copyright 2007-2008 Google Inc.

Licensed under the Apache License, Version 2.0 (the “License”);
you may not use this file except in compliance with the
License. You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software-
distributed under the License is distributed on an “AS IS” BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either
express or implied. See the

License for the specific language governing permissions and
limitations under the License.

CTGradient

Copyright © 2007-2010 Chad Weider.
Some rights reserved:
http://creativecommons.org/licenses/by/2.5/
Log4Cocoa

Copyright © 2002-2010, Bob Frank

All rights reserved.

Shortcut Recorder

Copyright © 2006-2010, contributors to ShortcutRecorder.
Contributor details at:
http://wafflesoftware.net/shortcut/contributors/

All rights reserved.

The MIT License
Copyright (c) 2008 Big Nerd Ranch, Inc.

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated documentation
files (the “Software”), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so,
subject to the following conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.
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Dragon Dictate Introduction 1

Introduction
Dragon Dictate is a speech recognition application. You can use your voice to create
content and control your computer.

It can interpret your words as a command, in which case it will obey the command.
For example, you can tell Safari to select a link in the text of a page you’re viewing,
by saying Move to Next Link; then you can tell Safari to go to the linked page, as

if you had clicked that link with the mouse, by saying Jump to This Link or Mouse
Click.

It can interpret your words as dictation, in which case it will type what you said, at
the insertion point or selection in the frontmost application. For example, you can
place the insertion point at the start of a new empty word processing document and
say Good morning, period, and Dragon Dictate will type: Good morning. You can
also ask Dragon Dictate to read your words back to you by saying Read Document,
by selecting text and saying Read Selection, or by telling Dragon Dictate to read
from one word through another.

It can transcribe the speech in an audio file and produce a text document
containing what was said. For example, you can speak ideas or notes into a
digital audio recorder or smartphone while away from your Mac and transcribe the
recording with Dragon Dictate when you return.

How does Dragon Dictate work? It isn’t magic or mysterious. Behind the scenes, Dragon
Dictate interprets the words you speak using a powerful and highly accurate speech
recognition engine with an extensive, flexible vocabulary. To obey your commands or
type your dictation, Dragon Dictate uses a combination of technologies built into OS X,
such as Accessibility and AppleScript.

You can get up and running with Dragon Dictate very quickly, but you will have some
preparation to do beforehand, and you will have some learning to do as you go along.

Preparation. Before Dragon Dictate can interpret your speech, you must provide a
sample of your speech, so that Dragon Dictate knows what your voice sounds like
and how you pronounce your words.

Learning. Dragon Dictate can’t obey just any old commands. When you start out,
you won’t know Dragon Dictate’s built-in commands; you’ll learn them as you go
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along (especially the ones you use most frequently). When dictating, you won'’t
always know Dragon Dictate’s terms for punctuation that you want to use; these,
too, you'll learn as you go along. (Of course you’ll have plenty of assistance along
the way; Dragon Dictate has a window listing its commands and punctuation, plus
you can consult this manual and the online help.) You'll also learn to speak more
clearly and smoothly; speaking to a computer program takes practice.

With time, you’ll become more experienced, and most of the things you do with Dragon
Dictate will become second nature. You may even customize Dragon Dictate’s abilities
to suit your needs. For example, you might add to its repertory of commands. Dragon
Dictate comes with built-in specialized commands for controlling itself plus a number

of commonly used applications, along with a set of general commands for use with

any application. You can write your own commands for inserting text, running a script,
choosing a menu, and so forth. And you’ll almost certainly customize Dragon Dictate’s
understanding of your speech.

You can add to Dragon Dictate’s vocabulary, in case you use words that it doesn’t
already know. And when Dragon Dictate types what you dictate and gets it wrong, you
can train Dragon Dictate to understand you better, telling it the right interpretation of what
you said and improving its ability to interpret your speech correctly in the future.

Installation

Before you can use Dragon Dictate, you must have two kinds of hardware that conform
to its requirements: your computer, and an audio source: a microphone for dicating and
a device for recording audio to be transcribed, if you wish to use that feature. You can
transcribe audio from files in the mp3, mp4, way, aif, aiff, m4v, and m4a formats.

Minimum System Requirements
— 05X10.8.30r10.9

— 4GB of RAM
— 3GB of disk space
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Microphone Requirements

— You can use a USB or Bluetooth microphone, the internal microphone of your Mac,
or an iOS or Android device running the Dragon Remote Microphone app. Ideally,
the microphone should be of high quality, with noise-cancelling abilities and should
be on the list of microphones certified and supported by Nuance. You can find a list
at the Nuance web site.

— o learn how to set up your iOS or Android device as a microphone, see “Using the
Dragon Remote App as a Microphone.”

If you’re using a USB microphone, plug it into one of your computer’s USB ports. If
you’re running short of open USB ports, it might be worth investing in a powered USB
hub. You can then plug some of your USB devices into the hub, and plug the hub into
the computer. Some USB microphones, however, must be plugged directly into the
computer.

Initial Installation
Use the following checklist to make certain you are ready to install Dragon Dictate.

1 Your microphone is connected to your computer, you have the Dragon Remote
Microphone app for an iOS or Android device, or you’ve decided to try the internal
microphone of your Mac.

L1 Your computer is connected to the Internet. You will need an Internet connection in
order to enter your serial number and license your copy of Dragon Dictate.

When you’ve completed the above checklist, you're ready to begin installing Dragon
Dictate.

If you purchased the software in a box, insert the included DVD into your Mac. If you
purchased the software as a digital download, locate the disk image file and double-click
it.

A new window will open. You'll see an icon named Install Dragon Dictate in the window
— double-click it to begin the installation process. The Dragon Dictate Installer will walk
you through the process. Click Continue to advance to the next step or Go Back to
return to the previous one
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When you arrive at the Installation Type step, we recommend that you use the standard
installation, although you can click the Customize button to determine which elements
you want to install. If you decide to stay with the standard installation after all, click
Standard Install to return to it.

Custom install allows you to opt out of the
Web Plug-Ins. See “Rich Internet Application
Nuancs el BN Extensions” later in this manual.

Dragon
Dictate

After you click Install, the installation process will begin; you will need to enter your
administrator password to give the installer access to place files on your Mac.

When the installation process finishes, go to the Finder, click on Applications on the left
side of the window, and find Dragon Dictate. Double-click it to launch the software.

After you click Accept in the License Agreement window, Dragon Dictate asks for

the serial number you received when you purchased the software. (You can copy it
(Command-C) from its source, click in the first field next to Serial Number, and paste it
(Command-V) without having to retype it.) If you can’t enter it right away, click Trial. You
can launch Dragon Dictate up to 5 additional times after the initial launch before you
must enter a serial number. (The Trial button keeps track of your remaining launches.)
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The Registration dialog.

Dragon Dictate’s installation is now complete, but you may need to tell OS X to allow the
software to control your Mac, as explained in the next section.

Enabling Accessibility
The first time you launch Dragon Dictate, you may see a dialog box with one of these

messages, depending on the version of OS X you’re using:

Dragon Dictate requires Accessibility to be

enabled.
Select "Enable access for assistive devices” in the YOU’II sSee thlS N OS X 1 0.8

Accessibility preferences.

| More Info | [ Open System Preferences ]
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Dragon Dictate requires Accessibility to be
enabled.

Allow Dragon Dictate to control your computer in the

Privacy pane of Security & Privacy preferences. You!“ See thlS |n OS X 109
| MoreInfo | [ Open System Preferences ]

In OS X 10.8, click Open System Preferences and open the Accessibility pane. Click
the checkbox next to “Enable access for assistive devices,” as shown:

Note: You will be asked for your administrator
password.

In OS X 10.9, click Quit. You will see this dialog box under the first one. Click Open
System Preferences.

If you click Deny, you will still be able to give
"D Dictate" Id like t trol thi. : .
-q- co:g:t:r u‘;.ing a::::sihil:y foe:::r;:. : Dragon DICtate COﬂtrOl Of yOUr MaC by Openlng
b_. Grant access to this application in Security & Privacy System Preferences. (C||Ck on it in the Dock or
preferences, located in System Preferences. h th A | ; th ; | ﬂ: f th
— cnhoose the € menu a e 1top left o e
@) | Open System Preferences | m pp P
screen and click System Preferences.)

System Preferences will open and display the Security & Privacy pane. Click the lock in
the bottom left and enter your adminstrator password. Then click the checkbox next to

Dragon Dictate, as shown:
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After you have enabled accessibility in either OS X 10.8 or 10.9, you will proceed to the
Profiles window, where you may need to create a profile, as explained in the next section.

Creating a Profile

In order to use Dragon Dictate, you need a profile. If you have installed the software for
the first time, you will have no profile. Therefore, Dragon Dictate immediately offers to
create one after you have registered the software.

A profile is a complete set of data on how you speak: what your voice sounds like, and
what vocabulary you use. In order to speak into Dragon Dictate, you must have at least
one profile.

In many cases, one profile is all you’ll need. But you'll need multiple profiles if different
people are using Dragon Dictate. Each person will need to train their profile to their voice.

Every profile has a name, which uniquely identifies it. WWhen you create a profile, you start
by giving it a name.

The first time you use Dragon Dictate, you will be prompted to create a new profile. If
you previously used MacSpeech Dictate, the profiles associated with that application
will automatically appear when you launch Dragon Dictate. However, to use them, you
will need to upgrade them by double-clicking the profile name or clicking the “Upgrade”
button in the bottom right corner of the window. Profiles that have not been upgraded

have a warning icon next to the profile name: A A profile without a connected audio
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source displays a lightning bolt inside a triangle: A Please note that you can’t upgrade
a profile that has a missing audio source.

Any commands and vocabulary you previously added to a profile will be preserved when
you begin the upgrade process, which cannot be undone. After the software updates
the older profile, you’ll see the Voice Training window. You must complete a new Voice
Training session. As in previous versions of the software, Dragon Dictate will stop the
training session when it has collected enough speech, and you can always return to
Voice Training any time to read more stories and improve the application’s accuracy.

When you create a new profile, you begin the Profile Enrollment process. The first step
involves giving your profile a name.

»»»»»»

ame: Brigen
...........

<<<<<<<

The Profile Enroliment process. Give your new
el ' profile a name and click Next.

The next step in the Profile Enrollment process involves choosing and naming your audio
source.

------

Click the dropdown next to Microphone to select an audio source, then enter a name in
the field below. If you want to see the microphones connected to your Mac, click Sound
Input Preferences..., which will open the Sound pane in OS X System Preferences.
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You can also click the radio button next to Transcription and enter the name of the
device that you will use for recorded speech files, such as a smartphone or digital voice
recorder. When you do so, you will skip microphone setup and voice training and train an
audio source for transcription.

At a minimum, you must enter a name for your audio source before you can click Next
and continue. If you don’t have an audio source or an iOS or Android device that you
can use with the Dragon Remote Microphone app, you can use your Mac’s internal
microphone. If you want to use another audio source later, you can simply add it to
your profile by clicking the plus (+) sign next to Dictation under Audio Sources in the
Profiles window. You would name the audio source, click Continue, and follow the
process explained in Microphone Setup.

When setting up a profile for the first time, continue with Region and Accent:

Choose from the United States, the United
Kingdom, Australia, Canada, India, New Zealand,
and Singapore. The selected region determines
spellings and word usage, along with some
auto-formatting.

Choose from American, American - Inland
Northern, American - Southern, American - Teens,
Australian, British, Indian, Latino, and Southest
Asian. Your selection helps Dragon Dictate
improve its accuracy.

Click Next after making each selection. You will then be prompted to save your new
profile. By default, it’s saved in the Documents folder. You can click the dropdown next to
Where to select another location; click the down arrow to the right of the Save As field
to navigate to a folder if it doesn’t show up in the dropdown list.
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Finding a place to save a profile after clicking the

down arrow to the right of the Save As field.

After you finish setting up your profile, Dragon Dictate creates it; a progress dialog shows
you that the software is working on it.

Dragon Dictate

Making Profile "My Profile”... ) ) . .
While creating a profile, Dragon Dialog

puts up a progress dialog.

e . B B B B B B B B e T T e |

After you create a profile, Dragon Dictate automatically proceeds to microphone setup,
unless you chose a transcription audio source instead of a dictation microphone, in
which case you should skip ahead to “Transcription Training” for an explanation of the
Process.

Tip. You are about to begin speaking to Dragon Dictate. It might be a good idea
to read the “Tips on Speaking” section now. If your microphone is a headset,
put it on! Position the microphone correctly.

Dragon Dictate next presents a dialog describing the proper positioning of your micro-
phone. Position the microphone as shown. A checkbox lets you skip this dialog in the
future, but don’t ignore the advice in this dialog! The microphone should be near your
mouth but not too close, and it should be slightly off to one side so that puffs of breath,
either from breathing or from articulation, are not interpreted as speech. You should
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position the microphone correctly, and you should attempt to recreate its position each
time you use Dragon Dictate. Click OK when you’re ready to proceed.

L2.0.8 Profiles |

Connecting a Microphene to your Macintosh

A Nuance-approved microphone for Mac is required in order to achieve the best accuracy
and receive technical support.

If your microphone has analog connectors, plug them into the appropriate receptacles in a
USB audio adapter and then plug the adapter into an open USB port on your computer.

P i Headset Microph:

Dragon Dictate shows you the correct
microphone position. Read it, do what
it says, and click OK.

Do not place the microphone { | i
directly in front of your mouth.
Place it off to the side, about a
thumb's width away from the
corner of your mouth. Make sure
the correct side, the side with the
waord "talk” or a dot, is facing you.

Other Microphones
Refer to your microphone's user manual for important information on setup and use.

Note: Microphone quality and positioning significantly affect recognition accuracy.

|| Don't show this information again. | Cancel | OK

Microphone Setup

Microphone setup takes place in the Microphone Setup window, and involves
adjusting the sound input level. You must go through the setup process for each new
microphone you associate with a profile.

AN Microphone Setup.

Volume Adjustment

[ Manual Gain: 9 50 E H
f The Microphone Setup window is
i o where you adjust your sound input
level. To begin, click the microphone
icon with the red “stop sign.”




Dragon Dictate

Introduction 12

To begin adjusting your sound input level in the Microphone Setup window, click the
microphone icon with the red “stop sign.” The window changes to display a paragraph of

text for you to read aloud.

8NN Microphone Setup

Volume Adjustment =
Begin reading so Dragon Dictate can properly adjust your microphone. E :i U

"I Manual Gain: O -~ 78 |

Speak at a normal conversational volume and pace. Microphone Setup
listens to your speech. It will automatically adjust the recording volume to suit
your voice and environment.

When the program has heard enough, a portion of what you just said will be
played back. Listen for any problems such as too much background noise or
distortion.

If you reach the end of this text, please continue reading from the beginning.

Read aloud the paragraph displayed
in the box in the Microphone Setup
window. As you read, Dragon Dictate
will adjust your microphone’s sound
input level.

L= o )y

Read the paragraph of text aloud. Speak slowly, naturally, clearly, and continuously,

but do not worry about enunciation, because Dragon Dictate is not listening to your
words; what'’s important is how loudly you speak. Try to speak at a natural, consistent
loudness, representative of how you will normally speak to Dragon Dictate in your current
environment. As you speak, the level indicator to the right of the microphone icon shows
your sound input level, a combination of how loudly you speak and how Dragon Dictate
has adjusted the microphone sound input level; and the horizontal gain indicator slider
moves left and right as Dragon Dictate experiments with different sound input levels.
When Dragon Dictate has heard enough, and has set your microphone sound input level
optimally, it will turn off the microphone and switch away from this window automatically.
If you reach the end of the paragraph before that happens, start reading aloud from the
beginning again.

Note. To use the Manual Gain Setting, click the Microphone icon, and slowly
slide the slider to the right while speaking until you see the window that says
“Finished.” Dictate will play back the last few seconds of your speech.
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In the next window, click the left-arrow button at the lower right to return to the previous
window, if you think there might have been a problem with your microphone and you
would like to train it again. (See “Sound Input Troubleshooting” for tips on diagnosing
sound input problems.) Otherwise, click Voice Training... to continue.

8.0.0 Microphone Setup

Finished

Your microphone's volume has been adjusted.

Dragon Dictate has adjusted your
microphone sound input level. If you're
creating a profile, click Voice Training
to proceed.

The next step in creating a profile is to do a session of voice training. This is where you
read aloud a little story, so that Dragon Dictate can learn how your voice sounds and
how you pronounce your words. Click Voice Training to proceed. You'll be taken to the
Voice Training window.

Voice Training
Voice training is a process where you read aloud a little story. It takes place in the
Voice Training window.

Tip. This would be a really good time to read the “Tips on Speaking” section
if you haven’t done so already. Or maybe read it again. If your microphone is a
headset, put it on! Position the microphone correctly.

During voice training, Dragon Dictate listens to your speech, matching it up with the
words of the story. In this way, Dragon Dictate learns how your voice sounds and how
you pronounce your words. Voice training is the most important step in creating a profile.
This is why you need a different profile for each different person.
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Dragon Dictate presents the Voice Training window, containing a description of what’s
about to happen. Click the right-arrow button, at the lower right, to proceed.

When you do voice training in an existing profile, you are shown a window where you
can select from among four stories to read from; stories you’ve previously read are
marked with a “green circle” icon. But when you first create a profile, the first story is
automatically selected for you.

(800 Voice Training "

Voice Training helps Dragon Dictate adapt to the way you speak. During this
process, you will be asked to read a story, including punctuation. This should
take you five minutes or less. The training process will stop when enough speech
has been collected, usually before you reach the end of the story.

The Voice Training window, before

o e b e A e, ek o W s o reading a story. To proceed, click the
start with the next word. . .

right-arrow button at lower right of the
The progress bar on the panel will show how far along you are in the story. W| ndOW

Click the right arrow to continue.

Next, Dragon Dictate presents a window in which you can choose one of four training
stories to read. Each is geared toward different types of users. Click the one that best
suits your needs and click the right arrow to continue.

| 8.0.0 Voice Training

The program needs to hear your voice to give you the best recognition results.
Please choose one of the following stories to read.

Welcome (Easier Reading: Instructional) The VOlce Tra”"“ng WlndOW |n Wthh

Children's Stories (Reading for Children)
Stage Fright (Medium Reading: Humor)

Sales Email M i - you select the story that best suits
your needs.

Click the right arrow to continue.
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In the next window, the microphone is off, as signified by a red “stop sign” icon, and
training will not begin until you click the icon.

&M Voice Training

O]

N o o The Voice Training window, ready for
E s e you to start reading a story. Click the
microphone icon (with the red “stop
sign”) to begin.

(][]

Here’s what’s going to happen when you click the microphone icon. Dragon Dictate will
turn on the microphone (the icon will change to a green circle) and will present you with a
short page of text to read aloud — usually just a sentence or two. You must read all the
text, including punctuation (because that’s what you do when you dictate). To help you
with this, punctuation is printed in capital letters, but you don’t read it any special voice.
You should read in fairly brief utterances, pausing after each utterance. Dragon Dictate
signifies its understanding by turning each utterance green. When you reach the end of
the page (all text has turned green), Dragon Dictate automatically “turns the page” for
you.

If Dragon Dictate has trouble with what you said, it turns the current utterance red. If this
happens, you need to read the red text again. If Dragon Dictate still doesn’t understand
(the same text remains red), you can click Skip Word to proceed past that text. If you feel
that things are really going badly and that you’d like to begin reading this story all over
again, click the left-arrow button.

As you read, keep an eye on the sound input level indicator (the vertical bar to the right
of the microphone icon). Speak at a level that keeps this at about the middle of the green
section.
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Warning. The speech recognition engine has no experience with your voice to
build on during the first few pages of a new profile’s Voice Training story, so your
utterances must be quite short and careful, and the pauses between them must
be long, to give the engine a chance to catch up and turn the text green. You
will probably need to read like this: “Hi. Carolyn. Here are some. New tips. To
post on our website.” After the first couple of pages, you will find that you can
start speaking much more naturally.

1800 Voice Training

BRI OOOOOO00 T skip werd | EH H
Hi Carolyn COMMA here are some new tips to post on our website PERIOD The f|rSt page Of the VO|Ce Tl’alnlng
By end of April COMMA | plan to send you new videos COMMA as well as § L.
updated versions of the User Guide and Administrator APOSTROPHE-S S‘tory for a new prof”e. Th|S IS ‘the
Guide PERIOD

sales-oriented training story. The first
few words have been read and have
turned green.

As your reading of the story proceeds, Dragon Dictate “turns the page” for you. Progress
from page to page is shown by the horizontal progress indicator above the text. If you
need to pause at any time (to clear your throat, get a drink of water, sneeze, stretch,
whatever), click the microphone icon to turn it to a red “stop sign”; when you're ready to
proceed, click it again to turn it into a green circle once again, and carry on reading.
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[ N el Voice Training

T H A page late in the first Voice Training
?H ‘ story. You can tell the story is nearly
;:‘;gwledge of the topic being talked about DASH 10c;ec:de whether a speaker | ﬁniShed’ because the green horizontal
PERIOD CLOSE QUOTE T o QUOTE er OPEN GUOTE facream progress indicator is nearly full. Notice
the level of the sound gain indicator at
the right of the microphone icon; this
is about the level where you want to
(+) | keep it, by speaking louder or softer.

1 e e I | | Skip Word

When you finish reading the last page of the story, Dragon Dictate will analyze the data
it has gathered about your voice and feed that analysis into your profile. (Actually, this
might happen in the middle of the last page, or an earlier page, if Dragon Dictate feels it
has sufficient data.)

AN Voice Training

Dragon Dictate has collected enough speech to perform training. You do not
have to read the entire story.

Dragon Dictate analyzes your reading
of the story and feeds the analysis
You may return to Vioice Training and read more stories to improve Dragon |nto yOUF pl’Of”e Be patlent Whlle
Dictate's ability to recognize your voice by selecting “Voice Training...” from the

processing proceeds.

After processing is complete, you will be ready to dictate into all your favorite
Macintosh applications.

"Tools" menu.
Processing Training...

- ™W™W™W™LLW™LLTW™LLW™LLW™LLIW™LLW™LLW™LTW™LOW™ W W,

e

Please note that Dragon Dictate’s analysis of your reading of the story is extremely
calculation-intensive and can take a long time (possibly as long as it took you to read the
story). We recommend that you do not do anything else with your computer while this is
happening. Do not force quit Dragon Dictate (doing so may ruin your profile).

As this dialog informs you, you can read this story again later, or choose from two other
stories, by choosing Tools > Voice Training. It's best to use Dragon Dictate for a while,
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though, speaking and dictating, refining the way you speak, and improving recognition
through Recognition Training. Most users do not find it necessary to do any Voice
Training beyond the first story.

When analysis of your reading is complete, the Voice Training window presents a final
dialog. Click Tutorial to proceed.

| 8.0.0 Voice Training

Congratulations, your profile is ready for use!

i ek e Analysis of your reading is complete.

g’:a;r;ﬁzU:g:szst:Z::Pfore the Help and Tools menus, as well as Click Tutorial to proceed, or click
the personalizing the vocabulary or

What'’s new in Dictate 3.5 links to

learn more.

For details about this version, including Smart Format Rules, please
see: What's new in Dictate 3.5.

If you have just completed the first Voice Training of your first profile, Dragon Dictate
presents the Welcome screen of the Interactive Tutorial. This tutorial walks you through
the features you need to be aware of before you begin using the software for the first
time. It includes some simple hands-on exercises.

Welcome to the
Interactive Tutorial

These step-by-step lessons include simulations that focus
on what everyone should know in order to dictate and
edit text efficiently.

Please take this opportunity to quickly learn essential tips
and practice habits that will get you the best results.

The Welcome to the Interactive
Tutorial window. Click Next to begin.

Click Next to get started.

Welcome Basics Dictating Recognition | Spelling ‘ Editing More... l
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The Interactive Tutorial provides simulations that get you familiar with the basic functions
found in Dragon Dictate, including good dictation habits, how to make corrections with
your voice, how to add words to the software’s vocabulary with Spelling mode, and
more. We strongly recommend that you complete all the exercises so you are ready to
begin using Dragon Dictate when you are done.

After you complete the Interactive Tutorial, you return to your working, active profile.
You are ready to speak to Dragon Dictate and have it type what you say and obey your
commands. If you have just installed Dragon Dictate for the first time and are curious
about where its parts were installed, read “What’s Installed Where.”

Any time you want to view your available profiles, you can do so by selecting “Profiles...”
under the Tools menu. While you’re there, you can add an audio source to a profile by
clicking the plus sign in the Audio Sources box.

You can also change the images associated with your profiles. In the Profiles window,
click the image to the left of a profile name to bring up a new dialog box. Click the down
arrow next to “Recent Pictures” at the top of the dialog box to view images to choose
from; they include recent iChat or Messages user images as well as images associated
with your OS X account. You can also click “Choose...” to find an image located
elsewhere on your Mac, or you can click the camera icon to use your Mac’s built-in iSight
or FaceTime camera, or another camera connected to your computer, to snap a photo
of yourself.

After you select an image, you can move it around to center the part of it you want to
use. The slider lets you change its size. When you're satisfied, click “Set” to use it, or
click “Cancel” if you’d rather return to the image you’re currently using.

Transcription Training

If you decide to train a transcription audio source first, rather than a dictation micro-
phone, or if you later need to add a transcription audio source to your profile, you’ll have
to supply an audio file that’s at least 90 seconds long, without significant gaps of silence.

The file needs to be in the aif, aiff, m4a, m4v, mp3, mp4, or wav format. It should have
been dictated into an iPhone (3G or later), iPod touch (4th generation or later), iPad,
Android or other smartphone -- or any other digital recording device, or into a computer
microphone.
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Note that if you don’t train an audio source while creating a profile and you later click
Transcription... in the Tools menu, you will automatically be asked to supply an audio
file that’s at least 90 seconds long for training.

A dialog will open and ask you to find the audio file you want to use for training. Select it
and click Open. The Transcription Training window will open; a transcription of the audio
will begin appearing and a progress bar at the bottom will let you know when it is done.

When it’s finished, you can click anywhere in the text, which will cause the phrase to
become highlighted, with a dialog box pointing at it. In that dialog box, you can choose
to ignore or accept the text, with the option to click the triangular play button to hear

it played back. You can also type in the text box to change the text, if it was analyzed
incorrectly; doing so helps train Dragon Dictate for future transcriptions.
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O seceads of B0 secaech required for Traiseg b bees actected.

A

Notice that as you accept text for transcription training, Dragon Dictate keeps track of
the 60 seconds of accepted text that it needs to perform the necessary training. The text
turns green as you accept it, the same way the text turns green as you read the initial
training story when you set up your profile, and when you have accepted enough text,
the bottom of the training window says “You can Train at any time,” with a Train button
to the right.

You will see the following progress bar after you click the Train button:

1. 8006 Transcription Training

Calibrating...

When Dragon Dictate has finished training, it begins transcribing the file into a new Note
Pad window. When transcription has finished, a dialog appears asking if you want to

go to the Profiles window to select another profile or audio source, transcribe another
audio file, or edit your transcription results. If you decide to open the Profiles window

or transcribe another audipo file, your transcription results will still be in the open Note
Pad window, so you can return to work with it further or copy and paste it into another
application.
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What do yos want 50 oo mang?

Your audio source is now trained to work with the current profile. You can add more
transcription audio sources any time through the Profiles window.

Giving Dragon Access to Your Email Contacts

The first time you launch Dragon Dictate, a dialog will appear that says Dragon Dictate
would like to access your contacts. Click OK to allow Dragon to access your email
contacts for use with such generated commands as Send an Email To XXX or Create a

Note For XXX, where “XXX” is the primary addressee. See “Generated Commands.” to
learn more.

“Dragon Dictate” would like to access
ur contacts.
access to your contacts so that
the ™

of
erated if ‘Generate Email
ption is enabled under the Commands

| Don’t Allow |E—OK—-]

After clicking OK, you still need to check the box next to Generate Email Commands
in the Preference window’s Command pane.

If you click Don’t Allow, you won’t be able to use those commands. If you decide later
that you want to allow Dragon access to your email contacts, open System Preferences
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in OS X and click on Security & Privacy. Click on the Privacy tab and grant access to
Dragon there.

23
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Interface
Dragon Dictate’s basic interface is extremely simple. This chapter will tour its key
features; details on some of these features appear in later chapters.

You can use Dragon Dictate while working in any application, so the purpose of Dragon
Dictate’s interface is to be present (so that you can control Dragon Dictate’s behavior)
without being in your way.

The Profiles Window

When you start up Dragon Dictate, you might see the Profiles window. Choose your
profile and click Continue. If you’d like to avoid seeing the Profiles window at startup,
uncheck Show Profiles Window in the General Preferences pane. Dragon Dictate will
then automatically load, when it starts up, the profile you were using when you previously
quit the application.

8.00 Profiles

Microphone: Dragon Remote Microphone

Region: United States
Accent: American

Audio Sources

~ The Profiles window. If you see this
window at startup, choose your profile

and click Gontinue.

T ———
The Status Window

The Status window is your control center for Dragon Dictate. It floats over the windows
of all other applications. Here you can turn the microphone on and off, change modes,
and more. For details, see “Status Window.”
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New Profile

f’ o >E= The Status window floats over all
v i applications.

The Available Commands Window

The Available Commands window lists the commands you can say to Dragon at the
moment. Any custom commands you’ve added are shown there too. It floats over the
windows of all other applications. For details, see “Available Commands Window.”

Available Commands

» Dictation
»Global

The Available Commands window tells
you what you can say at the moment.
To reveal the actual commands, click
a triangle.

The Dock Menu

The Dragon Dictate Dock menu provides commands for showing and hiding Dragon
Dictate’s windows, and for controlling modes and microphone state. The Dock menu is
available no matter what application is frontmost.
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i Untitled

Hide Status Window
Hide Available Commands

Microphone On

Dictation
P The Dock Menu lets you control Dragon

Spelling Dictate no matter what application is
Numbers

Sleep frontmost.
Options

Show All Windows

Hide

Quit
\‘\/’—J

The Status Menu ltem

The Dragon Dictate status menu item indicates whether the microphone is on or off,

and clicking it toggles the microphone state, unless you are using the Dragon Remote
Microphone app, in which case clicking it displays the barcode you can use to connect
your profile to the app. It provides a simple and convenient way to turn the microphone
on or off, no matter what application is frontmost, and even if the Status window is not
present. If you’d prefer not to see the status menu item, uncheck In The Menu Bar in the
Appearance Preferences pane.

h The status menu item controls the
microphone.

Keyboard Shortcuts
Dragon Dictate lets you define global keyboard shortcuts (“hot keys”) to perform each of
the following tasks:

— Turn the microphone on or off.

— Switch between Dictation mode, Spelling mode, Command mode, and Numbers
mode.

— Show or hide the Recognition window.
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— Dismiss the MouseGrid.

ein — 5%) o L__l( The“St’wortcuts Preferences pane. Click
e e g ot the “X” to delete the current shortcut and
Toggle Microphone: (__ i1 ¢ record a new one. After recording a new
e — shortcut, click the curved arrow to revert
Dismiss MouseGrid:  ariz to the original one.

These are all tasks that you can perform in other ways, such as using your voice, or
clicking in the Status window; the keyboard shortcuts are an optional convenience, and
many users happily ignore them or even disable them.

Important note: \When changing a keyboard shortcut, you should never assign a
key sequence that is the same as the one used to invoke Apple’s built-in dictation
capabilities found in OS X 10.8 and later. You should also not assign Apple’s built-in
dictation capability with a key sequence that includes Command-F9, Commmand-F10,
Command-F11, or Command-F12.

In addition, before using F-key keyboard shortcuts in Dragon Dictate, you should double-
check your settings in the OS X Keyboard preference pane:
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Using the Dragon or Android Remote App as a Microphone

You can use your iPhone (3G or later), iPod touch (4th generation or later), or iPad, or
Android smartphone, as a microphone by downloading the Dragon Remote Microphone
app from Apple’s App Store or Google Play (formerly called the Android Market). (iOS 4.2
or Android OS 2.2 or higher is required.)

Download and install the app on your device; Dragon Dictate will recognize it as a micro-
phone like any other. You can add it to your existing profile by clicking the plus sign next
to Dictation under Audio Sources, or you can create a new profile and choose it as
your microphone.

-

Click the dropdown next to Microphone and
select Dragon Remote Microphone.

After you have selected the Dragon Remote app as your microphone in Dragon Dictate,
you need to set it up on your device. The iOS app supports Bonjour, networking technol-
ogy from Apple that allows supported devices on a network to see each other; you can
use that method to quickly and easily set up your iOS device.

Make sure your device is connected to your home or office network before continuing.
You can’t use the app over a 3G cellular connection. If you’re in a location, such as a
coffee shop, with a public Wi-Fi network, you can use the Dragon Remote app over an
open router that doesn’t require a password. If the router is secure and requires a pass-
word, which is often the case at places like Starbucks, the Dragon Remote app won'’t
work because it will be blocked from connecting with your computer. If you’re attempt-
ing to use the Dragon Remote app at work and have trouble, contact your network
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administrator for assistance; it’s possible your workplace network has multiple subnets
set up for security reasons, in which case you will have difficulty connecting the app and
your Mac.

Setting Up the Dragon Remote App

Launch the Dragon Remote app on your device. On an iOS device, tap the gears icon
in the bottom right corner; on an Android device, tap the Menu button and then tap the
gears icon.

On an i0S device, you can tap “Find computer” to see a list of found Dragon Dictate
profiles and computers on your network. The easiest way to connect the app with
Dragon Dictate is to find the applicable profile and tap it; the app should “talk” to your
Mac and establish a link. If the list is too long to easily navigate, tap in the search field
and type in the name of the profile or Mac you’re looking for.

Should you need to manually establish the connection on either an iOS or Android de-
vice, tap “Manual Entry” and enter the necessary information. You can find the com-
puter’s IP address in the Network pane of System Preferences in OS X; ignore the port
number field, as it can’t be changed. You can find your Mac’s name in System Prefer-
ences’ Sharing pane; it's shown at the top of the window.

wil ATET = 4:49 PM

Back Settings

Profile Computer

Brad Cook Brad's iMac

Find Computer > Tap “Find Computer”

to locate your Mac or Loca‘ting a Dragon

Dragon Dictate profile. Dictate profile and the

Mac it is running on.
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s N i Bt Locating the name of the target computer
e I e % in the Sharing pane of System Preferences.

4:52 PM -

Manual Entry Cancel

Dragon Profile Name

Computer Name or IP Address

Computer Port
e ——

Use a barcode

Barcode feature only supported in
Dragon Dictate for Mac

The Manual Entry screen.

On either iOS or Android, you can also tap the “Use a barcode” button to connect with
your profile. (All iPhones have cameras, but not all iPod touch and iPad models do, nor
do all Android smartphones.) On your Mac, click the Dragon Dictate icon at the top of
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the screen; a pop-out window will display a barcode. Tap the “Use a barcode” button in
the Remote Microphone app and line up the barcode on your Mac’s screen with the box
shown on the display of your iOS device.

Computen 192.168.1.163
Pore 51001

Generating a barcode on your Mac’s dis-
play after clicking the Dragon Dictate icon
at the top of the screen.

Place a barcods inside tha

Lining up the barcode in the “Use a barcode”
feature.

After you establish a connection with your Dragon Dictate profile through the Remote
Microphone app through any setup method on iOS or Android, you will be prompted to
confirm that you want to allow it to occur.
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Do you want to allow a connection from
the Dragon Remote Microphone “Brad's
iPhone?"

| Don'tAllow | [ Allow
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Tap “Back” in the app to return to the main
screen. If the microphone icon shown in
the bottom half of the screen is red, tap it
to turn it green, which means it is active
and ready to accept input. To turn off the
microphone, tap the icon to turn it red.



Dragon Dictate

Should you exit the Remote Microphone
app, or if the connection with your Mac is
lost somehow, you will see the message to
the right. Tap the microphone icon in the
app to re-establish the connection.
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John Appleseed

Dragon Remote Microphone is
not connected. It must be
active to use this profile.

1

More Info...

You will see the message to the left if the Dragon
Remote Microphone app has not been launched
when you begin voice training.

As with any other microphone you set up with Dragon Dictate, you will need to complete
voice training by speaking into your device and reading the story presented on the
screen. If this is your first time doing so, refer to the “Voice Training” section earlier in this

chapter.
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The default setting for this option is to have the checkbox unchecked, which means you
need to add the fn (Function) to your Commmand-F-key presses in Dictate. If you check
that box, you don’t need to use the fn key with your Commmand-F-Key presses in Dictate,
but you do need to use the fn key when trying to access the features printed on the F
keys, such as the volume controls found on F10, F11, and F12 on most Mac keyboards.

Speech

The most important way to interact with Dragon Dictate is to talk to it! To talk
successfully to Dragon Dictate, you need to know about microphone state and the five
modes, so that’s the subject of the next section.
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Modes and the Microphone

The most important thing that you need to be in control of and aware of when using

Dragon Dictate is its state. At all times, the microphone is either on or off; and if the
microphone is on, Dragon Dictate is in one of five modes. These settings determine
whether and how Dragon Dictate will respond to your speech.

The Microphone

Microphone Off. Dragon Dictate is not listening at all. No sound can affect it. The
only change you can make is to turn the microphone on, and the only way to do that
is using the mouse or keyboard.

Microphone On. Dragon Dictate is listening, and how it responds to your speech
depends on what mode it is in.

The Five Modes

Dictation Mode. If Dragon Dictate can interpret your words as a command, it obeys
the command. Otherwise, Dragon Dictate interprets your words as dictation, and
types those words at the insertion point in the frontmost application.

Spelling Mode. If Dragon Dictate can interpret your words as a command, it
obeys the command. Otherwise, Dragon Dictate tries to interpret your words as a
limited set of letters and punctuation, and types those letters and punctuation at
the insertion point in the frontmost document. If Dragon Dictate can’t interpret your
words as a command or as letters and punctuation, nothing happens.

Command Mode. If Dragon Dictate can interpret your words as a command,

it obeys the command. Otherwise, nothing happens. You can give commands

in Dictation mode and Spelling mode as well, but Command mode can be an
advantage because Dragon Dictate doesn’t have to decide whether what you’re
saying is something to be typed or a command to be obeyed. You might switch to
Command mode when you are about to issue a command or a series of commands
and you want to make certain that nothing you say is interpreted as dictation and
typed accidentally into your document.
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Numbers Mode. If Dragon Dictate can interpret your words as a number, it displays
Arabic numerals. The software also recognizes commands and punctuation in this
mode.

Sleep Mode. If Dragon Dictate can interpret your words as one of the commands
Wake Up or Turn [the] Microphone On, it returns to one of the four preceding
modes. Otherwise, nothing happens.

Microphone Off and On
To pause your work completely, turn the microphone off entirely. The implications of
turning off the microphone are best understood by contrast with those of Sleep mode.

The advantage of turning the microphone off, as opposed to Sleep mode, is that no
voice input can be interpreted, even accidentally, as a command to turn the microphone
on. All voice input is ignored.

The disadvantage of turning the microphone off is that you can’t turn it on again using
your voice; you must use your hands. Sleep mode, on the other hand, lets you speak to
resume work.

To turn the microphone off:

— Say Microphone Off.

— Choose Speech > Microphone Off,

— Choose Microphone Off from the Dock menu.

— Click the microphone icon in the Status window so that it appears with a red “stop
sign”.

— Click the optional status menu item in the menu bar so that it appears with a red
“stop sign”.

— Press the keyboard shortcut for toggling the microphone.

— Tap the icon in the Dragon Remote Microphone app on your iOS or Android device.

To turn the microphone on, when the microphone is off:

— (Choose Speech > Microphone On.
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— Choose Microphone On from the Dock menu.

— Click the microphone icon in the Status window so that it appears with a green “go
button”.

— Click the optional status menu item in the menu bar so that it appears with a green
“go button”.

— Press the keyboard shortcut for toggling the microphone.

— Tap the icon in the Dragon Remote Microphone app on your iOS or Android device.
To learn whether the microphone is on or off:

— Look at the Status window. The microphone icon displays the microphone’s status.

— Look at the optional status menu item in the menu bar. It is a miniature version of the
Status window microphone icon, and displays the microphone’s status.

— Look at the Dock icon for Dragon Dictate. It appears (optionally) with a microphone
icon displaying the microphone’s status.

— Look in the Speech menu. If the microphone is on, the first menu item will read
Microphone Off; if the microphone is off, the first menu item will read Microphone
On.

— Look in the Dock menu. It contains menu items that work just like the Speech menu.

— Look at the icon in the Dragon Remote Microphone app on your iOS or Android
device. If it’s green, the microphone is on; if it’s red, the microphone is off.

Sleep Mode

To pause your work temporarily, switch to Sleep mode. In Sleep mode, Dragon
Dictate is listening, but it is in a special state where it responds only to a very limited set
of commands. They are:

— Wake Up
— Turn [the] Microphone On

Anything else you say will be ignored. This allows you to pause your work and have
Dragon Dictate ignore microphone input until you are ready to resume work.
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To enter Sleep mode:
— Say Sleep Mode, or Go to Sleep.

— Choose from the Status window mode menu. The mode menu appears when you
click the mode button in the Status window.

— Choose from the Speech menu.

— Choose from the Dock menu.

— Choose an Auto Sleep setting in the Recognition pane in the Preferences window.
To learn whether you are in Sleep mode:

— Look at the Status window. Its mode button shows the Sleep icon, and the
microphone appears with a blue “sleep balloon” with a crescent moon.

— Look at the Dock icon for Dragon Dictate. (Alternatively, use Command-Tab to
display the application switcher.) If you have chosen the option to badge the Dock
icon to display the microphone status, it appears with a crescent moon.

— Look at the optional status menu item. It appears with a crescent moon.

— Look in the Speech menu. The fifth mode menu item says “Wake Up”.

— Look in the Dock menu. It contains menu items that work just like the Speech menu.
When in Sleep mode, you can resume work by doing any of the following:

— Say Wake Up or Turn [the] Microphone On.

— Choose Speech > Microphone On or Speech > Wake Up.

— Choose Microphone On or Wake Up from the Dock menu.

— Click the microphone icon in the Status window so that it appears with a green “go
button.”

— Click the optional status menu item so it appears with a green “go button.”
— Press the keyboard shortcut for toggling the microphone.
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Learning and Switching Modes

The four non-sleep modes — Dictation mode, Spelling mode, Command mode, and
Numbers mode — form a group. You can switch from one to another, and learn which
mode Dragon Dictate is in, in a consistent manner.

To switch between modes:
— Say one of the following:
Dictation Mode
Spelling Mode
Command Mode
Numbers Mode

— Choose from the Status window mode menu. The mode menu appears when you
click the mode button in the Status window.

— Choose from the Speech menu.
— Choose from the Dock menu.

— Press the keyboard shortcut for cycling between modes, as found in the Shortcuts
preference pane. By default, Command-F10 is the shortcut; you can change it in the
preference pane.

To learn what mode you are in:

— Look at the Status window. The mode button’s icon represents the current mode;
and in the mode menu, which appears when you click the mode button, the current
mode is checked.

— Look in the Speech menu. The current mode is checked.
— Look in the Dock menu. It contains menu items that work just like the Speech menu.
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Dictation Mode

In Dictation mode, you can both dictate text to be typed and issue commands to be
obeyed. Dragon Dictate will type what you say, interpreting your words as dictation,
unless it recognizes what you say as a command.

In general, if you speak smoothly and continuously, Dragon Dictate will interpret your
words as dictation, even if they include words that might be a command. If you pause
before and after a phrase, on the other hand, Dragon Dictate will consider that phrase as
a possible command.

For example, Go To Sleep is a command (it switches to Sleep mode). So:
If you say Go. To sleep, Dragon Dictate types Go to sleep.

If you say Don’t go to sleep in the middle of the lecture, Dragon Dictate types
those words.

But if you say Don’t. Go to sleep, Dragon Dictate types Don’t and then switches
to Sleep mode.

So, to ensure that a phrase is recognized as a command, pause before and after the
command, but speak the command itself smoothly and continuously.

This might be a good time to review the “Tips on Speaking” section.

What You Can Say in Dictation Mode
Words and phrases to be typed. You can use the Vocabulary Editor window to
view and edit the list of words that Dragon Dictate knows about. You should try not
to make any extraneous noises, but Dragon Dictate will do its best to ignore the
well-known hesitation noises “ah”, “er”, “un”, and “um”. (In fact, you may have to use
Spelling mode to type such items.)

Instructions for spacing and capitalization. In general there should be no
need for these; Dragon Dictate will perform intelligent automatic spacing and
capitalization. But if you do need finer control over capitalization and spacing, you
have it. See “Capitalization, Spacing, and Numbers.” To insert a space, say
Space Bar.
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In many cases it will be simpler to let Dragon Dictate perform its automatic
capitalization, right or wrong, and then correct it after the fact with the
capitalization editing commands discussed below.

Punctuation. Unlike spacing and capitalization, you must explicitly dictate any
desired punctuation; Dragon Dictate doesn’t try to insert punctuation intelligently
based on grammar, tone of voice, or anything like that. Unlike Spelling mode,
Dictation mode does incorporate punctuation into its intelligent automatic spacing.
For names of punctuation marks, see “Punctuation.” You can also add punctuation
after dictating with the Surround the Word feature, which is also detailed in the
“Punctuation.” section.

Names of letters. Letter names may be used to type a word consisting of a letter,
or for dictating an acronym; but you should not use letter names in Dictation mode
as a substitute for Spelling mode. For example, to type An a-z of animals, say An
alpha hyphen zulu of animals. Even this approach is not entirely reliable, as Dragon
Dictate must allow for the possibility that alpha means alpha. Spelling mode gets
better results. See “Letter Names in Dictation Mode.”

Commands. All global, key, generated, and application-based commands are
available.

Recognition training commands. You can train the voice model and correct
recognition errors with these Dictation mode commands:

Train “Someword”
Train “Someword” Through “Otherword”
Train “Someword” to “Otherword”

The words (or the utterance containing them) are selected and the
Recognition window opens. See “Recognition Window.” When the Recognition
window is open, additional Recognition window commands are available.

Navigation and editing commands. These are Dictation mode commmands, listed
in the next section, designed for basic text navigation and editing, to correct your
own errors, to modify what you dictated, or to fix capitalization. If what you dictated
was not correctly recognized by Dragon Dictate, it is better to use the Recognition
window. See “Recognition Window.”
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Navigation and Editing Commands
You can move the insertion point with these commands:

Move Backward(s) NN Word(s), Move Forward(s) NN Word(s) (where “NN” is a
number up to 99)

You can place the insertion point with these commands:

Insert Before “Someword”

Insert Before “Someword” Through “Otherword”
Insert Before “Someword” to “Otherword”
Insert After “Someword”

Insert After “Someword” Through “Otherword”
Insert After “Someword” to “Otherword”

Insert Next “Someword” (where “Someword” is a word or series of words specified
by the previous select command)

Insert Previous “Someword” (where “Someword” is a word or series of words
specified by the previous select command)

You can control the selection with these commands:

Select “Someword”

Select “Someword” Through “Otherword”
Select “Someword” to “Otherword”
Select Next, Select Previous

Select the Next NN Words, Select the Previous NN Words (where “NN” is a
number up to 100)

Select Again “Someword” (where “Someword” is a word already selected)

You can select and delete a phrase with these commands:

Delete “Someword”

Delete “Someword” Through “Otherword”



Dragon Dictate Dictation Mode 43

— Delete “Someword” to “Otherword”

— Delete Next “Someword” (where “Someword” is a word already selected)

— Delete Previous “Someword” (where “Someword” is a word already selected)
You can select and change the case of a phrase with these commmands:

— Capitalize “Someword”

— Capitalize “Someword” Through “Otherword”

— Capitalize “Someword” to “Otherword”

— Capitalize Next “Someword” (where “Someword” is a word or series of words
specified by the previous select command)

— Capitalize Previous “Someword” (where “Someword” is a word or series of words
specified by the previous select command)

— Lowercase “Someword”
— Lowercase “Someword” Through “Otherword”
— Lowercase “Someword” to “Otherword”

— Lowercase Next “Someword” (where “Someword” is a word or series of words
specified by the previous select command)

— Lowercase Previous “Someword” (where “Someword” is a word or series of words
specified by the previous select command)

— Uppercase “Someword”
— Uppercase “Someword” Through “Otherword”
— Uppercase “Someword” to “Otherword”

— Uppercase Next “Someword” (where “Someword” is a word or series of words
specified by the previous select command)

— Uppercase Previous “Someword” (where “Someword” is a word or series of words
specified by the previous select command)

In the above commands where you specify the words to select, if those words appear
more than once in the document, Dragon Dictate selects the nearest instance. Position
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the insertion point near the desired words beforehand, to ensure that they will be
selected.

If you speak to delete or alter text and then change your mind (perhaps because Dragon
Dictate selected the wrong stretch of text), say Undo Dictation.

To remove the word last dictated or to the left of the cursor:
— Say Scratch Word.
To remove the phrase last dictated or to the left of the cursor:

— Say Scratch That (or Delete That). Dragon Dictate’s notion of a “phrase” depends
upon how it detects pauses in your speech.

If you “scratch” or “forget” and then change your mind (perhaps because Dragon Dictate
removed more than you wanted), say Undo Dictation.

Capitalization, Spacing, and Numbers

In Dictation mode, you can say commands that apply special rules for capitalization,
spacing and interpretation of numbers. This gives you finer control when Dictation
mode’s intelligent automatic behavior needs assistance. (For finest possible control,
though, use Spelling mode.)

Tip. Dragon Dictate comes with a large repertory of built-in words with correct
capitalization and spacing. So, before using these commands, try saying your
word (or look it up in the Vocabulary Editor window) to see what Dragon Dictate
does. For example, Dragon Dictate handles correctly such terms as “CD-ROM”
and “FreeBSD” without your having to worry about spacing, hyphenation, or
capitalization.

Title Case
To capitalize (title case) the next word:

— Say Cap. (To type the word “cap” you may need to switch to Spelling mode and
spell it out!)
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In the Status window, the first indicator light will glow yellow and will read “Abc”. When
you say the next word, it will be typed capitalized, and the indicator light will go out
automatically.

To capitalize (title case) a series of words, you may prefer to turn on title casing, say
the series of words, and turn off title casing. To do so:

— Say Caps On.

In the Status window, the first indicator light will glow green and will read “Abc”. Say the
series of words, which will be typed capitalized. Finally, say Caps Off. The indicator light
will go out.

Uppercase
To uppercase (all caps) the next word:

— Say All Caps.

In the Status window, the first indicator light will glow yellow and will read “ABC”. When
you say the next word, it will be typed uppercased, and the indicator light will go out
automatically.

To uppercase (all caps) a series of words, you may prefer to turn on uppercasing,
say the series of words, and turn off uppercasing. To do so:

— Say All Caps On.

In the Status window, the first indicator light will glow green and will read “ABC”. Say the
series of words, which will be typed uppercased. Finally, say All Caps Off. The indicator
light will go out.

Lowercase
To lowercase (no caps) the next word:

— Say No Caps.

In the Status window, the first indicator light will glow yellow and will read “abc”. When
you say the next word, it will be typed lowercased, and the indicator light will go out
automatically.
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To lowercase (no caps) a series of words, you may prefer to turn on lowercasing, say
the series of words, and turn off lowercasing. To do so:

— Say No Caps On.

In the Status window, the first indicator light will glow green and will read “abc”. Say the
series of words, which will be typed lowercased. Finally, say No Caps Off. The indicator
light will go out.

Spaces
To prevent automatic insertion of a space before the next word:

— Say No Space.

In the Status window, the second indicator light will glow yellow. When you say the
next word, it will be typed without a preceding space and the indicator light will go out
automatically.

To prevent automatic insertion of spaces while saying a series of words:
— Say No Space On.

In the Status window, the second indicator light will glow green. Say the series of words,
which will be typed without intervening spaces. Finally, say No Space Off. The indicator
light will go out.

To insert a space:
— Say Space Bar.

In general you should not need to suppress or control spacing merely because of
punctuation. For example, to hyphenate two words, say the first word, then Hyphen,
then the second word. There will be no space on either side of the hyphen, because
there is a built-in rule governing how automatic spacing works next to a hyphen.

Numbers
To force the next word to be interpreted as an Arabic digit (“1”, “2”, etc.):

— Say Numeral or switch to Numbers mode.
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In the Status window, the third indicator light will glow yellow and will read “123”. Say the
digit. The digit will be typed, and the indicator light will go out automatically.

Tip. To type 0, say Oh or Zero.

To force the next word to be interpreted as a Roman numeral (“I”, “II”, etc.):
— Say Roman Numeral.

In the Status window, the third indicator light will glow yellow and will read “XIV”. Say the
number. The number will be typed, and the indicator light will go out automatically. This
works even for large Roman numerals; for example, to type MCMXCVII, say Roman
Numeral One Thousand Nine Hundred and Ninety Seven (in one smooth utterance).

Dragon Dictate performs a lot of automatic intelligent formatting of numbers and dates.
Here are some details. You can also click on Auto Formatting under the Tools menu to
bring up options for formatting addresses, dates, times, numbers, and other utterances,
including common abbreviations and contractions.

When you say a number, Dragon Dictate will either type out the words or the number,
depending on the context in which the number was used. If you want to force the
program to type a number instead of typing the words for the number, say Numeral
before saying the number.

Here are some examples of Dragon Dictate’s automatic formatting and punctuation of
numeric expressions.

Numbers (numerals) may be spoken using digits or full number names. Insert
punctuation as needed.

What You Say Result
Numeral One 1
Numeral Five S
Seventeen 17
Forty Two 42
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What You Say Result
One Hundred Seventy Nine 179
Five Thousand Four Hundred and Twenty Three 5423
Numeral Five Comma No Space Four Hundred and Twenty 5,403
Three

Twelve Thousand Five Hundred and Thirty Seven 12,537
One Hundred and Forty Two Thousand and Fifteen 142,015
Thirty Five Point Two Three 35.23
Zero Point Zero Three 0.03
Forty-Three Point Twenty Eight Percent Sign 43.28%

Fractions may be spoken normally, or you can clarify by saying Slash or Over between

the numerator and the denominator.

What You Say Result
Numeral One Half 1/2
Numeral One Over Four; 1/4
Numeral One Quarter
Fifteen Sixteenths;

) ) 15/16
Fifteen Over Sixteen
Two and Three Fourths 2 3/4
Eleven Over Thirty Two 11/32
Eleven Thirty Seconds 11/32
Three and Seven Eights; 37/3
Numeral Three Seven Over Eight
Nine Slash Twelve

. 9/12
Nine Over Twelve
Numeral Five Space Bar Three Slash Fifty Six 5 3/56
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What You Say | Result
One Thirty Over Seventy | 130/70

Currency may be spoken normally; the number will be parsed and punctuated in
response to your use of the currency name.

What You Say Result
Ninety Nine Dollars and Fifty Five Cents $99.55
Forty Five Euros and Thirty Five Cents €45.35

Pound Sterling Sign One Hundred and Twenty Point Thirty
Five £120.35

Zip codes (US) may be spoken normally, digit by digit. For other postal code formats,
the best approach is probably to switch to Spelling mode.

What You Say | Result
Oh Two Four Six Zero 02460
Oh Two Four Six Zero Hyphen One Four Five Eight 02460-1458

US telephone numbers may be spoken normally, digit by digit, and punctuation will be
automatic; for other telephone number formats, say the punctuation (you might like to
experiment a bit).

What You Say Result
Three Five Zero Zero Nine Zero Three 350-0903
Six Oh Three Three Five Oh Oh Nine Oh Three 603-350-0903

One Eight Hundred Five Five Five One Two One Two | 1-800-555-1212

Open Parenthesis Six Zero Three Close Parenthesis
. . (603) 350-0903
Three Five Zero Zero Nine Zero Three

One Two One Two Five Five Five Twelve Twelve 1-212-555-1212
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What You Say Result

Open Parenthesis Oh One Six Two Eight Close
Parenthesis Eight Nine Four One Five Oh

(01628) 894150

Oh Two Seven Space Bar Six Two Nine Space Bar
Eight Nine Four Four

027 629 8944

Six One Hyphen Seven Hyphen Four Six Nine Five
61-7-4695-2055

Hyphen Two Zero Five Five

Dates and times may mostly be spoken normally. For times, the separator is a colon,
and this is entered automatically if you say AM or PM. Alternatively, say punctuation
explicitly.

What You Say Result
Twenty Two January Nineteen Ninety Nine 22 January 1999
April Nine Comma Two Thousand And One April 9, 2001
Fourteen Slash Oh Seven Slash Eighty Five 14/07/85
Three Slash Eleven Slash Zero Two 3/11/02
Three Slash Eleven Slash Two Thousand And Two 3/11/2002
April First April 1
March Twenty Second March 22
The Nineteen Eighties the 1980s
The Nineteen Eighty Apostophe Ess the 1980's
Seven Forty Five AM 7:45 AM
Three Colon Zero Zero 3:00

Letter Names in Dictation Mode
These are the names of letters that you can say in Dictation mode. (Consider using
Spelling mode instead, though, as it is more reliable — because Spelling mode knows
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that you are probably saying the name of a letter — and has a wider range of things you
can say.)

Letters

In Dictation mode, an individual letter (as opposed to known acronyms and
abbreviations) must be entered using the International Radio Alphabet. This is intended
primarily for when the letter name is itself a word.

An initial (a capital letter followed by a period) may be entered by saying Capital
or Uppercase followed by the name of the letter. For example, to dictate L. M.
Montgomery, you can say Capital L, Period, Uppercase M, Period, Montgomery.

An acronym (a series of capital letters without any spaces or periods in between) may
be entered using successive initials. Thus, for example, to dictate HAL 9000, you can
say Capital H, Capital A, Capital L, Nine Thousand.

Here are the International Radio Alphabet letter names:

What You Say
Alpha
Bravo
Charlie
Delta
Echo
Foxtrot
Golf
Hotel
India
Juliet
Kilo

Lima
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What You Say
Mike

November

Oscar
Papa
Quebec
Romeo
Sierra
Tango
Uniform
Victor
Whiskey
Xray
Yankee
Zulu

Diacritical Letters
A diacritical letter is a letter with a marking above or below it. (Spelling mode has a wider
repertory of diacritical letters and is recommended.)

The following phrases, all involving the International Radio Alphabet, enter diacritical
letters in Dictation mode:

What You Say Result
Alpha-Accent-Acute a
Alpha-Accent-Circumflex a
Alpha-Accent-Grave a
Alpha-Accent-Tilde; Alpha-Tilde a
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Result

Alpha-Accent-Umlaut
Alpha-Ring-Above
Charlie-Accent-Cedilla
Echo-Accent-Acute
Echo-Accent-Circumflex
Echo-Accent-Grave
Echo-Accent-Umlaut
India-Accent-Acute
India-Accent-Circumflex
India-Accent-Grave
India-Accent-Umlaut
November-Accent-Tilde
Oscar-Accent-Acute
Oscar-Accent-Circumflex
Oscar-Accent-Grave
Oscar-Accent-Tilde
Oscar-Accent-Umlaut
Oscar-Oblique-Stroke
Uniform-Accent-Acute
Uniform-Accent-Circumflex
Uniform-Accent-Grave
Uniform-Accent-Umlaut
Yankee-Accent-Acute

Yankee-Accent-Umlaut

Q:

O O Qo

e NG Y >

O ™

o O

S O O

< < o O
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You can say the following ligatures and non-Latin letters in Dictation mode:

What You Say

Result

A E Diphthong; A E Ligature
O E Diphthong; O E Ligature
Eszet; German Sharp S

S With Caron

Icelandic Eth

Icelandic Thorn

Dictionary Definition

T O O

You can ask Dragon Dictate to find the dictionary definition for any word by saying
Show Definition For "Someword." The Dictionary application built into OS X will launch
and display the definition of the requested word. This command is also available in
Command, Numbers, and Spelling modes.

Document Search

In addition, you can search any document for a word or phrase by saying Search
Document For "Someword" or Search Document For "Somephrase." If you want to
just bring up the Find dialog, you can simply say Search Document. You can insert the
word The or This between Search and Document. These commands are also available
in Command, Numbers, and Spelling modes.
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Spelling Mode

In Spelling mode, you can both spell and give commands. Dragon Dictate will type
individual letters, numbers, and punctuation that you say, unless it recognizes what
you say as a command. If Dragon Dictate doesn’t recognize what you say as a letter,
number, punctuation, or command, nothing happens.

Tip. Spelling mode enables a slightly different set of punctuation marks from
Dictation mode, which can be useful. Spelling mode is also good for typing
words that Dictation mode will misinterpret (such as “cap” or “uh”). It is helpful,
too, when you want to type a word that Dragon Dictate doesn’t know, or when
you want to enter an abbreviation or acronym or URL; but Dictation mode also
has ways of entering acronyms, and if you frequently use a word, you should
consider adding it to your profile’s vocabulary so that you can say it in Dictation
mode (see “Vocabulary Editor Window?”).

In Spelling mode, no automatic spaces are inserted. Contrast Dictation mode, where
automatic spaces are inserted before or after punctuation, as appropriate, and between
words. In Spelling mode, you must insert any desired spaces yourself.

To insert a space:

— Say Space Bar.

To remove the letter last typed or to the left of the cursor:

— Say Scratch Word (or Delete Word) or Scratch That (or Delete Word).
If you “scratch” and then change your mind, say Undo Dictation.

What You Can Say in Spelling Mode
The names of letters and numerals. (For letter names, see the next section,
“Letter Names in Spelling Mode.”) To capitalize a letter:

Say Cap followed by the name of the letter.

Punctuation. See “Punctuation.”
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Commands. All global, key, generated, and application-based commands are
available.

Navigation commands. You can control the insertion point with these Spelling
mode commands:

Move Backward(s) NN Letter(s) and Move Forward(s) NN Letter(s) (where
“NN” is a number up to 99)

Letter Names in Spelling Mode
These are the names of letters and numerals that you can say in Spelling mode.

Letters
Letters are lowercase by default. To capitalize a letter:

— Say Cap followed by the name of the letter.

To type a letter in Spelling mode:

— Say the name of the letter, e.g. A, B, etc.

— Or, say the International Radio Alphabet name of the letter (listed below).

When saying a plain letter name (as opposed to a diacritical letter, discussed below),
you may precede the name of the letter by Letter, e.g. Letter A, Letter B, Letter Alpha,
Letter Bravo. This can help disambiguate.

To repeat a letter (that is, to say a letter that appears twice in succession):

— You may say the letter name preceded by Double, e.g. Double A, Double Alpha. (In
case of “u”, say Double Letter U to disambiguate from “w”.)

Here are the International Radio Alphabet letter names:

What You Say
Alpha

Bravo
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What You Say

Charlie
Delta
Echo
Foxtrot
Golf
Hotel
India
Juliet
Kilo
Lima
Mike
November
Oscar
Papa
Quebec
Romeo
Sierra
Tango
Uniform
Victor
Whiskey
Xray
Yankee
Zulu

Spelling Mode

57
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Diacritical Letters
A diacritical letter is a letter with a marking above or below it. To type a diacritical letter
in Spelling mode:

— Say the name of the letter (normal or International Radio Alphabet) followed by the
name of the diacritical: A-Acute, Alpha-Acute.

— Optionally, in most cases you may say Accent between the name of the letter
and the diacritical (even when, strictly speaking, the diacritical is not an accent):
for example, A Accent-Acute, Alpha Accent-Acute. But you cannot do this for
“Dieresis” or “Ring”.
Not every diacritical is possible, even for every European language. You cannot, for
example, say the fourth letter of “Dvorak”. (The best way to type Dvorak’s name with
Dragon Dictate would be through a Text Macro command; see “Commands Window.”

Letter Diacriticals

A Acute, Circumflex, Grave, Tilde, Umlaut; Dieresis, Ring
C Cedilla

E Acute, Circumflex, Grave, Umlaut; Dieresis

Acute, Circumflex, Grave, Umlaut; Dieresis
Tilde
Acute, Circumflex, Grave, Tilde, Umlaut; Dieresis, Ring

Acute, Circumflex, Grave, Umlaut; Dieresis

< C O Z

Acute, Umlaut; Dieresis

Ligatures and Non-Latin Letters
You can say the following ligatures and non-Latin letters in Spelling mode:

What You Say | Result
A E Diphthong; A E Ligature; Ligature A E &
O Slash 9]
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What You Say Result
O E Diphthong; O E Ligature; Ligature O E e
Eszet; Sharp S; German Sharp; German Sharp 3

S

S Wedge S
Icelandic Eth o)
Icelandic Thorn b

Numerals
Numerals are individual digits. To type a digit in Spelling mode:

— Say the name of the digit, e.g. Zero, One, etc.

— Or, say Numeral followed by the name of the digit, e.g. Numeral Zero, Numeral
One, etc. (Do not say Number, which signifies the hash sign, “#”.)

Some numeric symbols are discussed as punctuation; see “Punctuation.”
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Punctuation

In Dictation mode, Spelling mode, and Numbers mode, you can say the names of
punctuation marks that Dragon Dictate should type. This chapter lists the names of
these symbols. These names are listed also in the Available Commands window (and, for
Dictation mode, in the Vocabulary Editor window).

There are some broad differences between saying a punctuation mark in Dictation mode
and saying it in Spelling or Numbers mode.

In Dictation mode, Dragon Dictate will attempt to insert intelligent automatic spacing.
(For example, it will probably put a space before “open quote” and after “close quote”.)
You may be able to prevent this by switching No Space on. But for finest control, use
Spelling mode.

In Spelling and Numbers modes, on the other hand, Dragon Dictate types the symbol
and that’s all. Also, Spelling mode has a larger repertory of punctuation marks (and of
other things you can say to type them, such as the names of letters and numbers).

After you’ve dictated text, you can go back and add punctuation around a word or
group of words with a feature called Surround the Word. You can specify a single word,
selected text, or a specific series of words, such as “and of things you can say to type
them.” For example, you can say Put Double Quotes Around the Words open quote, or
Put Parentheses Around the Words and Through them.

With Surround the Word, you can add quotes, double quotes, parentheses, brackets,
curly brackets, angle brackets, braces, Spanish exclamation marks, and Spanish
question marks.

Spaces
What You Say Result | Mode Comments
Space Bar All three Space character
New Line; Next Line All three Single return character
New Paragraph; Next Paragraph All three Double return character
Tab Key All three Tab character
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Stops
What You Say Result | Mode Comments
Period All three US dialect only
Full Stop; Dot All three UK dialect only
) Dictation, | Full stop or period followed by
Period Paragraph
Numbers | double return character
Exclamation Mark ! All three
Exclamation Point ! All three US dialect only
. . Dictation,
Inverted Exclamation Point i ,
Spelling
Inverted Exclamation Mark i Spelling
Question Mark ? All three
. Dictation,
Inverted Question Mark J, ,
Spelling
Pauses and Joins
What You Say Result Mode Comments
No space before or after in Dictation
Hyphen - All three
mode
Unicode 173, optional hyphen (not
Soft Hyphen Spelling every application interprets this cor-
rectly)
Comma , All three
Semicolon ; All three
Colon; Colon Mark (Dictation
All three

and Numbers modes only)
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What You Say Result Mode Comments
Center Dot; Middle Dot Dictation,
(Spelling mode only) Spelling
Dictation,
Dash -- , Two hyphens
Spelling
Em-Dash --- Dictation | Three hyphens
En-Dash -- Dictation | Two hyphens
Em-Dash — Spelling Unicode 8212, a true em-dash
En-Dash - Spelling Unicode 8211, a true en-dash
Apostrophe and Quotes

What You Say Result | Mode Comments

Dictation, | Straight apostrophe (no pre-
Apostrophe ' . .

Spelling ceding space)

Dictation, ,
Apostrophe-Ess 's , Straight apostrophe

Spelling
Open Single Quote; Begin Single , ,

‘ Spelling Left curly single quote

Quote
Close Single Quote; End Single , _ _ ,

Spelling Right curly single quote
Quote
Single Quote ' Spelling [ Straight single quote
Open Single Quote; Begin Single . et Straight single quote (preceding

ictation
Quote space)
Close Single Quote; End Single . Dictat Straight single quote (no pre-
ictation

Quote ceding space, like apostrophe)
Open Quote; Begin Quote “ Spelling | Left curly double quote
Close Quote; End Quote ” Spelling | Right curly double quote
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What You Say Result | Mode Comments

Quote; Quotation Marks Spelling | Straight double quote

Open Quote; Open Quotes; Begin
Quote; Begin Quotes; Open Double S

] Dictation |
Quote; Open Double Quotes; Begin ing space)
Double Quote; Begin Double Quotes

Straight double quote (preced-

Close Quote; Close Quotes; End

Quote; End Quotes; Close Double Straight double quote (no pre-

" Dictation
Quote; Close Double Quotes; End ceding space)
Double Quote; End Double Quotes
Open Euro Quote; Open Euro Dictation,
Quotes ) Spelling
Close Euro Quote; Close Euro Dictation,
Quotes ’ Spelling

Begin Angle Quote; Begin Angle
Quotes; Open Angle Quote; Open « Spelling
Angle Quotes

End Angle Quote; End Angle Quotes;

Close Angle Quote; Close Angle » Spelling
Quotes
Enclosures
What You Say Result Mode Comments
Open Paren; Left Paren; Open
) ) ( All three
Parenthesis; Left Parenthesis
Close Paren; Right Paren; Close
) All three

Parenthesis; Right parenthesis
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What You Say Result Mode Comments
Dictation, . . _
Open Bracket; Left Bracket ( _ Non-US dialects, like parenthesis
Spelling
. Dictation, . } .
Close Bracket; Right Bracket ) , Non-US dialects, like parenthesis
Spelling
Dictation,
Open Bracket; Left Bracket [ , US dialect, like square bracket
Spelling
. Dictation, , ,
Close Bracket; Right Bracket ] , US dialect, like square bracket
Spelling
Open Square Bracket; Left [ Dictation,
Square Bracket Spelling
Close Square Bracket; Right | Dictation,
Square Bracket Spelling
Open Brace; Left Brace; Open
Curly Brace; Left Curly Brace;
{ All three
Open Curly Bracket; Left Curly
Bracket
Close Brace; Right Brace; Close
Curly Brace; Right Curly Brace;
i 1 All three
Close Curly Bracket; Right Curly
Bracket
Open Angle Bracket; Left Angle o
< Dictation
Bracket
Close Angle Bracket; Right Angle o
> Dictation
Bracket
Open Angle Bracket; Left Angle , ,
< Spelling Unicode 8249, left angle quote

Bracket
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What You Say | Result | Mode | Comments
Close Angle Bracket; Right Angle , , _
Spelling Unicode 8250, right angle quote
Bracket
Money
What You Say Result Mode Comments
Cents Sign; Cent (Spelling mode only) ¢ All three
Dollar Sign; Dollar (Spelling mode only) $ All three
Sterling Sign; Sterling b Spelling
Pound Sterling Sign £ Dictation US dialect
. Dictation,
Pound Sign £ , Non-US dialects
Spelling
. . Dictation,
Yen Sign; Yen (Spelling mode only) ¥ ,
Spelling
. . Dictation,
Euro Sign; Euro (Spelling mode only) € ,
Spelling
. . . , Dictation,
Guilder Sign; Guilder (Spelling mode only) f ,
Spelling
Arithmetic
What You Say Result Mode Comments
. . Dictation,
Equals Sign; Equal (Spelling mode only) = ,
Spelling
Plus Sign; Plus (Spelling mode only) + All three
Minus Sign - All three
Plus or Minus Sign; Plus or Minus (Spelling Dictation,
+
mode only) Spelling
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What You Say Result Mode Comments
Plus Minus Sign; Plus Minus + Spelling
Multiplication Sign X Dictation
Multiply Sign; Multiply; Times sign; Times X Spelling
. . Dictation,
Division Sign + ,
Spelling
Divide Sign; Divide + Spelling
Less Than Sign; Less Than (Spelling mode Dictation,
<
only) Spelling
Greater Than Sign; Greater Than (Spelling Dictation,
>
mode only) Spelling
Percent Sign; Percent (Spelling mode only) % All three
. Dictation,
Point .
Spelling
Logical Not Sign; Logical Not (Spelling mode Dictation,
only) Spelling
Not Sign; Not = Spelling
) Dictation,
Superscript One 1 ,
Spelling
. Dictation,
Superscript Two 2 ,
Spelling
Squared; Square Z Spelling
. Dictation,
Superscript Three 3 .
Spelling
Cubed; Cube < Spelling
) Dictation,
One-Half Sign Y2 ,
Spelling
Half Sign; Half; One Half V2 Spelling
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What You Say Result Mode Comments
) Dictation,
One-Quarter Sign Va ,
Spelling
Quarter Sign; Quarter; One Quarter Va Spelling
. Dictation,
Three Quarters Sign 34 ,
Spelling
Three Quarters % Spelling
Octothorpe
What You Say Result | Mode | Comments
Pound Sign; Pound (Spelling mode Dictation, .
# , US dialect only
only) Spelling
Number Sign; Number (Spelling mode Dictation, ,
# , US dialect only
only) Spelling
Hash Sign; Hash (Spelling mode only); 4 Dictation, | In Dictation mode, works
Hash Mark (Spelling mode only) Spelling | only in non-US dialects
) ) Dictation, [In Dictation mode, works
Sharp Sign; Sharp (Spelling mode only) | # , , ,
Spelling | only in non-US dialects
Other Common Symbols
What You Say Result Mode | Comments
Ampersand; And-Sign; Ampersand Sign 2 Dictation,
(Spelling mode only) Spelling
Asterisk; Star (Spelling mode only) * All three
. . Dictation,
At Sign; At (Spelling mode only) @ ,
Spelling
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What You Say Result Mode | Comments
Dictation,
Backslash \ ,
Spelling
. . . Dictation,
Backquote; Backtick (Dictation mode only) ,
Spelling
. Dictation,
Caret; Hat (Spelling mode only) A ,
Spelling
Copyright Sign; Copyright (Spelling mode © Dictation,
only) Spelling
i ) Dictation,
Degree Sign; Degree (Spelling mode only) © ,
Spelling
. Dictation,
Ellipsis; Dot-Dot-Dot Three dots
Numbers
. , Unicode 8230, true
Ellipsis Spelling o
ellipsis mark
Forward Slash; Slash / All three
Large Center Dot o Dictation | Unicode 8226, bullet
Logical And && Dictation
Logical Or | Dictation
Optional Ess (s) Dictation
Paragraph Sign; Paragraph (Spelling mode q Dictation,
only) Spelling
Registered Sign; Registered (Spelling mode ® Dictation,
only) Spelling
Registered Trademark Sign; Registered ,
® Spelling
Trademark
. . . . Dictation,
Section Sign; Section (Spelling mode only) §

Spelling




Dragon Dictate

Punctuation

69

What You Say Result Mode | Comments
Dictation,

Tilde - Spelling

Trademark Sign; Trademark (Spelling mode ™ Dictation,

only) Spelling

Underscore _ All three

Vertical Bar; Bar (Spelling mode only) Dicta.tion,
Spelling

Rarities

What You Say Result | Mode Comments

Alternate Comma , Spelling Unicode 8218, lowered single quote

Angstrom a Spelling

Broken Vertical Bar : Spelling

Dagger T Spelling

Single Dagger Sign T Dictation

Double Comma ” Dictaltion, Unicode 8222, lowered double quote

Spelling

Double Dagger I Spelling

Double Dagger Sign ¥ Dictation

Feminine Ordinal @ Spelling

Feminine Ordinal Sign a Dictation

Macron Sign; Macron B Dictation,

(Spelling mode only) Spelling

Masculine Ordinal © Spelling

Greek Mu ! Dictation,

Spelling




Dragon Dictate

Punctuation

70

What You Say Result | Mode Comments
Micro u Spelling
Micron; Micro Sign u Dictation
Per Thousand; Permille | %o Spelling
Permille Sign %0 Dictation
Smilies
What You Say Result Mode Comments
Smiley Face; o
Smiley :-) Dictation
Frowny Face; o
Frowny —( Dictation
Winky Face; Winky | ;-) Dictation
Surround the Word
What You Say Result Mode Comments
Put Quotes Around
the Word/Selection/ | “text” Dictation
Words X Through Y
Put Double Quotes
Around the Word/ “toxt” Sttt

Selection/Words X
Through Y
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What You Say

Result

Mode

Comments

Put Quotation
Marks Around the
Word/Selection/
Words X Through Y

Put Single Quotes
Around the Word/
Selection/Words X
Through Y

Put Straight Quotes
Around the Word/
Selection/Words X
Through Y

Put Single Straight
Quotes Around the
Word/Selection/
Words X Through Y

Put Parentheses
Around the Word/
Selection/Words X
Through Y

Put Curly Brackets
Around the Word/
Selection/Words X
Through Y

Put Braces Around
the Word/Selection/
Words X Through Y

“.text”

‘text’

"text"

'text’

(text)

{text}

{text}

Dictation

Dictation

Dictation

Dictation

Dictation

Dictation

Dictation

Punctuation
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What You Say

Result

Mode

Comments

Put Curly Braces
Around the Word/
Selection/Words X
Through Y

Put Square
Brackets Around
the Word/Selection/
Words X Through Y

Put Brackets
Around the Word/
Selection/Words X
Through Y

Put Angle Brackets
Around the Word/
Selection/Words X
Through Y

Put Spanish
Exclamation Marks
Around the Word/
Selection/Words X
Through Y

Put Spanish
Question Marks
Around the Word/
Selection/Words X
Through Y

{text}

[text]

[text]

<text>

itext!

o text?

Dictation

Dictation

Dictation

Dictation

Dictation

Dictation

Punctuation
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Commands
To learn what commands are available at any moment, use the Available Commands
window. See “Available Commands Window.”

Commands may be edited — modified, created, activated and deactivated, and deleted
— in the Commands window. See “Commands Window.”

Commands come in six categories:

Mode-based commands. Individual modes may have commands built into them.
For example, Capitalize the Word “Valley” is something you can say in Dictation
mode only. For more information, see the discussion of each mode.

Window-based commands. Some commands become available only when a
certain window is open. For example, Pick 2, to insert the second alternative from
the Recognition window into your document, is available only when the Recognition
window is open. See “Recognition Window.”

Global commands. Some commands are global, meaning that they are always
available (except in Sleep mode). See “Global Commands.”

Key commands. Key commands are global commands that let you say the names
of keyboard keys or modifier-key combinations for Dragon Dictate to type. See “Key
Commands.”

Generated commands. Dragon Dictate, as it starts up, will optionally generate
additional global commands that let you launch applications or create an email
message addressed to someone in your Contacts. See “Generated Commands.”

Application-based commands. Some commands become available only when
a certain application is frontmost. For example, you can say Send Message when
Messages or Mail is frontmost. Dragon Dictate comes with command sets for
Finder, TextEdit, Safari, Mail, Messages, Calendar, Notes, Reminders, and

Notifications. See “Application-Based Commands.”
If the command you want to say is not a mode-based command, then the way to be

certain that Dragon Dictate understands your words as a command to be obeyed, and
not dictation to be typed, is to switch to Command mode.
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These commands are available in every mode (except Sleep mode). Some of them
control Dragon Dictate; others control the computer as a whole, or whatever application
is frontmost. Dragon Dictate has a lot of flexibility when recognizing commands; words
that are in parentheses are optional.

Dragon Dictate Modes and Microphone

What You Say

Comment

Dictation Mode

Switch To Dictation Mode
Spelling Mode

Switch To Spelling Mode
Command Mode

Switch To Command Mode
Numbers Mode

Go To Sleep

Sleep Mode

Switch To Sleep Mode
Wake Up

Microphone Off

Sets Dragon Dictate to Dictation Mode.

Sets Dragon Dictatee to Dictation Mode.

Sets Dragon Dictate to Spelling Mode.

Sets Dragon Dictate to Spelling Mode.

Sets Dragon Dictate to Command Mode.

Sets Dragon Dictate to Command Mode.

Sets Dragon Dictate to Numbers Mode.

Sets Dragon Dictate’s microphone to Sleep Mode.
Sets Dictate’s microphone to Sleep Mode.

Sets Dragon Dictate’s microphone to Sleep Mode.

Restores Dragon Dictate to its previous mode.
Turns the microphone off. No further voice input is possible until
microphone is turned on by keyboard or menu item.

Dragon Dictate Dictation and Training

What You Say

Comment

Scratch That

Scratch Word

Deletes the utterance or portion of utterance immediately to the left of the
cursor or selection. An utterance is a phrase that you spoke.
Deletes the word just prior to the cursor or left edge of the selection.
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Comment

Undo Dictation

Redo Dictation
Play the Selection

Train Vocabulary from
Selection

Cache Document

Cache Selection

Purge Cache

Reverses the effect of the last dictation or delete dictation command
(Delete, Scratch, Forget). Use of this command removes the correction in-
formation from the text involved, so if you “Redo Dictation” you will not be
able to correct the replaced text. If your last dictation replaced text, that
text is restored, but no correction information is restored.

Redo Dictation reverses the effect of the Undo Dictation command.

Play the Selection

Copies the current selection and opens the Vocabulary Training window
and uses the copied text as input.

Tells Dragon Dictate to record the contents of the current window as “user
typed text”. All prior knowledge of the window contents is replaced (dicta-
tion information, spelled letters). This is useful when opening and working

with an existing document.
Tells Dragon Dictate to record the selection of the current window as “user

typed text”. All prior knowledge of the window contents is replaced (dicta-
tion information, spelled letters). This is useful when opening and working

with an existing document.
Removes all cached information regarding the active window’s contents.

This does not delete the text appearing in the active window, but Dragon
Dictate now assumes that the window is blank, except for Note Pad win-
dows. When “Purge Cache” is applied to a Note Pad window, a “Cache
Document” command is automatically generated as well because Dragon
Dictate always knows about the contents of its own windows. This is use-
ful when opening and working with an existing document.
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Comment

Show (This or The) Status
Window

Hide or Close Status Window

Show Available Commands
Window

Hide or Close Available
Commands Window

Show (This or The) Recognition
Window

Bring Dictate to the Front
(Show or Open) Express Editor

(Close or Hide) Express Editor

Transfer (the Text)

Navigation

What You Say

Shows the Status window for Dragon Dictate.
Hides the Status window for Dragon Dictate.

Shows the Available Commands window for Dragon Dictate.

Hides the Available Commands window for Dragon Dictate.

Displays the Recognition window containing alternatives for
the current selection or the utterance to the left of the cur-
Sor.

Makes Dictate the frontmost application.

Opens and activates the Express Editor
Closes the Express Editor, preserving its contents in the

process
Transfers text from the Express Editor to the frontmost ap-

plication, as indicated in the Express Editor’s title bar

Comment

Go To Beginning

Move To Beginning Of
Document

Go To End
Move To End Of Document
Go Back

Moves the cursor to the first position in the document.
Positions to the beginning of the document.

Moves the cursor to the last position in the document.
Positions to the end of the document.

Returns the cursor to the last position it occupied.
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Comment

Next Field

Previous Field

Copy and Paste

Moves the cursor to the next field by sending a tab and

purges the cache.
Moves the cursor to the previous field by sending a shift tab

and purges the cache.

Outside of a Note Pad window (that is, in an application other than Dragon Dictate),
these commands are the same as if you had used your hands. If you have a problem
with Dictation mode navigation commands after speaking one of these commands, issue
one of the cache commands documented on previous pages.

What You Say

Comment

Copy Selection

Cut Selection

Paste from
Clipboard

Select All

No Leading Space

Mimics the Command-C keypress, which copies whatever is selected to the

clipboard in most applications.
Mimics the Command-X keypress, which cuts whatever is selected to the

clipboard in most applications.
Pastes the contents of the clipboard at the insertion point.

Mimics a Command-A keypress. Specifically, this command is intended to
select all text within a text document or object, or all objects in the frontmost

document.
All spaces are removed before the word immediately after the cursor or left

edge of the selection. Does not apply to words that have not been dictated
yet. Use “No Space” for those.

Button and Keyboard Pressing

What You Say

Comment

Press Cancel

Click Cancel

Press the Cancel Button.



Dragon Dictate Commands

What You Say Comment

Press Don’t Save

Click Don't Save
Press OK

Press the Don’t Save Button.

Press Enter
Press Return
Click OK
Click Enter
Click Return

Press Continue

Click Continue

Cancel This Operation | Cancels the current operation.

Press the OK Button.

Press the Continue button.

) Mimics a Command-S keypress. This command will save the frontmost
Save This Document

document in most applications.

Menus
What You Say Comment
File New
Selects the New menu item on the File Menu.
New File
File Open
Selects the Open menu item on the File Menu.
Open File
File Close
Selects the Close menu item on the File Menu.
Close File
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Comment

Undo Last Action

Redo Last Action
About this Application
Access Find Window

Access Force Quit
Window

Show (This or The) Date
and Time

Undoes the last action. This is the same as pressing
Command-Z (undo). You can also say Scratch That or
Undo Dictation.

Redo last action reverses the effect of the “Undo Last
Action” command.

Displays information about the frontmost application.

Opens the Find window. This window will look different
depending on what version of OS X you are using.

Opens the Force Quit window.

Displays a dialog box with the date and time stamp. Also
allows you to put the date stamp on the clipboard.

Spaces, Exposé, and Screen Capture

What You Say

Comment

Expose All Windows

Expose Application
Windows

Expose Desktop
Capture Screen

Capture Selection

Uses Mission Control to expose all windows.

Uses Mission Control to expose windows for the active applica-
tion.

Uses Mission Control to expose the Desktop.

Takes a snapshot of the entire screen and saves it on the desk-
top.

Allows you to capture a snapshot of a selection.

Application and Window Navigation

What You Say

Comment

Hide This or The Application [ Hides the frontmost application.
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Comment

Hide Other Applications
Hide All Applications

Show All Applications
Switch To Next Application

Switch To Previous
Application

Next Application Window

Previous Application Window

Quit This Application

Activate [Name of
Application]

Quit [Name of Application]

Swipe Left

Swipe Right

(Enter or Switch) to Full
Screen

Exit Full Screen

Hides all applications except the frontmost application.
Hides all applications except the Dragon Dictate; works only
when Dragon Dictate is frontmost.

Shows all applications.

Switches to the next application that is running.
Switches to the previous application that is running.

Activates the next window in the active application.

Activates the previous window in the active application.
Quits the frontmost application, except if it is Dragon Dictate.

Dragon Dictate must be quit using menu or keyboard.
Brings the named application to the front. “Activate” commands

are automatically generated for all running applications and ap-
pear in the Applications subgroup of the Available Commands

window.
Quits the named application. “Quit” commands are automati-

cally generated for all running applications except the Finder and
Dragon Dictate, and appear in the Applications subgroup in the
Available Commands window.

Simulates a left swipe gesture

Simulates a right swipe gesture
Enters full-screen mode, if possible

Exits full-screen mode, if possible
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Correction Process
When you need to correct text with Dragon Dictate, the software offers you several
options for making changes. Let’s use the following example:

brown fox jumped over the lazy dog.

| 8006 Untitled 7
The quick

You dictate the text The quick brown fox
jumped over the lazy dog PERIOD

<] Recognition

Spelling Alternatives
Say "Choose” or "Edit" and a number

dog
Dawg
E::g Note that you click the ear button in the
Bee upper right corner to have Dragon Dictate
e Eam play back how you said the word you want
to correct.

"Spell that” if you don't see your choice

"Say That" to edit the first option
"Play that back"

"All caps that"

"Unselect that"

Say Correct dog. The word “dog” is highlighted, and the Recognition window with spell-
ing alternatives appears:
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] Recognition

Spelling Alternatives
Say "Choose" or "Edit" and a number

Dawg

Dogg
Dog .
GG You can say cow to enter it next to

number one, or type the word.

¥ Related Commands

"Spell that" if you don't see your choice
"Say That" to edit the first option

"Play that back"

"All caps that"

"Unselect that"

You can say Edit, with the corresponding number, to change the text to that selection.
When the Recognition window with your spelling alternatives first appears, the list under
Related Commands is not visible; click the arrow to reveal them.

The Related Commands list gives you suggestions for commands you can say if, for
example, the word you want to change “dog” to does not appear. Let’s say you want to
change it to “cow.” Speak Edit number one and the first option becomes editable. Say
cow and it replaces “dog” next to option one.
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Then say Choose one and “cow” will replace “dog” in your text:

800 Untitled
The quick brown fox jumped over the lazy cow]

Note that depending on the type of change you make, Dragon Dictate may display the
Smart Format Rules window afterward. A Smart Format Rule allows you to tell the soft-
ware how to always handle certain corrections, such as specific ways to write numbers,

titles, and so forth.
See Smart Formatting Rules in the Auto Formatting section to learn more.
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Auto Formatting

You can tell Dragon Dictate to automatically format addresses, dates and times,
numbers, common abbreviations and contractions, and the number of spaces after a
period. Click on Auto Formatting... in the Tools menu to bring up the Auto Formatting
window, which offers several options. The windows to the right show you what will be
displayed when a formatting option is checkmarked.

LB 0L Auto Farmatting

Addressos
i.ﬁ‘mlﬂl addresies
UK and Canadian postiodes
[U! Web and email addresses namefnuance.com
Igﬁmnr numbers BOD=555=1212
Abbeeviated tithes Mister, D,

Diate & Time
Igﬂuﬂ.. Dates As Spoken
o Tirnes 3:20 AM

Humbers

[¥ Use numerals starting with: | 0 : 0,1.2
ﬂﬂlrl'd“\l’{ulmll “=lllian” numbers 5 millian

[ Prices and currencies $1.30

B0 currency codes

Iﬁun.ﬂ of measure 2 km
| Social Security numbaers

[ Al othar numbers Firsz

Miscellaneous
Cammon ahbrevidlions
Expand contracticns haven™
M'rrl“rt two spaces after period word. Word
M Allow pauses in formasted phrases

7 Anmly
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In addition to the Auto Formatting options explained below, Dragon Dictate has a Smart

Formatting feature that enables you to specify exactly how you want the software to

handle certain text.
For example:

/800 Untitled

Mr. Smith

The Recognition window appears.

] Recognition

Spelling Alternatives
Say "Choose” or "Edit" and a number

Mr.
Mister
Mr
mister
MR.

¥ Related Commands

"Spell that” if you don't see your choice
"Say That" to edit the first option

"Play that back"

"All caps that"

"Unselect that"

Say Choose two. “Mr.” turns into “Mister” in your document, and the Smart Formatting

Rules window automatically appears:

You dictate the words
Mister Smith. You say
Correct Mr. and Mr. becomes
highlighted.

See the Correction Process
section to learn more about
how this window works.
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() Smart Format Rules

Say "Choose” and a number to set the rule.

1 Never abbreviate titles

2 Always use the alternate written for...

¥ More Info

Dragon noticed that you made a correction that
changes a Smart Formatting Rule for auto-

formatting text or word properties. If you say Choose and a number,
You can say "choose” plus the number Dragon will remember that

associated with an item in this box. Doing so . . .
will enable or disable the corresponding options formattlng choice in the future.

on the Auto-Formatting dialog box.

If you don't want to change the rule now, you
can ignore this box. When you resume
dictating, the box will close.

For details, say "Search Dragon Help for Smart
Format Rules.”

If you don’t want to use any of the smart formatting rule choices, you can click the X'in
the top left corner of the window, or simply resume dictating text, and the window will
disappear. Smart Formatting rules are turned on by default when you install Dragon Dic-
tate, but you can turn them off in the Recognition pane in the Preferences window,
which is accessible in the Dictate menu.

Addresses

Street Addresses

Dragon Dictate will automatically format postal addresses when this option is enabled.
For example, speaking 49 Orchard Lane, Boston, Massachusetts Oh Two Four Four Six
will produce 49 Orchard Lane, Boston, MA 02446. A separate option enables automatic
formatting of UK and Canadian postcodes, such as W2 4RJ, which would be spoken as
W Two Four R J.
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Tip. Some addresses, particularly those with a lot of numbers, can be difficult
to interpret. For example, if you say Two Hundred Forty Fifth Street, Dragon
Dictate may produce 245th Street, 200 45th Street, or 240 5th Street. The
simple addition of the word And can help produce the right result, so if you say
Two Hundred And Forty Fifth Street, 200 45th Street will be eliminated from the
possible choices.

Web and Email Addresses

If you say Name At Nuance Dot Com, Dragon Dictate will produce name@nuance.com.
Web site addresses, such as W W W Dot Nuance Dot Com, will also appear properly; in
this case, you will see www.nuance.com on the screen.

Phone Numbers

Dragon Dictate will display properly-formatted phone numbers when you say seven- or
ten-digit sequences. For example, Eight Hundred Five Five Five One Two One Two pro-
duces 800-555-1212. (You can also say Eight Zero Zero at the beginning of the se-
quence.)
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Tip. Vanity phone numbers, such as 1-800-EXAMPLE, are not supported, nor is
automatic formatting of U.S. phone numbers for UK English users.

Abbreviated Titles

If you say Mister Smith or Missus Smith or Doctor Smith, for example, Dragon Dictate will
produce Mr. Smith or Mrs. Smith or Dr. Smith.

Date & Time

The default in the dropdown menu is Date As Spoken, which produces dates exactly
as you speak them. For example, January 5th 2011 produces January 5, 2011. (You can
also say January 5 2011 to display the same result.) From the dropdown, you can select
a variety of other ways to display dates, depending on your preference. For example,
setting it to 1/5/2011 produces exactly that when you say January 5th 2011.

Tip. Omitting the year when you speak produces the month and day as a word
and a number, despite the formatting you’ve selected. For example, January 5
(or 5th) produces January 5.

When you say a time, it's properly formatted if that option is enabled. For example, Three
Twenty A M produces 3:20 AM. Without auto-formatting, it would read 320 a.m.
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Numbers

The Use Numerals Starting With option has a dropdown that spells out all numbers
equal to or less than the selected value, which is set at 10 as the default. The other
choices in the dropdown menu are 2, 10, and 100. For example, if you choose 10, say-
ing Three will produce three and saying Eleven will produce 11.

If you choose to Partially Format “-illion” Numbers, Dragon Dictate will display a
combination of numbers and text when you speak numbers higher than 999,999. For
example, saying Eight Million will produce 8 million instead of 8,000,000.

Prices and Currencies

This option properly displays money amounts. For example, One Dollar and Thirty Cents
will produce $1.30. If the ISO Currency Codes option is checked, Dragon Dictate will
display the proper three-letter code, rather than the currency symbol.

ISO Code Displayed Currency Spoken Currency Symbol
UusbD US Dollar $

CAD Canadian Dollar c$

EUR Euro €

JPY Yen %

GBP British Pound 0

CHF Swiss Franc Fr

Units of Measure

This option properly displays symbols and abbreviations for measurements. For example,
Six Feet Three Inches will produce 6’3", and Two Kilometers will produce 2 km. If you
want to specify a format for a measurement, open the Vocabulary Editor in the Tools
menu, click the word or abbreviation in the list and click the Information button at the
bottom of the window.
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Social Security Numbers

Dragon Dictate will display properly-formatted U.S. Social Security numbers when you
say nine-digit sequences. For example, speaking One Two Three Four Five Six Seven
Eight Nine produces 123-45-6789.

All Other Numbers

Numbers not covered elsewhere in this section are properly formatted when this option
is checkmarked. They include negative numbers, numbers with punctuation, fractions,

decimals, and Roman numerals. For example, speaking Roman Numeral Twenty-Four

produces XXIV and Two Point Zero Three produces 2.03.
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Miscellaneous
These final four options cover other common auto-formatting needs:

Common Abbreviations: Automatically converts words to their common abbreviations.
For example, Versus will produce vs.

Expand Contractions: If this box is checked, spoken contractions will be expanded.
For example, Haven't will produce have not. If a contraction could be ambiguous, how-
ever, it is always expanded, regardless of how you set this option. For example, It Is
Always and It Has Always have two different meanings, so Dragn Dictate won’t display
it’s always.

Insert Two Spaces After Period: Automatically inserts two spaces after each period.
While this was a common convention when most writing was done with typewriters,
today the standard is to use one space after a period, thanks to the proportional fonts
found in word processing software.

Allow Pauses in Formatted Phrases: If you pause while speaking a number, Dragon
Dictate’s number and phrase formatting will still work together.
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Express Editor Window

If you open a program that does not offer full text control (the ability to dictate text and
then manipulate it through voice commands, such as Select dog or Delete the section),
you can summon the Express Editor Window, which floats above the application. Say
Open or Show Express Editor to open the Express Editor. You can dictate into the
Express Editor and then click the Transfer button or say Transfer to move the text to the
application.

While TextEdit does offer full text control with Dragon Dictate, we’ll use it here to explain
how to use the Express Editor window with an application. If you want to use Express
Editor with an application, make sure the cursor is active in a field in that application,
such as a new TextEdit document. Then open the Express Editor window, which looks
like this:

Help Transfer -~

Note that the Express Editor’s title bar which application it relates to, so you know where
the dictated text will appear when you transfer it. If you switch to another application
while the Express Editor window is open, its name will appear in the title bar.

The Transfer Window after text has been entered:
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[ TextEdit

The quick brown fox jumped over the lazy dog. Why did the quick brown fox jumped over the
lazy dog?|

Help Transfer ~*

To transfer text to the frontmost application, click the Transfer button or speak the
command Transfer.

The Express Editor window automatically closes after you transfer text from it to the
frontmost application. You can also close the Express Editor by saying Close or Hide
Express Editor, or by clicking the X in the upper left corner. Any text still in the Express
Editor window when you close it will be preserved and will reappear the next time you
open it.

If the Express Editor window is open when you quit Dragon Dictate, it will reopen the
next time you launch the software.

93
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Proofreading

Dragon Dictate can read text back to you, whether you want to hear a specific selection
or an entire document. Hearing your text can help you catch mistakes, especially ones
that a spelling or grammar checker might miss, and it lets you listen to the flow of your
writing, so you can decide where to make changes during editing.

Say Read Document or Read Selection to have Dragon Dictate read the entire document
or the text you’ve selected by highlighting it with your mouse. You can also say Read

the Words [text] to [text] to tell Dragon Dictate to read all the text from one word through
another. You can substitute Proofread for Read and Through for To. For example, if a
sentence says The quick brown fox jumped over the lazy dog, you can say Read the
\Words brown to over. You can also instruct Dragon Dictate to read a selection that spans
multiple sentences.

Say Wake Up, pause for the mic to respond, and then say Stop Reading to halt the
speech synthesis.

Dragon Dictate uses the text-to-speech capabilities that are built into OS X, so if you
want to change the voice you hear, click on Speech in System Preferences and select
Text to Speech. You'll see a few male and female voices to choose from, but if you select
Show More Voices, the list will expand. You will probably want to stick with one of the
standard voices, but if you want to have some fun, OS X offers several novelty voices
too, such as Bad News and Zarvox. Click the Play button to hear a sample.

You can also change your preferred voice’s speaking rate in the Speech preference pane.
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Numbers Mode

In Numbers mode, Dragon Dictate will type Arabic numerals when you say them, such
as 80 when you say Eighty. It will also recognize certain punctuation marks, some com-
mands, and a few words. You can say Numbers Mode to switch to it, or you can choose
it under the Speech menu or in the Dock menu.

Tip. Numbers mode, when used in conjunction with certain Auto Formatting
options, is most useful when you need to dictate strings of numbers, such as
phone numbers for a contact list or prices for a product list.

As in Spelling mode, no automatic spaces are inserted in Numbers mode. You must
insert spaces yourself. If you don’t, Dragon Dictate may combine separate smaller
numbers into a single larger one.

To insert a space:

— Say Space Bar.

To remove the number last typed or to the left of the cursor:

— Say Scratch Number (or Delete Number or Scratch That).

If you Scratch and then change your mind, say Undo Dictation.

See “Punctuation.” for the punctuation marks that are available in Numbers mode.
Here are the words Numbers mode recognizes:

What You Say
And

Billion
Cent/Cents

Dollar/Dollars

Euro/Euros
Hundred
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What You Say

Million
Minus
Pence
Thousand

Trillion

Numbers Mode

96
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Mouse Control

Dragon Dictate allows you to move your cursor in Command mode. You can simply
MOove your cursor by issuing commands, or you can say MouseGrid or Open
MouseGrid to summon a transparent three-by-three full-screen grid with the numbers
one through nine. With the mouse grid on the screen, speak the number you want to
focus on. A new three-by-three grid will appear in that spot. You can repeat the process,
but when the desired area becomes too small to display a grid, you will see a magnifica-
tion window.

Say Small MouseGrid or Open Small MouseGrid to start the process with a small
mouse grid centered around the pointer’s current location. You can speak Small
MouseGrid to summon the small grid at the mouse pointer’s current location; the mouse
will be located in grid panel 5. Say Cancel to remove the grid.
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Correction Process

[When you need t0 correct test Foeral
pptions for making changes. Let’s use the following example:

E Emmal Mouse Control
1 Mouse Control

| [Dragon Dictate Medical allows you to move your cursor in Command mode. You
an simply move your cursor by issuing commangds, or you can say MouseGrid or|
E Open MouscGrid to summon a transparent thrce-by-three full-screen grid with

1 the numbers one through nine. With the mouse grid on the screen, speak the num.
ber you want to focus on. A new three-by-three grid will appear in that spot. You
an repeat the process, but when the desired area becomes too small to display a
grid, you will see a magnification window.

Bay Small Mousc@lid or Open Small MouseGrid to start the process witl
gmall mouse g ntered around the pointer’s curent location. You can spea
icl to summon the small grid at the mouse pointer’s current
s8%vill be located in grid panel 5. Say Cancel to remove the grid®
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When the MouseGrid becomes too And the magnification window
small to display numbers, you’ll see will appear to show what you’re
this. focused on.

To move your mouse pointer without using the mouse grid, say Move Mouse and add
the desired direction: Up, Down, Left, or Right. You can also add a combination of
directions, such as Left and Up, and you can append 1-100 units of measurement

-- Points, Centimeters, or Inches -- after the direction. (For example: Move Mouse
Right and Down Two Inches.) Say Faster or Slower to change the mouse speed; you can
repeat the command to make it move even faster or slower. Mouse movement has three
levels of speed. Say Stop to end mouse movement.

When you have your mouse pointer in the desired spot, you can say Mouse Click,
Mouse Double Click, or Mouse Triple Click. Before those words, you can also say any
combination of Command, Option, Shift, Control, or Caps Lock, enabling you to use
those keys in conjunction with a single, double, or triple mouse click. Say Hold Mouse
when you want to click and hold the mouse pointer; a flashing circle appears around it to
indicate that status. Say Release Mouse to disengage the mouse.

By issuing voice commands to click and hold the mouse, and then move it, you can
highlight sections of text, drag and drop files and folders, and more.

You can change the mouse grid’s appearance in the Appearance Preferences pane
under the Dictate menu. You can modify its level of transparency and change its color,
along with the color displayed when you say Hold Mouse. In addition, you can decide
whether Dragon Dictate automatically switches to Command mode when you invoke
the MouseGrid, and you can enable or disable zoom, which turns on and off the



Dragon Dictate Mouse Control

magnification window that appears when the mouse grid becomes too small to display
numbers.

Mouse Commands
[Open] MouseGrid
[Open] Small MouseGrid

Cancel

[Modifer(s)] Press Mouse or Hold Mouse

[Modifier(s)] Mouse Click or [Modifier(s)] Mouse Double
Click or [Modifier(s)] Mouse Triple Click

Release Mouse

Move Mouse (Direction) [1-100 Points/Centimeters/
Inches]

Stop
Slower

Faster
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Transcription

You can dictate text into an iPhone (3G or later), iPod touch (4th generation or later),
iPad, Android or other smartphone -- or any other digital recording device, or into a
computer microphone (if you find yourself at a computer other than yours, for example)
-- and ask Dragon Dictate to produce a transcript of what you said. The software recog-
nizes these file formats: mov, wav, aif, aiff, m4v, and m4a.

Since you can have multiple transcription audio sources, Dragon uses the one you’ve
selected with your currently-active speech profile to analyze the audio, so the file needs
to contain your voice and should have preferably been dictated under circumstances
similar to the ones in which you use Dragon on your Mac.

So, for example, if you normally use Dragon Dictate in a quiet environment but you tend
to dictate into a digital recording device in a noisy atmosphere, you may want to train a
new transcription audio source in Dragon Dictate and use it for producing transcripts.
As with Dragon Dictate’s other speech recognition functions, its ability to produce an
accurate transcript of your file depends on how well you’ve trained the audio source in
use with your current speech profile.

The first time you use the Transcription feature, you’ll need to train a transcription audio
source; follow the process described in “Transcription Training.” This is similar to the
same method the software uses to learn your voice when you first set up a profile and go
through voice training.

After you’ve trained a transcription audio source, click the Tools menu and select
Transcription... to produce a new transcript.

m Format Window Help
ec

Profiles...
Commands... H/K
Vocabulary Editor... BV

1
-}

Auto Formatting...

Microphone Setup...

Voice Training...

Vocabulary Training...

Train Vocabulary from Selection

F

In the resulting dialog box, select the file you want to use and click Open.

Transcription...




Dragon Dictate Mouse Control 101

.2.0.8. Open

Please choose an audio file that is at least 32 seconds long.
Supported file types are: alf, aiff, m4a, m4v, mp4 and wav.

[« nggEu]] imi || =+ || (& Desktop DEGY

FAVORITES Name | Date Modified.
= All My Files
g’;\q Applications

"~ 20120422 154049.mda Today 3:40 PM
Select Transcribe in Speech menu Today 3:34 PM
smart format rules.rtf Today 2:52 PM

| [ Desktop. = smart formatting rule Today 2:50 PM
B] Documents smart formatting -...e correction option Today 2:49 PM
0 Downloads smart formatting - select text Today 2:48 PM

! auto sleep preference Today 2:14 PM
= Movies windows Vocab Train 2 Today 2:11 PM

ﬂ Music snortiblog.rf Today 2:10 PM

@ Pictures Voice Training Window Today 2:07 PM

commands Today 2:00 PM

sharing preference pane Today 1:54 PM

| Cancel | @

SHARED

A progress window will track Dragon Dictate as it transcribes the file:

Transcription

G )

Memo2Zme.m4da

Cancel

When Dragon Dictate is done transcribing the file, a dialog appears asking if you want
to go to the Profiles window to select another profile or audio source, transcribe another
audio file, or edit your transcription results. If you decide to open the Profiles window

or transcribe another audio file, your transcription results will still be in the open Note
Pad window, so you can return to work with it further or copy and paste it into another
application.
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What do yess wan oo do sang?

o it O o it e P, S D P B,
5 18 T i e BB T R G B s
-

| Proies_ Traoacribe_ | [nana]
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Commands 103

Comment

Turn Dock Hiding On
Turn Dock Hiding Off
Put Computer to Sleep
Special Sleep

Restart the Computer
Special Restart

Search Menus for [text]

Search [someplace] for
[text]

Voice Shortcuts

Turns on Dock hiding.

Turns off Dock hiding.

Puts the computer to sleep.

Forces the computer to go to sleep.

Restarts the computer.

Restarts the computer without waiting for other tasks to complete.

Searches OS X’s menus for a specific word or phrase

Searches a specific place on your Mac for a specific word or phrase

Given the amount of data we store on our Macs and the sheer volume of information
available on the Internet, odds are you perform frequent searches. Dragon Dictate lets
you easily scour your Mac or the Internet for what you need.

You can search in Spotlight, or a Finder window’s search field, on your Mac, or you

can open a web browser and tell Dragon Dictate to check the Google, Yahoo!, or Bing
search engines for a text string. You can also open Mail and search your emails; both the
messages’ subject headers and content will be included.

What You Say

Search Spotlight or Mac or Computer for [text string]

Search Google or Yahoo or Bing for [text string]

Search Mail for [text string]
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The Web 100 Commands

The Web 100 commands are global commands that take you in your browser to any of
a hundred commonly used web sites. For example, you can say Jump to Bartleby to go
to the bartleby.com Great Books Online site.

These commands are enabled as a group if you have checked Enable Web Site
Commands in the Command Preferences pane. If enabled, they will appear in the
Available Commands window in the Web 100 subgroup of the Global group.

Rich Internet Application Extensions

When you installed Dragon Dictate, the Web Plug-In package was installed by default. It
enables Dragon Dictate to work with the Rich Internet Application Extensions for Safari
and Firefox. The first time you launch Safari or Firefox, you will be prompted to download
and install the extension for that browser; follow the prompt in the dialog. The extensions
are part of Dragon Dictate’s Rich Internet Application (RIA) functionality, which lets you
dictate text and perform commands in many web pages, as well as in Google Gmail.

When you visit a new web site with RIA active in Safari, a dialog will appear:

W enwikipedia.ong

Do you want o trust the website “enwikipediaorg” to use
the “Dragon Dictate Web Plugin® plug-in?

clo | Tak @ ¥ou tan manage which webtiten you trast to use this plug-in in the Viaww hisiney
Secaricy pane of Safan preferer el
? Mewer for this Website Trust | Mot Now
Nuance Com
From Wikipodia, S oo enciiopea
¢i%  The artcio noeds additional citations for verification. Pleaso hedp improve thes aricle by adding cilaton
- a8, Unsoursed malorial may bo challongod and romavid. fune 2068)

Nuance Communications is a muBnabional computer softwane lechnology corporation, headauarened in Buslington, L1

Click Trust to always use the Dragon Dictate extension for Safari with that web site. If
you click Not Now, the dialog will reappear the next time you visit that web site. If you
select Never for this Website, the Dragon Dictate extension will be disabled for that
website.

Should you wish to later change which web sites you allow Dragon Dictate to use, you
can do so by clicking Manage Website Settings... in Safari's Security preference:
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T T E AR J Click the dropdown next to each web site to
i . choose from Ask, Block, Allow, Always Allow, or
- Run in Unsafe Mode.
EET - -]
e " To apply a global setting, click the dropdown
o st Sy next to When visiting other websites at the

bottom of the window. For example, selecting
Always Allow there will stop the trust warning from
appearing on all future websites that you visit.

If you want to turn off the Safari extension for Dragon Dictate, you can do so in the
Extensions preference:

|
o [l -
= === Click the checkbox next to Enable Dragon Dictate
| % e | to turn the extension on or off.
e ——

In Firefox, click Add-ons in the Tools menu to see the extensions installed in that brows-
er, including Dragon Dictate:
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To tell Firefox how to use the Dragon Dictate extension with web sites, click the Plugins
pane in Add-ons Manager:

ann Al Mg

U [ e— L

e | o) (D res o d o |

‘ R T : Click the dropdown next to an extension to
' choose from Always Activate, Never Activate or
Ask to Activate. The last option prompts Firefox
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€ to ask on a site-by-site basis if you want to use
' Google Talk Plugin 4.9.1.16010 . . .
= i [ e Dragon Dictate, like Safari does.
Google Talk Plugkn Vide . 0.1.44.20
' Do Tl Pl gy | S Rt

When you visit a web site with the Dragon Dictate extension enabled in either Safari or
Firefox, you can say Click X, where X is the name of the link. Depending on the web
page and the number of links it contains, you may be able to use just a word or two with
the command to click the link. For example, if you are using browser-based email and a
link on the page says, “You have new messages in your in box,” you will likely be able to
say Click You to click it.

However, on a web site like Wikipedia, where pages can have many links, you will prob-
ably need to use more words. Dragon Dictate also offers a simpler way to navigate
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link-filled pages with the Show Links command, which places a number on each link on
the page:

- i (I |
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l sEr EED mmE ® Say Choose N, where N is the number of the
B B g link you want to click. Say Cancel to dismiss the
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i - | { maton | e numbers.
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RIA and Browser-Based Email

You can use Dragon Dictate’s browser extensions with Google Gmail. Make sure you are
logged in before dictating text and using commands. Say Click Compose to start a new
email. You can then dictate text into the body of the email.

Key Commands
Key commands are global commands that let you tell Dragon Dictate to enter a

keystroke, as if you had typed that keystroke manually.

Key commands can help you in situations where you might otherwise have to use the
keyboard, when there is no built-in command that lets you say what you want done. And
even when there is a built-in command, key commands may be easier to remember;

for example, even if you forget the global command for creating a new document in

any application (File New or New File), you probably know that its key combination is
Command-N, so you can say Press the Key Combo Command N.

When Dragon Dictate types in response to a key command, the typing is directed just as
real keyboard typing would be. So, for example, Press the Key Combo Command N is
directed to the frontmost application (typically to create a new document), but Press the
Key Combo Command Tab is directed to the system (and brings the second application
to the front), because that’'s how Command-Tab is treated when you type it manually.
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How to Say a Key Command
What you say depends on whether you want to press a single key or a key
combination involving modifier keys:

Single key. Say Press the Key KEYNAME, where KEYNAME is the name of the
key.

Key combination. Say Press the Key Combo MODIFIER KEYNAME or Press
the Keys MODIFIER KEYNAME, where KEYNAME is the name of the key, and
MODIFIER is any combination of modifier key names.

(Key names and modifier key names are shown later in this section.)
So, for example:

— To press the Page Down key (in many applications, this scrolls a document down
one screenful), say Press the Key Page Down.

— To press the key combination Command-Shift-4 (by default, this is the system
command for letting you select an area of the screen and take a screenshot of it),
say Press the Key Combo Command Shift Four.

Modifier key names

What You Say
Command
Shift

Option

Control

Caps Lock

Key names:

Normal letter and digit names. So, for example, A, B, C, and so forth, as well as
One, Two, Three, and so forth.

International Radio Alphabet letter names. These names are listed in the
discussion of Spelling mode commands.
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F-Key names. These consist of the letter “F” followed by a number from 1 to 20.
So, for example, F One, F Two, and so on through F Twenty.

Named keys. These are as follows:

What You Say

Left Arrow
Right Arrow
Up Arrow

Down Arrow
Home

End

Page Up
Page Down
Return
Enter

Tab

Space
Escape
Forward Delete

Help

Generated Commands

Dragon Dictate, as it starts up, will optionally generate global commands that let you
launch an application or create an email message addressed to someone in your
Contacts.

Launching Applications
To generate commands for launching applications:
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— Check Generate Application Launch Commands in the Command Preferences
pane.

Nothing will happen immediately; you need to quit Dragon Dictate and start it up again.
When you do, as it starts up, Dragon Dictate will look through all the applications on
your computer and generate commands of the form Activate XXX, where “XXX” is the
name of the application. So, for example, if you have Automator on your computer, a
command Activate Automator will be generated, and you’ll be able to say Activate
Automator to launch it.

The commands for launching applications will appear in the Available Commands
window in the Applications subgroup of the Global group.

Email Messages
To generate commands for creating pre-addressed email messages:

— Check Generate Email Commands in the Command Preferences pane.

The Email Commands subgroup will appear in the Global group in the Available
Commands window. The Email commands are globally available (you do not have to be
in Mail to use one). To learn what Email commands are available, consult your Contacts;
Dragon Dictate lets you say the name of any person or group having an email address in
your Contacts.

To create an email message:

— Say Send an Email To XXX, where “XXX” is the primary addressee.
To specify multiple addressees:

— Append and as you give your command.

For example: Send an Email To XXX and YYY. You can have more than two
addressees: Send an Email To XXX and YYY and ZZZ and so forth.

Dragon Dictate responds by creating a new email window addressed as specified, with
the insertion point in the Subject line ready for you to dictate a subject.
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Application-Based Commands
Dragon Dictate has sets of commands that it makes available only when a particular
application is frontmost. These are the application-based commands.

Note. This mechanism allows commands to be tailored to a particular
application. It also keeps the list of available commands from becoming too
long, since application-based commands effectively go out of existence
temporarily when that application is not frontmost. (You can access them in the
Commands window, to edit them; but you can’t use them.) This is good for you,
because the Available Commands window remains manageable. It's also good
for Dragon Dictate, because it limits the number of possible commands against
which Dragon Dictate must try to match what you say.

Dragon Dictate comes with command sets for the following applications:
— Dragon Dictate

— Finder

— TextEdit

—  Safari

— Malil

— Messages

— Calendar

— Notes

— Reminders

You can create your own application-based commands in the Commands window. The
rest of this section lists the application-based commands that ship with Dragon Dictate.
You can find this same information in the Available Commands window.
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Commands

These commands are available when Dragon Dictate is frontmost.

Dragon Dictate Application Menu Actions

What You Say

Comment

112

About This or The Application

Access or Show Check For
Updates Window

Access or Show Preferences
Window

Hide This or The Application
Hide (All) Other Applications
Show All Applications

Show Other Applications

Displays information about Dragon Dictate.

Opens the Check For Updates window.

Opens the Preferences window.

Hides Dictate.
Hides other applications.
Shows all open applications.

Shows other open applications.

Dragon Dictate File Menu Actions

What You Say

Comment

Make or Create New Note Pad

Make or Create New
Command

Access or Show Open
Window

Clear Recent Menu

Close This or The Window
Close All

Save This or The Document

Opens a new Note Pad window.

Opens Commands window and creates a new command.

Displays the Open window.

Clears the files listed when the cursor is placed on the arrow
next to Open Recent.
Closes the active window.

Closes all open Dictate windows.

Saves the active document.
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Comment

Access or Show Save As
Window

Revert to Last Saved Version
Access or Show Print Window
Save This or The Profile

Access or Show Command
Export Window

Opens the Save As... dialog box.

Reverts to the last saved version of the current document.
Access Print window.

Saves the current Profile.

Opens the Command Export window.

Dragon Dictate Edit Menu Actions

What You Say

Comment

Undo Last Action

Redo Last Action

Cut This or The Selection
Copy This or The Selection
Paste From Clipboard

Paste and Match Style

Delete This or The Selection
Select All

Access or Show This or The
Find Window; Search This or
The Document

Find Next

Search This or The Document
For [Dictation]

Undoes the last action. This is the same as pressing Command-
Z (undo).

Redoes the last action.

Cuts the selection to the clipboard.

Copies the selection to the clipboard.

Pastes the contents of the clipboard at the insertion point.
Matches the style at the insertion point when pasting the con-
tents of the clipboard.

Deletes the selection.

Selects everything.

Opens the Find window.

Finds the next occurrence of the current find string.

Opens the Find window and searches for the specified word or
phrase
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Comment

Search Again

Find Previous

Use Selection For Find
Jump to Selection

Toggle This or The Spelling
and Grammar Window

Check Spelling

Access or Show Special
Characters Window

Repeats the previously-performed search.

Finds the previous occurrence of the current find string.
Uses the current selection for the find string.

Jumps to the currently selected find string.

Shows the Spelling and Grammar window. Speak this com-
mand again to hide it.

Check the spelling of the current Note Pad document.

Displays the Special Characters palette.

Dragon Dictate Tools Menu Actions

What You Say

Comment

Access or Show This or The
Profiles Window

Access or Show Commands
Window

Access or Show Vocabulary
Editor Window

Access or Show This or The
Microphone Setup Window
Access or Show Voice Training
Window

Access or Show Vocabulary
Training Window

Opens the Profiles window.

Opens the Commands window.

Opens the Vocabulary Editor window.

Opens the Microphone Setup window.

Opens the Voice Training window.

Opens the Vocabulary Training window.
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What You Say

Commands

Comment
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Access or Show Train
Vocabulary From Selection
Window

Opens the Train Vocabulary From Selection window.

Dragon Dictate Format Menu Actions

What You Say

Comment

Align This or The Text Left
Align This or The Text Center
Align This or The Text Right
Justify This or The Selection

Aligns the text to the left.
Aligns the text to the center.
Aligns the text to the right.

Justifies the selected text.

Dragon Dictate Window Menu Actions

What You Say

Comment

Minimize This or The Window
Minimize All Window
Zoom This or The Window

Bring All Windows To The
Front

Arrange in Front

Minimizes the active window.
Minimizes all Dictate windows.

Zooms the frontmost window.

Brings all Dictate windows to the front.

Arrange in front.

Dragon Dictate Help Menu Actions

What You Say

| Comment

Access or Show Dictate Help

| Opens the Dictate Help window.
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Commands

Comment
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Access or Show Tips and
Tricks

Access or Show Release
Notes

Access or Show Quickstart
Guide

Access or Show User Manual

Send Email to Tech Support

Finder Commands

Opens Tips and Tricks.

Opens the Release Notes.

Opens the Quickstart Guide.

Opens the User Manual.

Sends email to tech support.

These commands are available when the Finder is frontmost.

Finder Application Menu Actions

What You Say

Comment

About This or The Finder

Access or Show Preferences
Window

Empty Trash
Secure Empty Trash
Hide or Close This Application

Hide or Close Other
Applications

Access or Show All
Applications

Displays information about the Finder.
Opens the Preferences dialog box.

Empties the trash.
Securely empties the trash.

Hides the Finder.

Hides other applications.

Shows all applications.
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What You Say

Commands

Comment
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New Finder Window
Make or Create New Folder

Make or Create New Smart
Folder

Make or Create New Burn
Folder

Open Selection

Print This or The Document
Close This or The Window
Close All Windows

Get Info

Show or Access Inspector
Hide or Close Inspector

Compress This or The
Selection

Duplicate This or The
Selection

Make or Create Alias
Quick Look Selection
Slideshow Selection
Access or Show Original
Add To Sidebar

Move To Trash

Eject Selection

Makes a new Finder window.

Makes a new folder.

Make New Smart Folder

Makes a new Burn folder.

Opens the selected item(s).

Prints the selected document.

Closes the active Finder window.

Closes all Finder windows.

Displays information on the selected item(s).
Shows the Inspector window.

Hides the Inspector window.

Compresses the selection.

Duplicates the selection.

Makes an alias of the selected item(s).

Opens the Quick Look heads up display for the selection.

Shows a slideshow of the selected items.
Shows the original of the selected alias(es).
Adds the selection to the Sidebar.

Moves the selected item(s) to the trash.

Ejects the selected item.
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Comment

Access or Show Burn Disc
Window

Access or Show Find Window

Finder Edit Menu Actions
What You Say

Allows you to access the Burn Disc window.

Opens the Find dialog box.

Comment

Undo Last Action

Cut This or The Selection
Copy This or The Selection
Paste From Clipboard
Select All

Deselect All

Access or Show Clipboard

Display Special Characters
Window

Finder View Menu Actions

What You Say

Undoes the last action. This is the same as pressing Command-
Z (undo).

Cuts the selection to the clipboard.

Copies the selection to the clipboard.

Pastes the contents of the clipboard at the insertion point.
Selects everything.

Deselects everything.

Shows the clipboard.

Displays the Special Characters window.

Comment

View As Icons

View As List

View As Columns
View as Cover Flow

Clean Up This or The Folder or
Window

Switches the view of the current window to lcon view.
Switches the view of the active window to List view.
Switches the view for the active window to Column view.
Switches the view of the current window to Cover Flow view.

Cleans up the active window. If no window is active, then it

cleans up the desktop.
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Comment

Clean Up Selection

Arrange By Name

Arrange By Date Modified

Arrange By Date Created

Arrange By Size

Arrange By Kind
Arrange By Label

Keep Arranged By Name

Keep Arranged By Date
Modified

Keep Arranged By Date
Created

Keep Arranged By Size
Keep Arranged By Kind
Keep Arranged By Label
Access or Show Path Bar
Hide Path Bar

Access or Show Status Bar
Hide Status Bar

Access or Show Toolbar
Hide Toolbar

Access or Show Customize
Toolbar Folder or Window

Cleans up the selected item(s).

Arranges the view of the active window or desktop by name.
Arranges the view of the active window or desktop by date

modified.
Arranges the view of the active window or desktop by date cre-

ated.
Arranges the view of the active window or desktop by size.

Arranges the view of the active window or desktop by kind.
Arranges the view of the active window or desktop by label.
Sets the view of the window or desktop to arrange by Name.

Sets the view of the window or desktop to arrange by Date
Modified.

Sets the view of the window or desktop to arrange by Date
Created.

Sets the view of the window or desktop to arrange by Size.
Sets the view of the window or desktop to arrange by Kind.
Sets the view of the window or desktop to arrange by Label.
Shows the Path Bar.

Hides the path Bar.

Shows the Status Bar.

Hides the status bar.

Shows the Toolbar.

Hides the Toolbar.

Opens the Customize Toolbar dialog box.
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What You Say Comment

Access or Show View Options [ Shows the View Options window.
Hide View Options Hides the View Options window.

View or Display (Using) [view

Changes the view style for the frontmost Finder window.
style]

Finder Go Menu Actions

What You Say Comment
Go Back or Previous Goes back to the previous view in the active window.
Go Forward or Next Goes to the next view in the active window.
Go To Enclosing Folder Opens the Enclosing folder for the selected item.
Go To (The) Computer (Folder , _ _
) Switches to the main Computer view.

or Window)
Go To (The) Home (Folder or , o _ ,

. Switches the view in the active window to your home folder.
Window)
Go To Desktop Goes to the Desktop.
Go To (The) Network (Folder or , o , , ,

] Switches the view in the active window to the Network view.
Window)
Go To My iDisk Switches the view in the current window to your iDisk.

Access or Show Other Users . ,
Allows you to access another user’s iDisk public folder.

Public Folder
Go To (The) Applications
(The) App Goes to the Applications folder.
Folder
Go To (The) Utilities (Folder or .
) Goes to the Utilities folder.
Window)

Clear Recent Folders Menu Clears the Recent Folders menu
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What You Say

Commands

Comment
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Access or Show Go To Folder
Window

Access or Show Connect to
Server Window

Finder Window Menu Actions

What You Say

Opens the Go To Folder dialog box.

Opens the Connect to Server window.

Comment

Minimize This or The Window
Minimize All Windows

Zoom This or The Window
Cycle Through Windows
Bring All To Front

Finder Help Menu Actions

What You Say

Minimizes the active window.
Minimizes all open Finder windows.
Zooms the active Finder window.

Cycles through open windows.

Brings all Finder windows to the front.

| Comment

Access or Show or Display
Mac Help

Finder Action Menu Actions

What You Say

Displays Mac Help in the Apple Help Viewer.

| Comment

Access or Show Package
Contents Of Selection

Shows the contents of the selected package.
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Finder Button Pressing

What You Say

Commands

Comment
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Press Cancel (Button)

Click Cancel
Press Connect (Button)

Press Done (Button)

Finder Selection

What You Say

Press the Cancel Button

Press the Connect Button

Press the Done Button

Comment

Select Name Of Selection
Select Next Name

Select Previous Name

TextEdit Commands

Selects the name of the selected icon.

Selects the next item alphabetically.

Selects the previous named item alphabetically.

These commands are available when TextEdit is frontmost.

What You Say

| Comment

About This Command Set

| Displays information about this command set.

TextEdit Application Menu Actions

What You Say

Comment

About This Application

Access or Show Preferences
Window

Hide This Application
Hide Other Applications

Displays information about TextEdit.
Opens the Preferences window.

Hides TextEdit.

Hides other applications.
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Commands

Comment
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Show All Applications
Quit This or The Application

TextEdit File Menu Actions
What You Say

Shows all applications.

Quits TextEdit.

Comment

Make or Create A New
Document

Open A Document

Clear Recent Menu

Close All Windows

Close This or The Window
Save This or The Document
Save All Documents

Access or Show Save As
Window

Revert To Last Saved Version
Show Properties Window
Hide Properties Window

Access or Show Page Setup
Window

Print This or The Document

Makes a new document.

Allows you to open an existing document.
Clears the recent menu.

Closes all TextEdit windows.

Closes the active window.

Saves the active document.

Saves all the documents.
Opens the Save As dialog box.

Reverts to the last saved version of the current document.
Shows the Properties window.

Hides the Properties window.

Opens the Page Setup window.

Prints the active document.
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TextEdit Edit Menu Actions
What You Say

Commands 124

Comment

Undo Last Action

Redo Last Action

Copy This or The Selection
Cut This or The Selection
Paste From Clipboard

Paste And Match Style

Delete This or The Selection
Complete This or The Selection
Select All

Insert Line Break

Insert Page Break

Insert Paragraph Break
Access or Show Find Window
Find Next

Find Previous

Use Selection for Find

Jump to Selection

Access or Show Select Line
Window

Show or Display Spelling And
Grammar Window

Undoes the last action. This is the same as pressing Com-
mand-Z (undo).

Redoes the last action.

Copies the selection to the clipboard.

Cuts the selection to the clipboard.

Pastes the contents of the clipboard at the insertion point.
Matches the style at the insertion point when pasting the
contents of the clipboard.

Deletes the selection.

Auto-completes the selection.

Selects everything.

Inserts a line break at the insertion point.

Inserts a Page Break at the insertion point.
Inserts a Paragraph Break at the insertion point.
Opens the Find dialog box.

Finds the next occurrence of the find string.
Finds the previous occurrence of the find string.
Uses the selection for the find string.

Jumps to the selection.

Opens the Select Line window.

Shows the Spelling and Grammar window.
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Comment

Hide Spelling And Grammar
Window

Check Spelling And Grammar Of
This or The Document

Turn Check Spelling While
Typing Off

Turn Check Spelling While
Typing On

Turn Check Grammar With
Spelling Off

Turn Check Grammar With
Spelling On

Turn Substitutions Smart Copy
And Paste Off

Turn Smart Copy And Paste On
Turn Smart Links Off

Turn Smart Links On

Turn Smart Quotes Off

Turn Smart Quotes On

Display Special Characters
Window

TextEdit Format Menu Actions

What You Say

Hides the Spelling and Grammar window.

Allows you to check the spelling and grammar of the active

document.

Turns off the Check Spelling While Typing feature.

Turns on the Check Spelling While Typing feature.

Turns off the Check Grammar with Spelling feature.

Turns on the Check Grammar with Spelling feature.

Turns off the Smart Copy and Paste feature.

Turns on the Smart Copy and Paste feature.
Turns off the Smart Links feature.

Turns on the Smart Links feature.

Turns off the Smart Quotes feature.

Turns on the Smart Quotes feature.

Displays the Special Characters palette.

| Comment

Show or Display Fonts Palette |Shows the Fonts Palette.
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Commands

Comment
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Hide This or The Fonts Palette

Make This or The Selection
Bold

Make This or The Selection
Italic

Make This or The Selection
Outline

Make This or The Selection
Underlined

Make This or The Selection
Plain Text

Make This or The Selection
Bigger

Make This or The Selection
Smaller

Show Colors Palette

Hide Colors Palette

Align This or The Text Center
Align This or The Text Left
Align This or The Text Right
Justify This or The Selection
Change Text Writing Direction
Show or Display Text Ruler
Hide Text Ruler

Copy Text Ruler

Hides the Fonts Palette.

Makes the selection bold.

Makes the selection italic.

Makes the selection outlined.

Makes the selection underlined.

Makes the selection plain text.

Makes the selection bigger.

Makes the selection smaller.

Shows the Colors Palette.
Hides the Colors Palette.
Aligns the text to the center.
Aligns the text to the left.
Aligns the text to the right.
Justifies the selected text.
Changes the writing direction.
Shows the Text Ruler.

Hides the Text Ruler.

Copies the Text Ruler for the selection.
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Commands

Comment
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Paste Text Ruler

Access or Show Text Spacing
Window

Access or Show Link Window
Access or Show List Window
Access or Show Table Window

Convert Document To Plain
Text

Convert Document To Rich
Text

Turn Prevent Editing Off
Turn Prevent Editing On
Wrap Text To Page
Toggle Hyphenation
Turn Hyphenation On

Applies the formatting settings copied with the “Copy Text
Ruler” command to the selection.

Opens the Text Spacing window.

Allows you to assign a URL to a selection of text.
Allows you to format the selected text as a list.

Allows you to format the selection as a table.

Converts the active document to plain text.

Converts the active document to rich text.

Turns Prevent Editing off.
Turns Prevent Editing on.
Toggles whether the text is wrapped to the page or not.

Turns Hyphenation off.

Turns Hyphenation on.

TextEdit Window Menu Actions

What You Say

Comment

Bring All Windows To Front
Minimize This or The Window
Minimize All Windows

Zoom This or The Window

Brings all non-minimized TextEdit windows to the front.
Minimizes the active window.
Minimizes all TextEdit windows.

Zooms the front-most window.
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TextEdit Help Menu Actions
What You Say

Commands

| Comment

128

Display Help

Safari Commands

| Displays Help about TextEdit,

These commands are available when Safari is frontmost.

What You Say

Comment

About This or The Command
Set

Safari Application Menu Actions

What You Say

Opens a dialog box describing this command set.

Comment

About This or The Application

Access or Show Preferences
Window

Turn Private Browsing Off
Turn Private Browsing On
Reset Safari

Hide This or The Application
Hide Other Applications
Show All Applications

Quit This or The Application

Displays information about Safari.
Access Preferences window

Turns off the Private Browsing feature in Safari.
Turns on the Private Browsing feature in Safari.
Allows you to completely reset Safari.

Hides Safari.

Hide Other Applications

Shows all applications.

Quits Safari.
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Safari File Menu Actions

What You Say
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Comment

Make or Create New Browser
Window

Make or Create A New Tab

Access or Show Open File
Window

Access or Show Open Location
Window

Close This or The Window
Close All Windows

Close This or The Tab
Hide or Close Other Tabs

Access or Show Save As
Window

Mail Contents Of This or The
Page

Mail Link To This or The Page

Open In Dashboard Window

Access Import Bookmarks
Window

Access Export Bookmarks
Window

Print This Document

Opens a new browser window.

Makes a new untitled tab in the current window.

Allows you to open a file, typically a web page stored locally,
on any attached storage device.

Selects contents of URL field in the current window. (TIP: use
spelling mode to enter complex URLSs.)

Closes the front window in Safari.
Closes all open Safari windows.
Closes the current tab.

Closes all tabs except the current one.
Opens the Save As dialog box.

Mails the contents of the current web page using your pre-
ferred email client.
Mails a link to the current web page using your preferred

email client.
Allows you to open a portion of the current web page in

Dashboard.

Allows you to import bookmarks from a file.

Allows you to export your bookmarks to an XML file.

Prints the current web page.
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Safari Edit Menu Actions
What You Say
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Comment
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Undo Last Action

Redo Last Action
Cut This or The Selection
Copy This or The Selection

Paste From Clipboard

Delete This or The Selection
Select All

Auto Fill This or The Form
Do Web Search

Show Find Toolbar

Find Next

Find Previous

Hide or Close Find Banner
Use Selection for Find
Jump to Selection

Check Spelling And Grammar Of
This Document

Turn Check Spelling While Typing Off
Turn Check Spelling While Typing On

Turn Check Grammar With Spelling
Off

Undoes the last action. This is the same as pressing
Command-Z (undo).
Redoes the last action.

Cut Selection

Copy Selection

Paste the contents of the clipboard at the insertion
point.

Deletes the selection.

Selects everything.

AutoFills the Current Form.

Puts the cursor in the Search field.

Opens the Find window.

Finds the next instance of the Find string.

Finds the previous occurrence of the Find string.
Hides the Find Banner.

Uses the current selection as the Find string.
Jumps to the selection in the current window.

Allows you to check the spelling and grammar of the

active document.
Turns off the Check Spelling While Typing feature.
Turns on the Check Spelling While Typing feature.

Turns off the Check Grammar with Spelling feature.
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Turn Check Grammar With Spelling
On

Show Special Characters Window

Safari View Menu Actions

What You Say

Displays the Special Characters palette.

Comment

Turns on the Check Grammar with Spelling feature.

Show Bookmarks Bar

Hide or Close Bookmarks Bar
Show Status Bar

Hide or Close Status Bar
Access or Show Tab Bar

Hide or Close Tab Bar

Access or Show Toolbar

Hide or Close Toolbar

Access Customize Toolbar Window
Stop Loading This or The Page
Reload This or The Page

Safari History Menu Actions

What You Say

Shows the Bookmarks Bar.

Hides the Bookmarks Bar.

Shows the Status Bar.

Hides the Status Bar.

Shows the Tab Bar.

Hides the tab bar.

Shows the Toolbar.

Hides the Toolbar.

Opens the Customize Toolbar window.
Stops loading the current page.

Reloads the current web page.

Comment

Jump Back

Jump Forward

Jump Home

Goes back to the last location visited.

Jumps forward to the next location visited (typically used

after you have already used the “Jump Back” command

to view a previous page again).
Takes you to your home page.
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Comment

Mark This or The Page For Snap
Back

Jump To Snap Back Page

Search Snap Back
Reopen Last Closed Window

Reopen All Windows From Last
Session

Jump To Bookmark One
Jump To Bookmark Two
Jump To Bookmark Three
Jump To Bookmark Four
Jump To Bookmark Five
Jump To Bookmark Six
Jump To Bookmark Seven
Jump To Bookmark Eight
Jump To Bookmark Nine
Show All History

Clear History

Safari Bookmarks Menu Actions

What You Say

Marks the current web page for SnapBack.

Takes you to the page you previously marked as the
SnapBack page.
Takes you to the Search Results SnapBack page.

Reopens the last closed window.

Reopens all the Safari windows that were open during
the last session.

Jumps to the first bookmark in the Bookmark Bar.
Jumps to the second bookmark in the Bookmark Bar.
Jumps to the third bookmark in the Bookmark Bar.
Jumps to the fourth bookmark in the Bookmark Bar.
Jumps to the fifth bookmark in the Bookmark Bar.
Jumps to the sixth bookmark in the Bookmark Bar.
Jumps to the seventh bookmark in the Bookmark Bar.
Jumps to the Eighth bookmark in the Bookmark Bar.
Jumps to the ninth bookmark in the Bookmark Bar.
Show All History

Clears the history of locations visited.

Comment

Show All Bookmarks
Hide All Bookmarks

Shows the Bookmark Manager.

Hides the Bookmark manager.
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What You Say

Commands 133

Comment

Access Add Bookmark
Window

Add Bookmark For These
Tabs

Add Bookmark Folder
Bookmark This or The Page

Access Save As Window
Move To Next Cell
Open Selected Bookmark

Delete Selected Bookmarks

Safari Window Menu Actions

What You Say

Adds a bookmark to the current page, allowing you to rename it.

Add Bookmark For These Tabs

Adds a Bookmark Folder to the Bookmark collection.

Adds the current page to the Bookmark menu without asking to
rename it.

Opens the Save As dialog box.

Moves to the next editable cell while in Bookmarks view.
Opens the selected bookmark when in Bookmark view.

Deletes the selected Bookmarks when in Bookmarks view.

Comment

Minimize This or The Window
Minimize All Windows

Zoom This or The Window
Select Next Tab

Select Previous Tab

Merge All Windows

Move Tab To New Window
Open Downloads Window
Bring All Windows To Front

Minimizes the current window.

Minimizes all windows.

Zooms the current window.

Selects the next tab in the current window.
Selects the Previous Tab in the current window.
Merges all windows.

Moves the current tab to a new window.
Opens the Downloads window.

Brings all Safari windows to the front.
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Safari Help Menu Actions

What You Say

Commands 134

Comment

Display Safari Help

Access or Show
Acknowledgments

Display Installed Plug ins

Display License

Safari Links and Navigation

What You Say

Displays Safari’s Help file in a new window.
Displays the Acknowledgments document in a new window.

Displays the installed plug-ins in a new window.

Displays the license agreement in a new window.

Comment

Create or Create a command
for this page

Jump To This or The Link
Move To Next Link

Move To Previous Link

Move To Next Text Field

Move To Previous Text Field

Scroll Up

Scroll Down

Scroll To Top

Scroll To Bottom

Scroll Left

Scroll Right

Creates a command for this page

Takes you to the web page for the selected link.

Moves to the next link while in normal view.

Moves to the previous link while in normal view.

Moves to the next editable text field while in normal view.

Moves to the previous editable text field while in normal view.
Scrolls the page up by a small amount, but more than clicking on

the scroll bar up arrow.
Scrolls the page down by a little, but more than by clicking the

scroll down arrow.

Scrolls to the top of the current page.

Scrolls to the bottom of the current page.
Scrolls the page left by a little, but more than by clicking the

scroll left arrow.
Scrolls the page right by a litte, but more than by clicking the

scroll right arrow.
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What You Say

Commands

Comment
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Scroll One Screen Down
Scroll One Screen Left
Scroll One Screen Right
Scroll One Screen Up
Do Web Search

Mail Commands

Scrolls down one screenfull.
Scrolls left one screen.
Scrolls right one screen.
Scrolls up one screentull.

Puts cursor in the search field.

These commands are available when Malil is frontmost.

What You Say

About This Command Set

Mail Application Menu Actions

What You Say

About This or The Application
Access or Show Preferences W
Hide This or The Application
Hide Other Applications

Show All Applications

Quit This or The Application

Mail File Menu Actions

What You Say

indow

(Make or Create) New Message
New Viewer Window
Close This or The Window
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What You Say

Save As Draft
Access or Show Save As Window
Access or Show Attach File Window

Access or Show Save Attachments
Window

Access or Show Add Account Window

Access or Show Import Mailboxes
Window

Access or Show Page Setup Window

Print This or The Document

Mail Edit Menu Actions
What You Say

Undo Last Action
Redo Last Action

Cut Selection

Copy Selection

Paste From Clipboard
Delete Selection
Select All

Complete Entry
Paste As Quotation
Paste AsHT M L
Paste and Match Style

Append Selected Messages or Email

Commands
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What You Say

Access or Show Add Hyperlink Window
Include Original Attachments in Reply
Exclude Original Attachments in Reply
Access Find Window

Find In Selected Mailboxes

Use Selection for Find

Find Next

Find Previous

Jump to Selection

Access or Show Spelling Window
Check Spelling

Turn Check Spelling As You Type Off
Turn Check Spelling As You Type On

Turn Check Spelling When You Click Send
On

Access or Show Special Characters
Window

Mail View Menu Actions

What You Say

Show Attachments Column
Show Buddy Availability Column
Show Date Received Column
Show Date Sent Column

Show Flags Column

Commands
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What You Say

Show From Column

Show Mailbox Column
Show Number Column
Show Size Column

Show To Column

Hide Attachments Column
Hide Buddy Availability Column
Hide Date Received Column
Hide Date Sent Column
Hide Flags Column

Hide From Column

Hide Mailbox Column
Hide Number Column
Hide Size Column

Hide To Column

Sort By Attachments

Sort By Buddy Availability
Sort By Color

Sort By Date Received
Sort By Date Sent

Sort By Flags

Sort By From

Sort By Mailbox

Sort By Message Status

Commands
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What You Say

Sort By Number

Sort By Size

Sort By Subject

Sort By To

Turn Organize by Thread Off
Turn Organize by Thread On
Collapse All Threads
Collapse This or The Thread
Expand All Threads

Expand This Thread

Hide B C C Address Field
Show B C C Address Field
Hide Reply To Address Field
Show Reply To Address Field

Select All Messages or Emails In This or

The Thread

Select Next Messages or Emails In This

or The Thread

Select Previous Message or Emails In

This or The Thread

Go To Next Message or Email In Thread

Go To Previous Message or Email In

Thread
Show Long Headers

Show Default Headers

Commands
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What You Say

Access or Show Plain Text Alternative
Access or Show Next Alternative
Access or Show Previous Alternative

Access or Show Best Alternative For
Selected Message

Access or Show Raw Source For
Selection

View Original Content For Selection
Access or Show Selected Messages Only
Display All Messages or Email

Hide Mailboxes

Show Mailboxes

Hide Deleted Messages or Emails
Access or Show Deleted Messages
Hide Toolbar

Access or Show Toolbar

Access Customize Toolbar Window
Use Large Mailbox Icons

Use Small Mailbox Icons

Mail Mailbox Menu Actions

What You Say

Go Offline
Go Online
Get All New Mail

Commands

140



Dragon Dictate

What You Say

Synchronize All Accounts

Erase Deleted Messages or Email In All
Accounts

Erase Deleted Messages or Email On My
Mac

Erase Junk Mail

Make or Create New Mailbox

Make or Create New Smart Mailbox
Edit Selected Smart Mailbox

Make or Create New Smart Mailbox
Folder

Rename Selected Mailbox

Delete This or The Mailbox

Access or Show In Box

Access or Show Out Box

Access or Show Drafts

Access or Show Sent Box

Access or Show Junk

Access or Show Trash

Use This or The Mailbox For Drafts
Use This or The Mailbox For Junk

Use This or The Mailbox For Sent Mail or
Mailbox

Use This or The Mailbox For Trash
Rebuild Selected Mailbox

Commands
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Mail Message Menu Actions

What You Say

Send This or The Message or Email
Send This or The Message or Email
Again

Reply To This or The Message or Email

Reply All To This or The Message or
Email

Reply With | Chat

Forward Selection

Forward This or The Message or Email
Redirect This or The Message or Email
Bounce Selection

Mark As Flagged

Mark As Unflagged

Mark As High Priority

Mark As Low Priority

Mark As Normal Priority

Mark As Junk Mail

Mark As Read

Mark As Unread

Move To Last Used Mailbox

Apply Rules

Add Sender to Contacts

Remove Attachments

Commands
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Mail Format Menu Actions

What You Say

Access or Show Font Palette
Hide Font Palette

Show Color Palette

Hide Color Palette

Make Selection Bigger

Make Selection Smaller

Make Selection Bold

Make Selection ltalic

Make or Create Selection Outline
Make Selection Underline

Make Selection Plain Text

Make Selection Rich Text

Copy Style Of Selection

Paste Style

Access or Show Styles Window
Align Selection Center

Align Selection Left

Align Selection Right

Justify Selection

Change Writing Direction From Left To Right
Change Writing Direction From Right To Left
Increase Quote Level

Decrease Quote Level

Commands
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Mail Window Menu Actions

What You Say

Minimize This or The Window

Zoom This or The Window

Access or Show Message Viewer
Access or Show Address Panel
Access or Show Previous Recipients
Show Activity Viewer

Access or Show Connection Doctor
Bring All to Front

Arrange In Front

Mail Help Menu Actions
What You Say

Access or Show Mail Help

Display What’s New in Malil

Mail Navigation and Selection

What You Say

Move To Beginning Of Message or Email

Move To End Of Message or Email
Move Down One Page

Move Up One Page

Move Down One Paragraph

Move Up One Paragraph

Move Left One Word

Commands
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What You Say

Move Right One Word

Move To Beginning Of This or The Line
Move To End Of This Line

Move Left One Character

Move Right One Character

Extend Selection to Beginning Of
Message or Email

Extend Selection To End Of Message or
Email

Extend Selection To End Of This or The
Window

Extend Selection Down One Page
Extend Selection Up One Page
Extend Selection To End Of Paragraph
Extend Selection Up One Paragraph
Extend Selection To Beginning Of Word
Extend Selection To End Of Word
Extend Selection Up One Line

Extend Selection Down One Line
Extend Selection To Beginning Of Line
Extend Selection To End of Line
Extend Selection Left One Character
Extend Selection Right One Character
Access or Show Drafts Mailbox

Access or Show In Box

Commands
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What You Say

Access or Show Out Box

Access or Show Sent Mailbox

Access or Show Trash Mailbox

Messages Commands
This command is available when Messages is frontmost.

What You Say | Comment

146

Send Message | Sends the message currently being dictated.

Calendar Commands
These commands are available when Calendar is frontmost.

What You Say
About This Command Set

Calendar Application Menu Actions

What You Say
About This Application

Access Preferences Window
Hide This Application

Hide Other Applications
Show All Applications

Quit This Application
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Calendar File Menu Actions

What You Say

Make New Event

Make New To Do

Make New Calendar
Make New Calendar Group
Show Info

Hide Info

Access Import Window
Access Export Window
Close This Window
Access Back Up Window
Access Restore Window

Print This Document

Calendar Edit Menu Actions

What You Say

Undo Last Action
Redo Last Action

Cut Selection

Copy Selection

Paste Selection

Delete Selection
Select All

Duplicate Selection
Put Focus In Find Field

Commands
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What You Say
Display Special Characters Palette

Calendar Calendar Menu Actions

What You Say

Access Subscribe Window

Publish This Calendar

Unpublish This Calendar

Access Send Publish Email Window
Refresh This Calendar

Refresh All Calendars

Access Change Location Window
Find Shared Calendars

Calendar View Menu Actions

What You Say

Switch To Day View
Switch To Week View
Switch To Month View
Go To Next Day

Go To Next Month

Go To Next Week

Go To Previous Day

Go To Previous Month

Go To Previous Week
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What You Say

Go to Today

Go to Date

Show Mini Months
Hide Mini Months

Show Notifications

Hide Notifications
Show Search Results
Hide Search Results
Show To Dos

Hide To Dos

Show All Day Events
Hide All Day Events
Show Mini Calendar
Hide Mini Calendar
Show Notifications

Hide Notifications

Calendar Window Menu Actions

What You Say

Minimize This Window
Zoom This Window

Show Address Panel

Hide Address Panel

Bring All Windows To Front
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Calendar Help Menu Actions

What You Say
Display Help

Display Keyboard Shortcuts

Calendar Navigation and Display

What You Say

Show Calendar

Show Events On This Calendar
Hide Events On This Calendar
Hide Other Calendar Events
Scroll Up

Scroll Down
Select Next

Select Previous

Notes Actions

What You Say Comment
File New
Creates a new note and makes it active.
New File
File Save Saves the active note.
File Close
Closes the active note.
Close File
Select All Selects all text within the active note.
Copy Copies the selected text within the active note to the clipboard.
Paste Pastes the clipboard contents to the active note.
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What You Say Comment

Delete Deletes the selected text from the active note.
Minimize Minimizes the window containing the active note.
Print Prints the active note.

Check Document Now Checks the spelling and grammar in the active note.

Reminders Actions

What You Say Comment

New Reminder Creates a new reminder and makes it active.
Close Reminders Closes the reminders.

Select All Selects all text within the active reminder.

_ Copies the selected text within the active reminder to the clip-
Copy Reminders

board.

Paste Pastes the clipboard contents to the active reminder.

Delete Deletes the selected text from the active reminder.

Minimize Minimizes the window containing the active reminder.
Notifications Actions

What You Say | Comment

Notifications | Shows the notifications.
Messages Actions

What You Say Comment

Send Message Sends the contents of the message work area.
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Windows
Dragon Dictate’s windows are:

Note Pad window. Like a word processor that takes dictation.
Profiles window. Different users, different audio sources, different profiles.
Commands window. Manage what commands are available, and create new ones.

Vocabulary Editor window. Manage what individual words Dragon Dictate can
recognize, along with their automatic punctuation behavior.

Auto Formatting window. Manage how Dragon Dictate automatically formats
addresses, dates, numbers, and more.

Microphone Setup window. Set your sound input level.

Voice Training window. Perform additional training to help Dragon Dictate better
recognize your speech.

Vocabulary Training window. Add words that you want Dragon Dictate to know.
Status window. Your compact floating command center.
Available Commands window. A list of all commands you can say right now.

Recognition window. Improve Dragon Dictate’s accuracy when it misrecognizes
your speech.

Express Editor Transfer window. A window for dictating and manipulating text
before transferring it to an application that does not offer Full Text Control with
Dragon Dictate.

Transcription window. A window for importing and reviewing text resulting from
Dragon Dictate’s analysis of a speech file.

Preferences window. Some useful options live here.

Note Pad Window

Dragon Dictate comes with its own built-in word processor — Note Pad. A Note
Pad window is a word processing window. But it’s a special kind of word processor: it
is specifically aimed at dictation through Dragon Dictate. In fact, you should control the
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contents of the window entirely through dictation and commands; you should never
need to type in a Note Pad window.

1 @N6O Untitled
Dragon Dictate lets you dictate into any
application, but a Note Pad window is the fastest
and most reliable place to dictate because itis : H
designed for this purpose. A common technigue A NOte Pad WIndOW IS a faSt and
i5 to dictate into a Note Pad window and then . .
copy and paste into another application. reliable place to dictate.

Dragon Dictate lets you dictate into any application, but a Note Pad window is an easy
place to dictate, because it is designed for this purpose. A common technique is to
dictate into a Note Pad window and then copy and paste into another application. A
TextEdit document also makes a good place to dictate, for similar reasons.

One big advantage of a Note Pad window or TextEdit document is that Dragon Dictate
can actually “see” what’s in it; Dragon Dictate always knows the contents of a Note Pad
window or TextEdit document, even after you type or paste in text, or open an existing
document. Dragon Dictate is thus not as dependent upon its own memory of how it
entered text through dictation (the cache) as in other applications.

To summon a new Note Pad window:

— Say File New, New File, New Note Pad, Make New Note Pad, or Create New Note
Pad when Dragon Dictate is frontmost.

— Choose File > New Note Pad.
To set the default font and size for a new empty Note Pad window:

— Open a new Note Pad window, choose Format > Font > Show Fonts, specify the
desired font and size, and close the Font palette and the Note Pad window.

Note Pad window contents are saved as .rtf files which can be opened for editing later
with another word processor (TextEdit, Microsoft Word, etc.). You can also open an
existing .rtf file into a Note Pad window (choose File > Open).



Dragon Dictate Windows 154

Profiles Window
The Profiles window is for managing your profiles.

A profile is a complete set of data on how you speak. In order to speak into Dragon
Dictate, you must have at least one profile; and at every moment you are using exactly

one profile (the active profile or current profile, marked in the Profiles window with a
green circle).

800

The Profiles window

To summon the Profiles window, choose Tools > Profiles. If you have checked Show
Profiles Window in the General Preferences pane, the Profiles window will appear
automatically when you start up Dragon Dictate, offering you a chance to activate a
profile; otherwise, Dragon Dictate activates the profile you were previously using.

In many cases, one profile is all you’ll need. But you’ll need multiple profiles in certain
situations:

— If different people are using Dragon Dictate, each will need their own profile.

— If you use Dragon Dictate in different environments (home and office, for example),
you should have a profile for each environment, as the ambient sound characteristics
may differ.

Every profile has a name, which uniquely identifies it. The name of the active profile is
visible in the Status window (as its title bar).
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The data for a profile lives on your hard disk as a package whose file extension is
.ddictateprofile. It is found in the Documents folder in the Finder. We do not recommend
you move it.

The first time you use Dragon Dictate, there will be no profile, and you will be prompted
to create one.

To create a profile:

— In the Profiles window, click the |+ button. The Profile Enrollment process begins.
Give the profile a name and click Next. Then select an audio source, give it a name
and click Next. Choose your Region and Accent in the next two steps, clicking Next
after each option. Choose a place to save your profile and wait while Dragon Dictate
creates it. You then go through the Microphone Setup and Voice Training processes.
For a full discussion of the profile creation process, see “Installation and Making a
Profile.”

To delete a profile:

— Select the profile’s listing in the Profiles window and click the | = button. You can’t do
this if there is only one profile. You can’t delete the active profile.

To set which profile should be the active profile:
— Select the profile’s listing in the Profiles window and click Make Active.
— Double-click the profile’s listing in the Profiles window.

Profiles for this version of Dragon Dictate are incompatible with earlier versions of Dragon
Dictate. Profiles from an earlier version of Dragon Dictate are marked in the Profiles

window with a special icon (/21). You can make such a profile active; when you do, it is
updated for use with this version of Dragon Dictate and will no longer work with earlier
Versions.

To dismiss the Profiles window:
— Create or activate a profile, as previously described.
— Click Close (at the lower right).
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Commands Window

The Commands window is your interface for management of global and application-
based commands. This is where commands may be edited — modified, created,
activated and deactivated, and deleted.

To open the Commands window:
— Choose Tools > Commands.

— Choose File > New Command. This is the same as choosing Tools > Commands
and then pressing the [+| button to create a new command.

e Y e— ,

The Commands window. An active
built-in command from the Global set
is selected, displaying its AppleScript
underpinnings.

® Lt

To switch among command lists:
— Inthe left column, select a command set — Global, or an application context.
— At the top of the middle column, click All, Built-in, or User Defined.

It is the combination of both these settings that determines which commands are
displayed.

To activate or deactivate a command:
— (Click the checkbox to the left of the command’s name.

A deactivated command still exists, but it is not listed in the Available Commmands
window, you cannot issue the command, and Dragon Dictate doesn’t have to consider
that phrase as a possible command when you say it. So, deactivating unused
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commands can be useful, but you probably should wait before doing so to see which
commands you really don’t need.

To create a new command:

— Click the [+ button.

To delete a command:

— Select the command, and press Delete, or choose Delete from the tool (gear) menu.

You can’t delete an unmodified built-in command. Deleting a built-in command that
you’ve modified restores the original unmodified built-in command.

To duplicate a command.:

— Choose Duplicate from the tool (gear) menu.

To edit a command:

— Select the command name and work in the right-hand column.

Changes that you make in the Commands window might not be registered until you
close the Commands window.

Note. You don’t need to read any more about the Commands window unless
you are thinking of creating or modifying a command.

To import or export commands:
— Select Command Import... or Command Export... in the File menu.

When you select Command Export..., a dialog window appears and you can select

the individual commands, or entire sets of commands, you want to export. When you’re
done and click Export..., a new dialog window allows you to name the export; whatever
name you give it will automatically have .commandstext appended to it. You will also be
prompted to save those commands’ trigger terms in a separate file that will automatically
have -Terms.dynamictext appended to it. A confirmation of your successful export will
appear when you’re done.
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Facebook/Twitter Commands

You can use Dragon Dictate to post updates to your Facebook and/or Twitter account.
To get started, open the Mail, Contacts & Calendar pane (in OS X 10.8) or the Inter-
net Accounts pane (in OS X 10.9) in System Preferences and click Twitter and/or Face-
book to log in.
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If you dictate text, such as This Is a Test, and then speak the command Post That to
Facebook, a dialog window appears. You can continue dictating text before speaking

the command Press Share. If you don’t want to post that text to Facebook, say Press
Cancel or Click Cancel.
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®00 Untitled
This is a test

Or, you can say Post That to Twitter to bring up the Twitter dialog box. Say Press Tweet
to send the tweet through your Twitter account, or say Press Cancel or Click Cancel to
rescind the post.

The Facebook and Twitter functions also allow you to select part of a piece of text and
share or tweet it, as shown below. You can say Select This Is A Test and then speak a
Twitter or Facebook command.

[LHalé] Untitled
This is a test of the emergency broadcast system. L

This is a test
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You can also go directly to the Share on Facebook or Share on Twitter dialog box by
speaking Post to Facebook More Snow or Post to Twitter More Snow, or by simply
saying Post to Facebook or Post to Twitter, which will bring up an empty dialog win-
dow.

There are other variations on the Facebook and Twitter commands. Saying That with a
command uses the currently-selected text, or the last recognized text.

What You Say

Post That To Facebook

Post That To My Facebook Page
Post That To My Facebook Wall
Facebook That

Post That To Twitter

Post That To My Twitter Page
Twitter That

Tweet That

If you want to speak a Facebook or Twitter command and then dictate the text you want
to use, or simply summon an empty dialog window, you can use one of these variations:

What You Say

Post To Facebook

Update My Facebook Page
Update My Facebook Wall
Post To My Facebook Wall
Post To My Facebook Page
Post To Twitter

Post To My Twitter Page
Update My Twitter Page
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When you select Command Import..., a dialog window asks you to find the
.commandstext file that you want to import; you will then be prompted to find the file’s
associated -Terms.dynamictext file. A confirmation will also appear.

Command Types
Every command is of one of the following types (as listed in the Type drop-down menu in
the right-hand column of the Commands window):

AppleScript. The command executes a script written in AppleScript. The Source
field in the Commands window is an AppleScript script editing environment; you can
compile and run a script, and view its result (toggle between the Source and Result
buttons above the editing environment). Many built-in Dragon Dictate commands are
AppleScript commands. Even commands directed at Dragon Dictate itself, such as
Dictation Mode, are AppleScript commands; Dragon Dictate is itself scriptable with
AppleScript.

Application. The command launches a specified application. Dragon Dictate can
generate launch commands for all your applications (see “Generated Commands”),
but if you didn’t want to activate that option, an Application command would be
useful for launching a particular frequently used application.

Bookmark. The command jumps to a URL in your default browser. The “Web 100”
commands are Bookmark commands (see “The Web 100 Commands”). Listed in
the command list as a URL type.

File or Folder. The command opens a specified file or folder in the Finder (and
activates the Finder). Listed in the command list as an Alias type.

Menu Item. The command chooses a menu item, specified by menu and menu
item name. A Menu Item command must be created and edited in a specific
application context, though it may later be changed to Global context if desired.

Shell Script. The command executes a shell script. The Shell Script text field in the
Commands window is a script editing environment. The script should begin with a
“shebang” line (e.g. #!/bin/sh). Running a shell script does not open the Terminal,
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and there is no means of viewing output; a shell script to be run from within Dragon
Dictate should generally be created and tested elsewhere.

Text Macro. The command inserts specified text at the insertion point of the
frontmost document. This is a good way to store and enter boilerplate text (hunks
of named text) or any frequently used text that is awkward to dictate or that needs
to be formatted without regard to Dragon Dictate’s automatic capitalization and
punctuation rules.

Automator Workflow. The command executes an Automator workflow, specified by
the pathname of the workflow file.

Keystroke. The command executes the simulated pressing of a specific key, or
group of keys, as defined by you.

Creating a Command
In creating a command, consider the following:

Context. Should this command be available everywhere (Global), or only in the
context of some specific application?

Name. The name of the command is the phrase that you will speak to trigger the
command. What should this phrase be?

Implementation. How will you implement this command? Which of the above
command types should it be?

To create the command, click the '+ button. A workspace appears in the righthand
column. Edit each setting:

Command Name. This is the name of the command, the phrase you will speak to
trigger the command. Click in that window to edit it.

Command Description. This is the field below Command Name. It is optional.
Click in that window to edlit it.

Context. This is the application in which you want the command to be
available. For all applications, choose Global. Contexts for which Dragon Dictate
already has application-based commmands are listed in the pop-up menu (see



Dragon Dictate Windows 163

“Application-Based Commands”). To create a new context, click Choose and
select an application in the Open dialog.

Type. Pick a type from the pop-up menu (see “Command Types”). Alternatively, if
the implementation involves specifying a file or is itself a file, you may be able simply
to leave the pop-up menu on “Automatic” and drag the file onto the drag area.

For example, if you drag an Automator Workflow file, Dragon Dictate chooses the
Automator Workflow type and points to that file; if you drag an AppleScript compiled
script file, Dragon Dictate chooses the AppleScript type and copies the script into
the Source field; if you drag text, Dragon Dictate chooses the Text Macro type and
copies the text into the Text field; if you drag a miscellaneous file or folder, Dragon
Dictate switches to the File or Folder type and points to the dragged item; and so
forth.

Implementation. If an implementation was not automatically provided by the
previous step, provide an implementation for your command.

Providing a command implementation is generally straightforward, because the use of a
command type implies that you already understand that command type. For example, a
Shell Script implementation requires a knowledge of shell scripts.

The AppleScript command type is the most flexible, and therefore the most involved.
Teaching you AppleScript is beyond the range of this manual (you can learn the language
from any of a number of books, such as AppleScript: The Definitive Guide, published
by O’Reilly Media). You can study the built-in AppleScript commands to get an idea of
how they are implemented. Except for Global commands directed at Dragon Dictate
itself, the built-in commands tend not to talk AppleScript at an application, even when it
is scriptable; rather, they use GUI scripting, by way of System Events, to manipulate the
target application’s interface. \Whenever possible, the Menu ltem type is the preferred
approach. This, however, should not discourage you from writing your own commands
that do take advantage of the target application’s scriptability.

As a convenience, Dragon Dictate lets you easily create an AppleScript command that
issues modifier-keystroke combination. (For example, you might create a Log Out This
User command that types Shift-Command-Q.) Set the Type to AppleScript, click “Click
to record shortcut,” and type the modifier-keystroke combination. The script will be
automatically created in the Source field.
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In general, the more you arm Dragon Dictate with a repertory of user-defined commands
corresponding to your frequently executed tasks, the more useful Dragon Dictate will be
as a speech-driven assistant.

Vocabulary Editor Window
The Vocabulary Editor window is your interface for viewing and editing the list of words,
phrases, and symbols that Dragon Dictate can type for you in Dictation mode.

To summon the Vocabulary Editor window, choose Tools > Vocabulary Editor.

The very first time you open the Vocabulary Editor window when a given profile is active,
there will be a brief delay while Dragon Dictate generates an initial list of the built-in
dictation vocabulary for that profile. Once this initial list is generated, subsequent access
to the Vocabulary Editor window is rapid. (The list is long, though — over 150,000 words
— S0 there can still be a brief delay when you perform certain actions in the window.)

To switch among vocabulary lists:

— Click All, Built-In, or User. User vocabulary can come from vocabulary training
(analysis of written text, see “Vocabulary Training Window”) or from direct editing in
this window. An icon distinguishes built-in vocabulary from user vocabulary.

To filter the displayed list:

— Type in the search field and press Return. The pop-up menu in the search field lets
you determine whether the filter operation is Contains, Begins With, or Ends With.
Both the written and spoken forms are searched. For example, a Contains search
on “dash” lists “balderdash”, because its written form contains “dash”, but also “---",
because its spoken form is “em-dash.” To empty the search field and stop filtering
the list (displaying the entire list), click the “x” in the search field or press Esc when
the search field has focus.

If you do a search and no match is found, and if you’re in the All category, Dragon
Dictate will offer to add the term to your user vocabulary. To add it, click Yes. (You can
edit this new vocabulary item later.) To decline, click No.
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To edit a vocabulary item:

— Select the item, and use the info area at the bottom of the window. If the info area is
not present, click the info button to summon it.

You can’t edit the written form of a vocabulary item. You can edit the spoken form of a
user vocabulary item, but not of a built-in vocabulary item; you should do this if the item’s
written form differs from its pronunciation. (For best results, train the item’s pronunciation,
as described below.) To edit the spoken form of a user vocabulary item:

— Type the spoken form (an English spelling equivalent to how the word is pronounced)
and press Return. You should see a dialog warning that any recorded training for
this word will be erased.

i Untitled
The quick brown fox jumped over the lazy dog.

eno Vocabulary Editor
Built-In  User Q'mxi . .
£ oa - The Vocabulary Editor window,
¥ cefoxitin R b
@ it S B showing a user vocabulary item
# FOLFOX ext word: (Natural capitalization & , ,
e whose spoken form differs from its
? Fox -
ey el il s s written form. (Behind, a Note Pad
Insert: | 1 +| spaces after
U window demonstrates that this
¥ Foxborough Numbers
! OXCH T (A — . . . .
g S vocabulary item is indeed working; the
i ! o ‘ormat following: | normal B .

$ e iara Ferms ® user has said the spoken form and
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The Vocabulary Editor window info area also displays features of the selected vocabulary
item having to do with Dragon Dictate’s intelligent automatic capitalization and spacing.
You can edit these features for user vocabulary items, and for most built-in vocabulary
items (although some built-in vocabulary items have complex automatic capitalization
and spacing rules, which can’t be fully displayed or edited):
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Spaces before and after. Normal words will have one space before and one space
after. But a punctuation mark might follow a different rule.

Next word. How should the word following this item be capitalized? In most cases,
“Natural capitalization” (the default) will be the right choice.

Lower case in titles. A “title” is a phrase dictated while title casing is turned on
(Caps On). You might prefer that “small” words such as “of” or “in” not be capitalized
in such phrases.

If a vocabulary item is not being recognized correctly, you might wish to train the
pronunciation of the item. This means that you pronounce the item several times, so that
Dragon Dictate can record your voice saying it and incorporate the recording into your
voice model. To train a vocabulary item, select the item and choose Train from the tool
(gear) menu at the bottom of the window.

Dragon Dictate presents a sequence of training dialogs:

1. A dialog explaining that you are about to pronounce the item three times (click Train
to proceed).

2. A dialog where you pronounce the item three times, watching for feedback in the
dialog so you know Dragon Dictate has heard you.

3. Adialog where you are informed that the training process is over.
To create a new user vocabulary item:

— Click the |+ button. Type the word, as written, in the dialog. To add a description
of how the word is spoken, or to train the word’s pronunciation by speaking, click
Advanced to reveal the rest of the dialog.

To delete a user vocabulary item:

— Select the word and press Delete (or choose Delete from the gear menu). A dialog
appears giving you an opportunity to change your mind.

To export and import vocabulary items:

— To export, select the item(s) and choose Export from the gear menu. An XML file is
created. To import, choose Import from the gear menu and specify an exported XML
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file. User vocabulary, when created, belongs to the current profile, so this is a way to
copy user vocabulary from one profile to another.

Microphone Setup Window
The Microphone Setup window is where you adjust the sound input level.

Tip. Optimal sound input level is crucial to speech recognition. It's a good idea
to summon the Microphone Setup window and adjust the sound input level
each time you begin a session using Dragon Dictate. If you use a headset,
it’s a good idea to also do that each time you take it off and put it back on,

because the microphone position or the background noise conditions may have
changed.

To show the Microphone Setup window:

— Choose Tools > Microphone Setup.

The Microphone Setup window will also appear automatically when you create a profile.

.00 Microphene Setup

Volume Adjustment

|_| Manual Gain: U 50 B H

f ‘ The Microphone Setup window is
Enable the microphone . .
by clicking the ican. where you adjust your sound input

level. To begin, click the microphone
icon with the red “stop sign.”

3 EY

To adjust the sound input level automatically:

— Click the microphone button at the lower left of the window, and read aloud the
text that appears in the middle of the window, until the window informs you that the
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level is adjusted. You might have to read the entire text two or three times before
the adjustment is completed. When adjustment is completed, the window will say
“Finished” and the last few seconds of your speech will be played back.

To adjust the sound input level manually:

— Check “Manual Gain Setting” and slide the slider while speaking until the typical gain
displayed in the thermometer next to the microphone button maxes out at the top of
the green area.

For a complete description of the microphone setup process, see “Microphone Setup.”

Voice Training Window
The Voice Training window is where you read aloud a little story so that Dragon Dictate
can train the active profile’s voice model to recognize your speech.

To summon the Voice Training window:
— Choose Tools > Voice Training.

The Voice Training window will also appear automatically as part of the sequence of
events when you create a new profile.

800 Voice Training

Voice Training helps Dragon Dictate adapt to the way you speak. During this
process, you will be asked to read a story, including punctuation. This should
take you five minutes or less. The training process will stop when enough speech
has been collected, usually before you reach the end of the story.

The Voice Training window, before

Text will turn green as it is recognized. If the text turns red, pause, then begin H H
reading again. If you cannot turn the text green, click the Skip Word button and readlng a Story TO proceed’ C“Ck the
start with the next word. . .
right-arrow button at lower right of the
The progress bar on the panel will show how far along you are in the story. .
window.
Click the right arrow to continue.
o) (=]

To train with a story:

1. Click the right-arrow at the lower right. The stories are listed; stories that you have
not trained for this profile are unmarked.
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2. Select a story and click the right-arrow again.

3. When you’re ready to begin, click the microphone button at the lower left. Read the
story aloud.

As you read aloud, passages that have been recognized will turn green. If passages turn
red, try again or click “Skip Word”. When you first start to train a profile, you will need

to read quite slowly, in very short distinct phrases (but smoothly and naturally), waiting
each time for the display of green text to catch up with you. After three or four pages of
text, however, you will be able to read at a considerably more normal speed and in larger
phrases.

When you’ve reached the end of the story, or when Dragon Dictate has heard enough,
the window will change to indicate that your training is being processed into the voice
model.

You must train the voice model with at least one story prior to using a new profile. After
that, further training is optional. Reading additional stories (there are three of them) might
improve Dragon Dictate’s accuracy in recognizing what you say, but in many cases the
recognition engine will prove to be remarkably accurate after you have read just one
story.

For a complete description of the voice training process, see “Voice Training.”

Vocabulary Training Window

The Vocabulary Training window is where you provide Dragon Dictate with written text
so that it can learn unknown words. Learned words are added to Dragon Dictate’s
recognition vocabulary for your profile, so you can use them while dictating.

To open the Vocabulary Training window:

— Choose Tools > Vocabulary Training.
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| 800 Vocabulary Training

Dragon Dictate can analyze documents to determine your writing style. This
improves accuracy by helping Dragon Dictate learn about the way you put
words together. For this reason, it is important that Dragon Dictate analyzes
documents written by you, not someone else.

To have Dragon Dictate analyze documents click the “Add..." button in
below and choose documents from the Open File Dialog Box. You can also

drag files directly into this window.

Learn from text in files:

The Vocabulary Training window,
ready to add files for analysis.

| Add.. | | Remove

To feed text files to the Vocabulary Training window:
1. Click the right-arrow at the lower right.

2. Click Add to select files to add to the list of files to be analyzed. Dragon Dictate can
read the same standard formats as TextEdit, such as text files, .rtf, .doc, and .odt
files.

3. Click the right-arrow at the lower right once again.

Alternatively, to feed selected text from an already open document to the Vocabulary
Training window:

— Select the text and issue the command Train Vocabulary from Selection.

— Or, in a Note Pad window, select the text and choose Tools > Train Vocabulary From
Selection.

If the text contains unknown words, the Vocabulary Training window will now present two
columns of words: Included and Excluded. Manipulate the contents of these columns
(by selecting words and then clicking Exclude or Include) so that the Included column
contains only words that you actually use, and which you want Dragon Dictate to
incorporate into its vocabulary.

To incorporate words in the Include column into Dragon Dictate’s vocabulary:
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— Click the right-arrow at the lower right.
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The Vocabulary Training window, after
analyzing a text file (shown behind),
ready to add a previously unknown
word to this profile’s vocabulary.

Status Window

The Status window is Dragon Dictate’s compact control center. \When the Status
window is showing, it floats over all applications.

Use the Status window to toggle the microphone on or off, to bring Dragon Dictate to

the front, and to summon the Recognition window, using the mouse instead of your
voice.

Look at the Status window to learn what your sound input level is, what mode Dragon
Dictate is in, whether you’re using a capitalization, spacing, or numeral command, what
profile is currently active, what the current dictation context is (that is, where Dragon
Dictate would type your dictation at this moment), and (optionally) to see how Dragon
Dictate interprets what you have said.
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The Status window.
Top: Current profile.

New Profile

input level; mode button; bring to front button;
Recognition window button.

No Space, and Numeral.)

Bottom: Current dictation context. Underneath:

Last utterance (optional).

To show or hide the Status window:

— Say Show Status Window or Hide Status Window.

— Choose Window > Show/Hide Status Window.

— Choose Show/Hide Status Window from the Dock menu.

To set whether the Status window is visible when Dragon starts up:

— In the General Preferences pane, check or uncheck “Show Status Window at
Startup”.

To change the Status window’s transparency:

— Use the slider in the Appearance Preferences pane.

To set whether the Status window displays your speech as it is recognized:
— In the General Preferences pane, check or uncheck “Show Recognized Text”.
To toggle the microphone on or off:

— Click the microphone button.

The microphone button’s icon indicates the microphone’s status:

— Green circle: The microphone is on.

— Red stop sign: The microphone is off.

— Blue balloon with crescent moon: The microphone is asleep.

Middle, left to right: microphone button; sound

172

(Under the last three buttons are indicators for Caps,
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The mode button’s icon indicates the current mode. Click it to summon the modes
menu, where you can switch between modes.

To bring Dragon Dictate frontmost:
— Click the bring to front button.
To summon the Recognition window:

— Click the Recognition window button.

Available Commands Window
The Available Commands window lists the commands you can say at any moment.
When the Available Commmands window is showing, it floats over all applications.

The list of commands displayed in the Available Commands window changes
automatically depending on what mode you’re in, what application is frontmost, and
whether the Recognition window is open. The availability of some global commands and
the order in which commands are displayed depends on your settings in the Command
Preferences pane.

[ ] Available Commands

Q
Dictation

Global

The Available Commands window, while the
Finder is frontmost.

To show the Available Commands window:
— Say Show Available Commands Window.
— (Choose Window > Show Available Commands.
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— Choose Show Available Commands from the Dock menu.

The Available Commands window will automatically appear when you start up Dragon
Dictate if it was showing when Dragon Dictate last quit.

Scroll through the window, or use the search field, to discover commands.

Tip. If there is text in the search field, the list of commands is filtered to display
only commands containing that text. To be certain that all commands are
displayed, empty the search field; a quick way is to click in the search field and
press Esc.

To issue a command:
— Say the command.

— For a global or application-based commmand, double-click the command’s name in
the Available Commands window.

Hover the mouse over a command’s name in the Available Commands window to see a
tooltip displaying its description.

To hide the Available Commands window:

— Say Hide Available Commands Window.

— Choose Window > Hide Available Commands.

— (Choose Hide Available Commands from the Dock menu.

— Click the close button at the top left of the Available Commands window.

Recognition Window

The Recognition window is your interface for refining Dragon Dictate’s voice model by
telling it about recognition errors it has made. This is called training the voice
model. When the Recognition window is showing, it floats over all applications.
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When Dragon Dictate has typed what you said in Dictation mode, and has made a
mistake, use the Recognition window to correct Dragon Dictate’s interpretation of what
you said, as well as to correct what Dragon Dictate typed.

There are thus two ways to modify the existing dictated content of a document: you can
use Dictation mode commands, or you can use the Recognition window to train the
voice model. However, there is a big difference between them:

Modifying the document. When you use a Dictation mode command to select and
delete a phrase, or to select and dictate to replace a phrase, and so forth, you are
implying that you made a mistake.

Training the voice model. \When you use the Recognition window to train the
voice model, you are implying that Dragon Dictate made a mistake; it misrecognized
your speech, or didn’t know a word you used. Use training, in other words, to teach
Dragon Dictate and to improve its accuracy in recognizing your speech and the
kinds of things you say.

< Recognition
Spelling Alternatives

i The Recognition window. If the first alternative

dog is correct, the next step would be to say Pick 1

Dawg (or click the 1 button).
Dogg

Dog

To summon the Recognition window:

— Say Show Recognition Window.

— In Dictation mode, say one of the following:
Train the Word “Someword”
Train the Words “Someword” Through “Otherword”
Train the Words “Someword” to “Otherword”

— Click the Recognition window button in the Status window.
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Press the Recognition window keyboard shortcut.

If “Show Recognition Window when dictating” is checked in the Recognition
Preferences pane, the Recognition window will open automatically when you are
dictating in Dictation mode or Spelling mode as soon as the insertion point is within
or after a phrase capable of being trained. Usually this will be as soon as you dictate
anything.

Note. The Recognition window (and voice model training in general) operates on
dictated utterances. Dragon Dictate has its own ideas about what constitutes
an utterance, based partly on where you paused while dictating. Therefore, the
phrase that is selected when you say Train the Word(s)..., or the phrase that
appears in the Recognition window (and is selected when you summon the
Recognition window), might be longer or shorter than what you initially specified.

To close the Recognition window:

Say Hide Recognition Window.

Say Cancel Training.

Say Cancel Recognition.

Click the close button at the top left of the Recognition window.
Press the Recognition window keyboard shortcut.

If “Close Recognition Window after each choice” is checked in the Recognition
Preferences pane, the Recognition window will close automatically as soon as you
use it to replace a dictated phrase with its correct version.

Try different Recognition Preferences pane settings and different ways of summoning

and closing the Recognition window as you train your dictation. You'll soon settle on a
favorite way of working (which might depend on external factors, such as the size of your
screen).
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How to Train

The Recognition window presents alternative interpretations of the phrase containing
the current selection or insertion point in the dictation document. The first alternative is
the interpretation that Dragon Dictate entered in the document. The number of additional
alternatives is limited by your setting for “Maximum number of alternatives” in the
Recognition Preferences pane.

You can use the Recognition window to train what you just dictated, because the
insertion point is still at the end of that phrase, so that is the phrase shown in the
Recognition window. You can also select a dictated phrase (using Dictation mode
navigation commands); if Dragon Dictate still has cached dictation information for this
part of the document, the Recognition window will change to show alternatives for that
phrase.

Thus, one way of working with the Recognition window is to train phrases as soon as
you dictate them; another is to dictate a larger amount, such as a paragraph or two,
and then go back and train.

In most cases, Dragon Dictate will have preserved the recording of your speech from
when you dictated the phrase. To play the recording of the phrase selected in your
text:

— Say Press Play.
— Click the green ear icon at the top right of the window.

This can be a useful precaution, because you may not have said what you think you
said. You do not want to mistrain Dragon Dictate by using the Recognition window to
enter a trained phrase that is not a correct interpretation of what you actually said! If you
made a mistake, don’t use the Recognition window!

If one of the Recognition window’s alternatives is correct, enter it in the document in
place of the alternative that’s already there. To do so:

— Say Pick 2 or Choose 2 (or whatever the actual number at the left of the correct
alternative is — but most of the time, it probably will be 2!).

— Click the numbered button at the left of the correct alternative.
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You have now performed recognition training. Internally, Dragon Dictate will modify its
speech model, and will save this information into your profile the next time your profile is
saved.

If none of the Recognition window’s alternatives is correct, you can edit one of the
alternatives so that it is correct, and then enter the edited, correct alternative as in the
previous step. It doesn’t matter which of the alternatives you edit; edit whichever is most
convenient. To edit an alternative:

— Say Edit 1 (or whatever the actual number at the left of the desired alternative is).

— Click once to select the alternative, pause, and then click once inside the text of the
alternative.

The alternative you are editing is now the “target” for dictation and commands. You can
edit using Dictation mode or Spelling mode (and it is also fine to use your fingers to type
in the Recognition window). The only standard command that doesn’t work is “Scratch

that”; instead, use Scratch Word.

To exit editing mode without entering the corrected phrase into your document:
— Say Cancel Edit or click elsewhere.

Preferences Window
The Preferences window lets you set certain options for Dragon Dictate. To show the
Preferences window:

— (Choose Dictate > Preferences.
To close the Preferences window:

— Click the close button at the top left of the window.

General Preferences pane
The General Preferences pane assembles some miscellaneous options, having mostly to
do with the state of things when Dragon Dictate is launched.
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Startup Mode

Use the radio button to determine what mode Dragon Dictate should be in
when it starts up, or whether the microphone should simply be off.

Startup Actions

Check Check for Updates if you want Dragon Dictate to go online at launch
time and automatically communicate over the Internet with Dragon to see
whether your version of Dragon Dictate is the most recent. If a newer version
is available, you will be offered a chance to download and install it. You can also
check for updates manually by choosing Dictate > Check for Updates.

(This checkbox does the same thing as the checkbox in the Profiles window.
If one is checked, the other is automatically checked.)

Check Show Profiles Window if you want Dragon Dictate to pause and
display the Profiles window at launch time; the main reason for doing this
would be so that you can select a profile as the active profile. If unchecked,
Dragon Dictate will automatically activate the profile you were using previously.

Check Show Status Window if you want the Status window to be visible at
launch time.
When Activating a Profile

Check Open a New Note Pad Window if you want a new empty Note Pad
window to open when a profile is activated. This includes opening a Note Pad
window at launch time, because a profile is always activated at launch time.

Feedback

Check Show Recognized Text if you want the Status window to display the
text of each phrase that Dragon Dictate understands you to have uttered.

Appearance Preferences pane
The Appearance Preferences pane assembles some miscellaneous options having to do
with microphone icons and the Status window.
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Notepad Window Size

Fill in the fields next to Width and Height to change the default size of a new
Note Pad window when you create one. Click the Default button to return those
numbers to their original state, which is a width of 80 characters and a height of 25
lines.

Show Microphone Status

Check In the menu bar if you want the Dragon Dictate status menu item to
appear in the menu bar. This status menu item is an icon that displays whether the
microphone is on or off, or asleep; plus, you can click it to toggle the microphone on
or off.

Check In the Dock if you want Dragon Dictate’s Dock icon (and its
Command-Tab application switcher icon) to be badged with a microphone
icon showing whether the the microphone is on or off, or asleep.

Status Transparency

Use the slider to govern how opaque or transparent the Status window
should be.

When Starting MouseGrid

Check Switch to Command mode if you want Dragon Dictate to switch to
Command mode when you invoke the MouseGrid. Check Enable zoom if you
want MouseGrid to display the magnification window when you focus on an area too
small to show the grid. Both of those options are checked by default.

Obscure Transparency

Use the slider to determine how light or dark the MouseGrid should be. The
lighter it is, the easier you will be able to see what’s under it. This is set to Lighter by
default. Below the slider, you can choose what color the grid should be, as well as
what color is used when you invoke the Hold Mouse command. Click the box next
to the option to summon a color wheel where you can make changes.
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Dictation Preferences pane

The Dictation Preferences pane allows the Auto Cache Document feature to be
enabled or disabled for certain applications. It's also where you can enter a port number
for the Dragon Remote Microphone app, although you shouldn’t change it from the
default (51001) unless you have a reason to do so.

TextEdit

By default, Auto Cache Document is enabled for TextEdit. To disable, uncheck
the box next to TextEdit.

Microsoft Word

By default, Auto Cache Document is disabled for Microsoft Word. To enable,
uncheck the box next to Microsoft Word.

Recognition Preferences pane
The Recognition Preferences pane governs some behaviors of the Recognition window,
and of the recognition engine.

Recognition Window Options

If Show Recognition Window When Dictating is checked, the Recognition
window will open automatically when you are dictating in Dictation mode
or Spelling mode as soon as the insertion point is within or after a phrase
capable of being trained. Usually this will be as soon as you dictate anything.

If Close Recognition Window After Each Choice is checked, the Recognition
window will close automatically as soon as you use it to replace a dictated
phrase with its correct alternative.

If Show Smart Format Rules is checked, Dragon will open the smart
formatting window after you’ve made a correction, enabling you to tell the
software how to automatically handle the change in the future.

Use Maximum Number of Alternatives to set the number of alternatives
shown in the Recognition window. Fewer alternatives might be shown (as few as
one, in fact), depending on how certain Dragon Dictate feels about its interpretation
of what you said.
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Recognition

Use the slider to trade off between speed and accuracy of speech
recognition. The middle (50) is a good initial setting, but given the speed of today’s
Intel-based machines you can probably opt for more accuracy with no appreciable
increase in response time. Feel free to experiment. After you’ve done a good deal of
dictation and honed your voice model using the Recognition window, Dragon Dictate
will probably be both faster and more accurate, so you can then afford to move the
slider to the right a bit.

Auto Sleep

Use the slider to set the length of time before the microphone goes to

sleep and no longer recognizes input. \While you can use the Go To Sleep

or Microphone Off commands to accomplish the same thing, the Auto Sleep
feature is useful if you are frequently interrupted or simply prefer not to use those
commands.

You can set the length of time for Auto Sleep at anywhere from 30 seconds
to five minutes, or never.

800 Recognition
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Command Preferences pane
The Command Preferences pane affects the behavior and contents of the Available
Commands window, as well as what commands are actually available.

Available Commands Window

Check Show Global Commands above Application Commands to make the
global commands appear above the application-based commands in the
Available Commands window.

Check Enable Web Site Commands to cause the Web 100 global commands
to be enabled (and to be present in the Available Commands window).

Command Generation

Check Generate Application Launch Commands to cause global commands
for launching applications to be generated the next time you start up
Dragon Dictate.

Check Generate Email Commands to cause global commands for creating
and addressing an email message to be generated the next time you start
up Dragon Dictate.

Shortcuts Preferences pane
The Shortcuts Preferences pane lets you set global keyboard shortcuts (hot keys) for
three Dragon Dictate actions. They are:

— Toggle Microphone. Turns the microphone on or off.

— Select Speech Mode. Cycles through the modes: Dictation mode, Spelling mode,
and Command mode.

— Show Recognition Window. Shows and hides the Recognition window.
— Dismiss MouseGrid. Dismisses the MouseGrid after it’s been summoned.

Important note: \When following the instructions below to change a keyboard
shortcut, you should never assign a key sequence that is the same as the one used to
invoke Apple’s built-in dictation capabilities found in OS X. You should also not assign
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Apple’s built-in dictation capability with a key sequence that includes Command-F9,
Command-F10, Command-F11, or Command-F12.

To set a shortcut:

— Click in the oval shortcut region and type the desired shortcut.

To delete a shortcut:

— Click the “X” at the right end of the oval shortcut region.

To revert to a previous shortcut:

— Click the curved arrow at the right end of the oval shortcut region.

Sharing Preferences pane

The Sharing Preferences pane allows you to set up connectivity to your Facebook and
Twitter accounts, so you can dictate updates to both social sites.

Click the Login button next to each option to set it up. Enter your user name and
password for each service. Facebook will ask you to allow Dragon Dictate to access your
Facebook wall and personal information; that function is a necessary part of Facebook’s
privacy policy, so you must enable it to post updates via Dragon Dictate.

If you change your user name or password for either service, set up a new account, or
simply don’t want to use this function anymore, click the Reset button to disconnect
one of the social networking services.



Dragon Dictate Menus 185

Menus
This section lists Dragon Dictate’s menus and menu items.

Dictate Menu
About Dictate. Summon the About window.

Check for Updates. Communicate over the Internet with Dragon to see whether your
version of Dragon Dictate is the most recent. If a newer version is available, you will be
offered a chance to download and install it. Dragon Dictate can also optionally check for
updates automatically as it starts up; to control whether it does this, use the checkbox in
the General Preferences pane.

Preferences. Summon the Preferences window.

Services. Click Services Preferences to open the Keyboard Shortcuts pane in System
Preferences.

Hide Dictate, Hide Others, Quit Dictate. Those are all self-explanatory.

File Menu
New Note Pad. Open a new empty Note Pad window.

New Command. Open the Commands window in the same state as if you had pressed
the [*! button to start creating a new command.

Open. Summon a standard File Open dialog where you can open an existing .rtf file as a
Note Pad window.

Open Recent. Open a document recently edited as a Note Pad window.
Close. Close the active window (offering a chance to save if necessary).
Save... Save the current Note Pad window (as an .rtf file or plain text document).

Duplicate. Creates a duplicate of the current Note Pad window. To replicate the Save
As... command that was found in earlier versions of OS X, create a duplicate of a Note
Pad and enter a new name in the document’s title bar (and assign it a tag and change
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the file location, if you want). Or you can choose Save... -- you will be prompted to enter
a file name when you save the document.

You can also hover the cursor next to the file name and click the down arrow that
appears -- a dialog box will pop up and allow you to enter a file name; click anywhere in
the Note Pad to dismiss it when you’re done.

Rename. Save the current Note Pad window under a new name.

Move To. Move the current Note Pad window to a new folder; you cannot change its
name.

Revert To. Revert to the last saved version or select “Browse All Versions” to select a
past revision through Time Machine.

Print. Print the current Note Pad window.

Save Profile. Save the currently active profile’s data. Enabled only if you have done
something (such as training the voice model) to affect the active profile. The active profile
is saved automatically when you activate a different profile or quit Dragon Dictate; this
menu item is just a “safety valve” for those wishing to make certain that changes in the
profile are not lost in case of a power failure or similar unforeseen event.

Command Import. Summon a standard File Open dialog where you can open a
.commandstext file (as created by the Command Export menu item). Opening such a
file will incorporate the commands it contains, so that they will appear in the Commands
window and the Available Commands window.

Command Export. Summon a dialog where you can select commands (from the
Commands window) to export, followed by a standard File Save dialog where you can
specify a name and location to save the commands as a.commandstext file. This is
an XML file, but it is not intended to be user-editable; its purpose is to be imported with
the Command Import menu item. Thus you can transfer custom commands between
computers and users.

ScriptPak Import. Like Command Import, but the type of file you can open is a
ScriptPak, as exported from or created for iListen, Dragon’s previous speech recognition
application.
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Edit Menu
The Edit menu items are a subset of those that are standard and familiar in any OS X
word processing application, such as TextEdit.

Undo. Undo the previous action.

Redo. Redo the previously undone action.

Cut. Remove selected text and place it on the clipboard.

Copy. Place a duplicate of the selected text on the clipboard.
Paste. Insert the contents of the clipboard at the selection point.

Paste and Match Style. Insert the contents of the clipboard at the selection point,
ignoring any style information on the clipboard.

Delete. Remove selected text (without placing it on the clipboard).

Select All. Expand the selection to including everything.

Find > Find. Summon the Find dialog.

Find > Find Next. Search forwards for the Find string.

Find > Find Previous. Search backwards for the Find string.

Find > Use Selection for Find. Copy the selected text to become the Find string.
Find > Jump to Selection. Scroll to reveal the selected text.

Spelling > Show Spelling and Grammar. Summon the Spelling and Grammar dialog.
Spelling > Check Spelling. Select the next misspelled word.

Spelling > Check Spelling While Typing. Toggle whether misspelled words are
marked.

Start Dictation. Activate the built-in dictation feature found in OS X.
Special Characters. Summon the Special Characters input palette.

Speech Menu
The menu items of the Speech menu also appear in Dragon Dictate’s Dock menu. An
advantage of the Dock menu is that it works even if Dragon Dictate is not frontmost.
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Microphone On/Off. Toggle the microphone on or off.

Dictation. Switch to Dictation mode. If it’s checked, Dragon Dictate is already in
Dictation mode.

Command. Switch to Command mode. If it's checked, Dragon Dictate is already in
Command mode.

Spelling. Switch to Spelling mode. If it’s checked, Dragon Dictate is already in Spelling
mode.

Numbers. Switch to Numbers mode. If it’s checked, Dragon Dictate is already in
Numbers mode.

Sleep / Wake Up. Switch into or out of Sleep mode.

Tools Menu
Profiles. Summon the Profiles window.

Commands. Summon the Commands window.

Vocabulary Editor. Summon the Vocabulary Editor window.
Auto Formatting. Summon the Auto Formatting window.
Microphone Setup. Summon the Microphone Setup window.
Voice Training. Summon the Voice Training window.
Vocabulary Training. Summon the Vocabulary Training window.

Train Vocabulary from Selection. Analyze the text selected in the current Note Pad
window and then, if the text contains unknown words, summon the Vocabulary Training
window displaying Included and Excluded columns.

Transcription... Open a dialog box where you can open a supported audio file for
Dragon Dictate to transcribe to text.

Format Menu
The Format menu items are a subset of those that are standard and familiar in any OS X
word processing application, such as TextEdit. They work in a Note Pad window.
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Font > Show Fonts. Show the Font palette. Changes will be applied to the selection.
Font > Bold. Toggle the bold styling of the selection.

Font > Italic. Toggle the italic styling of the selection.

Font > Underline. Toggle the underlined styling of the selection.

Font > Bigger. Increase the font size of the selection.

Font > Smaller. Decrease the font size of the selection.

Font > Show Colors. Show the Color palette. Changes will be applied to the selection.
Font > Copy Style. Move styling information from the selection to the clipboard.
Font > Paste Style. Apply style information from the clipboard to the selection.

Text > Align Left. Align the selected text against the left margin.

Text > Center. Center the selected text between the margins.

Text > Justify. Align the selected text against both margins.

Text > Align Right. Align the selected text against the right margin.

Window Menu
Minimize. Minimize the active Note Pad window to the Dock.

Minimize All. Option-key version of the above. Minimize all Note Pad windows to the
Dock.

Zoom. Toggle the size of the active Note Pad window.
Zoom All. Option-key version of the above. Toggle the size of all Note Pad windows.

Bring All to Front. Bring all Dragon Dictate windows in front of windows of other
applications.

Arrange in Front. Option-key version of the above. Bring all Dragon Dictate windows in
front of windows of other applications, and arrange them neatly overlapping in the middle
of the screen.

Show / Hide Status Window. Toggle the visibility of the Status window.
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Show / Hide Available Commands. Toggle the visibility of the Available Commands
window.

The preceding two menu items also appear in Dragon Dictate’s Dock menu. An
advantage of the Dock menu is that it works even if Dragon Dictate is not frontmost.

Enter / Exit Full Screen. Enter or exit full screen mode.

Individual Windows. Individual open windows (not including the floating Status window,
Available Commands window, and Recognition window) are listed; choose one to switch
to it. The active window is checked. Note Pad windows containing unsaved changes are
marked with a bullet.

Help Menu

Dictate Help. Summon the online help.

Contact Technical Support. Open the Support for Dragon for Mac page on the
Nuance web site in your default browser.

Dragon on the Web. Open the Speech Recognition for Mac page on the Nuance web
site in your default browser.

Interactive Tutorial. Begin the Interactive Tutorial.
User Manual. Display this PDF User Manual for Dragon Dictate.

Deactivate / Activate. Open the Activation dialog where you can enter a valid serial
number. If Dragon Dictate is already activated, the Deactivate option lets you deactivate
the software.

Register for Support. Open the Support - Product registration page on the Nuance
web site. You can register your copy of Dragon Dictate there, if you haven’t done so
already. Doing so will give you access to technical support.
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Tips on Speaking

Speech recognition, while it has become far faster and better over the past several years,
does not work like the human brain. The speech recognition engine identifies the words
you speak, using its knowledge of how you pronounce sounds, along with a rudimentary
notion of grammatical and lexical context, but it doesn’t know the meaning of the words,
nor does it have the understanding of your speech that a person does.

Thus, while the speech recognition engine’s accuracy can be improved to respond to the
unique characteristics of your voice, you also need to let Dragon Dictate train you. Your
use of Dragon Dictate will be much more successful if you bear in mind, and put into
operation, a few simple tips.

Train honestly. When you create a profile, you will use Microphone Setup to set your
microphone input level, and then you will use Voice Training to read a story. Speak in
the same manner and choose the same environment in which you will primarily use
Dragon Dictate.

Be consistent. This tip is a continuation of the previous one. Having trained Dragon
Dictate with Voice Training, you should carry on speaking the same way, as you
proceed to use Dragon Dictate. Stressing your words, or speaking expressively, is
apt to alter your pronunciation and mislead the speech recognition engine.

Pause. Dragon Dictate hears and thinks in “utterances,” which are stretches of
speech with pauses in between. When you say Scratch That, Dragon Dictate
deletes the previous utterance. The Recognition window displays complete
utterances. Utterances can be phrases or even complete sentences. Since Dragon
Dictate thinks in utterances, you should speak in utterances. Pause fairly often.

Speak clearly. Don’t mumble. Imagine you're speaking over a radio connection
from the International Space Station, that the signal is undependable and static-
prone, and that you’re calmly explaining to a disbelieving ground crew at Houston
that a large green alien monster is trying to break in. Clarity is key.

Speak naturally. Speak clearly, but speak calmly and naturally. Don’t over-
emphasize any sounds. Don’t over-emphasize the divisions between words. Don’t
pronounce “fat cat” as “ffatt-uh, catt-uh;” run words and sounds together in a
linguistically natural way. Don’t pronounce “the” as “thee,” or “a” as “aye,” unless



Dragon Dictate Tips on Speaking 192

that’s how you actually speak. Dragon Dictate needs to hear sounds and words in
their natural linguistic context. Speak in utterances, but make each utterance natural
and smooth.

Dictate, don’t talk. Talking and dictating are different. Conversation is a bit like
mind-reading; we guess at what our interlocutor means. Dragon Dictate can’t read
your mind; it tries to transcribe faithfully what you actually say. Make up your mind
what you want to say, then say it. Don’t stumble. Don’t add any extra noises or
interjections, like “You know.” Pause between utterances, but try not to hesitate in
the middle of an utterance.

Relax. Tension in your voice and mouth can cause sounds to emerge in an artificial,
strained way. Posture might matter. It can even be helpful to have on hand a glass of
water, or warm tea, and to take frequent sips. Breathe gently so that your breath is
not heard as an utterance. Turn the microphone off and shake out your tension from
time to time.
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Sound Input Troubleshooting

If Dragon Dictate doesn’t respond to your voice or doesn’t seem to be working at all,
check your sound input. The problem might be software (your microphone might not
be your sound input device) or hardware (your microphone might not be working at all).
Also, if your iOS or Android device goes to sleep, the Dragon Remote Microphone app
may stop communicating with your Mac.

Begin by quitting Dragon Dictate if it is running. You might restart the computer just in
case, or see if waking up your iOS or Android device helps. Now try the following:

— Look in System Preferences > Sound > Input and make sure your microphone
is the sound input device. (This is not applicable if you are using the Dragon
Remote Microphone app.) Speak into the microphone. The input level indicator
should respond to your voice. If it does not and you are using a USB microphone,
try unplugging it or the adapter from the USB port and plugging it back in again.
Remember, most USB microphones must be plugged directly into your computer
(not into a USB hub). Also, check to see whether your microphone has a Mute
switch and make sure it is not engaged.

— If you are using a Bluetooth microphone, you can try resetting or restarting it, if such
an option is available. You should also check the batteries and see if you need new
ones.

If things appear to be working, try Dragon Dictate again. Choose Tools > Microphone
Setup and go through the microphone setup procedure (see “Microphone Setup,”
earlier). You should now be able to use Dragon Dictate.

If things do not appear to be working, suspect the microphone. If possible, try using
the microphone with a different computer and running the same tests there to confirm
this. If you have a Bluetooth microphone, try using it with another device, such as a
smartphone, to ensure it is working.
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What’s Installed Where

In case you’re wondering where all the pieces of Dragon Dictate live on your hard disk, or
if perhaps for some reason you’d like to uninstall it, here’s a list of the pieces and where
they live (and how big they are).

The Application. It lives wherever you put it when you installed Dragon Dictate
— typically in the top-level /Applications folder, but it could be anywhere. It’s
approximately 30MB in size.

The Support Folders. These are in Library/Application Support/Dragon and
~Library/Application Support/Dragon. You access the former from the top level of
your hard drive, where the Applications, System and Users folders are also found,
but to locate the latter, you need to hold the Option key while clicking on the Go
menu in the Finder, since it is hidden by default.

The Library/Application Support/Dragon folder contains the Speech Engine Data
file, which is 2.25GB in size, along with your license. If you ever need to delete that
folder, you should set aside your license file, which will be convenient to have on
hand if you decide to install Dragon Dictate again.

The ~Library/Application Support/Dragon folder contains the Command Sets,
Commands, Profiles, and Troubleshooting folders.

The Dragon Dictate Preferences File. This is in ~Library/Preferences (the folder
you access by holding down the Option key while clicking on the Finder’s Go menu),
and is called com.Dragon.dictate.plist. It maintains a record of the state of the
application each time you quit. It's very small.

The Dragon Dictate Internet Plug-in File. This is in Library/Internet Plug-Ins
and is called npDDRia.plugin.

Your Profile(s). Each profile is wherever you put it when you created the profile,
but it will likely be in your user’s Documents folder, assuming you chose the default
location when originally saving it. A Spotlight search on “ddictateprofile4” should
find your profiles, if necessary. (Or search on “ddictateprofile” if you also want to find
profiles associated with older versions of Dragon Dictate.) A profile is about 77MB in
size with a single audio source. Profiles can be larger depending upon the number
of audio sources associated with the Profile.
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Credits

AppScript
Special Thanks To:

Apple Inc. for the wonderful OS X. Brad Cook and Matt Neuburg for their documentation expertise.

Credit Given Where Credit Is Due:

Copyright (C) 2007-2008 HAS

Aquatic Prime

AquaticPrime.h

AquaticPrime Framework
Copyright (c) 2006, Lucas Newman

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
eRedistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

eRedistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documenta-
tion and/or other materials provided with the distribution.

eNeither the name of Aquatic nor the names of its contributors may be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

BDAlias
License Agreement

By using or downloading this software, you agree to be bound by the following license. If you do not agree to be bound by the license, please
destroy all copies of this software.

Copyright © 2001-2002, bDistributed.com, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
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*Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

*Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documenta-
tion and/or other materials provided with the distribution.

*Neither the name of bDistributed.com, Inc. nor the names of its contributors may be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Twitter+OAuth

Twitter+OAuth Source and Example for iPhone

Glommed together by Ben Gottlieb

copyright 2009 Stand Alone, Inc - all rights reserved.

License: BSD, If you use it, please include the following text somewhere in your application’s user-facing text:
“Includes Twitter+OAuth code by Ben Gottlieb”

The goal of this was to create a drop-in code package for iPhone apps that want to access Twitter via OAuth. The main benefit here is that the
source line on the Twitter page will say your app name, rather than “from web”.

This includes source taken from several other open frameworks, listed below. Most of the heavy lifting was all done by them, | just synthesized it
into a (hopefully) easily digestible chunk.

| decided not to do the whole thing as a static library since most developers are already using Matt Gemmell’s MGTwitterEngine, and there was
no reason to duplicate code. It adds about 200k to the final size of your project, mainly due to the OAuth library.

Enjoy, and please let me know if you have any feedback!
Ben Gottlieb

ben@standalone.com

BGHUDAppKit

BGHUDAppKIit - Copyright (c) 2008, Tim Davis (BinaryMethod.com, binary.god@gmail.com)

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documenta-
tion and/or other materials provided with the distribution.
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* Neither the name of BinaryMethod.com nor the names of its contributors may be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Growl
Copyright (c) The Growl Project, 2004-2009

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documenta-
tion and/or other materials provided with the distribution.

3. Neither the name of Growl nor the names of its contributors may be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

NDHotKey

NDHotKeyEvent

Created by Nathan Day on Wed Feb 26 2008.
Copyright (c) 2003 Nathan Day. All rights reserved.

Shortcut Recorder
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Copyright (c) 2006, contributors to ShortcutRecorder. (See the contributors listed in detail later in the file, or see <http:wafflesoftware.net/
shortcut/contributors/>.)

All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documenta-
tion and/or other materials provided with the distribution.

* The name of the contributors may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Contributors to Shortcut Recorder, in no order in particular:
Jesper, waffle software, <wootest+shortcutrecorder@gmail.com>. Initial idea and concept, first shot at implementation using NSView.
David Dauer, <david@daviddauer.de>. Refinement, cleaner reimplementation, documentation, IB Palette.

Jamie Kirkpatrick, Kirk Consulting Ltd, <jkp@kirkconsulting.co.uk>. Further modularisation and re-factoring, and general bug fixes.

CTGradient
Copyright (c) 2005, Chad Weider.
Some rights reserved: <http:creativecommons.org/licenses/by/2.5/>

For more information, visit <http:blog.oofn.net/projects/misc/>

Sparkle
Copyright (c) 2006 Andy Matuschak

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the
“Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO
THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

TokyoCabinet

* Tokyo Cabinet is free software; you can redistribute it and/or modify it under the terms of

*the GNU Lesser General Public License as published by the Free Software Foundation; either

*version 2.1 of the License or any later version. Tokyo Cabinet is distributed in the hope

* that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of

* MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
* License for more details.

* You should have received a copy of the GNU Lesser General Public License along with Tokyo

* Cabinet; if not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330,

* Boston, MA 02111-1307 USA.

The MIT License
Copyright (c) 2008 Big Nerd Ranch, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the
“Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO
THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.



